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G U I D E  D E  L E C T U R E

Comment lire ce manuel

Chaque entrée du manuel suit le même schéma. Sur la page de gauche, vous trouvez 
les chemins d’accès et les détails techniques ; à droite, dans un encadré latéral chaud, 
l’explication simple est toujours présente. De petites icônes en début de ligne vous 
indiquent d’un coup d’œil quel type d’information arrive.

L E S  Q U AT R E  I C Ô N E S

Où trouver cela ? Le chemin de clic concret à travers l’application — barre de 
menu, section de l’inspecteur ou étape du mode débutant. Les raccourcis clavier 
associés figurent ici aussi. L’icône est une épingle de carte et indique où la fonc
tion se trouve dans l’interface utilisateur.

Détails. Valeurs par défaut, plages de valeurs et chemins de code. Vous rencon
trerez cela surtout dans les réglages d’entraînement, qui ne sont pas des entrées 
de menu mais des paramètres numériques. L’icône représente une petite fiche 
de spécification.

Technique. Ce que la fonction fait en interne, quels paramètres agissent, à quoi 
elle réagit et quels effets de bord elle a. Pour les lecteurs qui veulent comprendre 
ce qui se passe en coulisses. L’icône est un bloc de potentiomètres et représente 
symboliquement les manettes sous le capot.

En bref. L’idée centrale exprimée en mots clairs — sans jargon, sans code. Lisez 
cette section en premier si vous voulez juste savoir rapidement à quoi sert une 
fonction et quand l’utiliser. L’icône est une bulle de dialogue et signifie « pour 
résumer ». Cette colonne est toujours sur un fond sable chaud pour que l’œil la 
trouve immédiatement.

C O U L E U R S  D E S  C H A P I T R E S

Chaque chapitre a sa propre couleur d’accent, que vous reconnaîtrez à l’étiquette 

d’identifiant (par exemple M1 ) à gauche de chaque titre d’entrée et aux petites icônes 
placées devant. En feuilletant, vous voyez ainsi immédiatement dans quel chapitre vous 
êtes.

1 Menus 2 Inspecteur 3 Réglages 4 Fenêtres auxiliaires 6 Entraînement

7 Préréglages 8 Exports 9 SfM 10 Mode débutant



C O N S E I L S  D E  N AV I G AT I O N

Démarrage rapide. Si seul le maniement de l’application vous intéresse, allez 
directement au Chapitre 10 — Mode débutant. C’est la variante guidée en quatre 
étapes qui ne demande aucune connaissance préalable.

Aller plus loin. Le Chapitre 2 — Inspecteur et le Chapitre 7 — Préréglages 
expliquent les contrôles et les profils de qualité préconfigurés dont vous disposez 
en mode expert.

Recherche. La table des matières et la recherche plein texte du PDF vous aident 
à trouver une fonction précise. Vous n’avez pas à lire le manuel de bout en bout.



R A D I A N C E K I T

C H A P I T R E

Introduction — Ce que vous devez savoir

Qu’est-ce que RadianceKit ?

RadianceKit est une application macOS native qui transforme une série de photos 
ordinaires ou une vidéo en une reconstruction 3D dans laquelle on peut se déplacer. 
L’entrée consiste, par exemple, en 50 à 500 prises de vue que vous avez faites autour 
d’un objet, dans une pièce ou à travers un paysage. La sortie est ce que l’on appelle une 
scène de Gaussian Splatting — un modèle 3D que vous pouvez observer sur votre Mac 
en temps réel sous tous les angles, qui peut être exporté et intégré sur des sites web, 
et qui, dans ses aspects principaux, paraît photoréaliste.

L’application fonctionne entièrement localement sur votre Mac — aucune image n’est 
envoyée dans le cloud, aucune connexion n’est requise, aucun abonnement. Elle 
exploite intensivement le GPU de votre Mac Apple Silicon (série M) : une session 
d’entraînement complète peut durer entre deux minutes et plusieurs heures selon la 
scène et le préréglage. Pendant le calcul, vous pouvez continuer à travailler normale
ment sur votre Mac ; RadianceKit poursuit en arrière-plan et vous prévient lorsque le 
résultat est prêt.

Il existe deux modes d’utilisation : le mode débutant (Simple Mode) vous guide en 
quatre étapes à travers le flux Importer → Choisir un préréglage → Entraîner → Exporter. 
Le mode expert (Expert Mode) ouvre un grand inspecteur avec tous les paramètres, une 
fenêtre d’aperçu en direct et des graphiques de diagnostic. Vous pouvez à tout moment 
passer d’un mode à l’autre ; les données de la scène sont conservées.

Qu’est-ce que le Gaussian Splatting ?

Le Gaussian Splatting (souvent abrégé 3DGS ou simplement Splatting) est une méthode 
relativement récente de rendu 3D photoréaliste, présentée en 2023 dans un article 
issu de Graz et de l’INRIA. L’idée : au lieu de modéliser une scène comme un maillage 
polygonal classique (triangles) ou comme une grille de voxels, on la compose à partir 
de millions de petites taches 3D douces — chacune est une distribution gaussienne 
3D (d’où le nom) avec sa position, sa taille, sa forme, sa couleur et sa transparence 
propres. Ces taches sont entraînées pour que, prises ensemble depuis tous les angles 
de vue de vos photos d’entrée, elles produisent la bonne image.
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Concrètement, cela signifie que le Gaussian Splatting peut représenter les reflets, les 
hautes lumières, le feuillage souple, les cheveux ou les rideaux d’une manière que la 
modélisation 3D classique ne peut pas reproduire — ou seulement au prix d’efforts 
considérables. En contrepartie, le résultat n’est pas un modèle 3D éditable au sens 
classique — vous ne pouvez pas simplement déplacer un mur ou réorienter un vase. 
C’est plutôt une capture figée de l’espace, à travers laquelle vous pouvez vous déplacer 
librement. Pour de nombreuses applications — visualisation architecturale, présentation 
de produits, visites virtuelles, criminalistique, patrimoine culturel — c’est exactement la 
bonne force.

Pour transformer les images d’entrée en scène 3D, deux étapes sont nécessaires. 
L’application calcule d’abord, via un procédé appelé Structure-from-Motion (SfM), où 
se trouvait votre caméra pour chaque photo. Au passage, un nuage de points 3D 
grossier de la scène est généré. Puis commence le véritable entraînement de Gaussian 
Splatting : à partir de ce nuage grossier, les millions de taches 3D sont progressivement 
distribuées, agrandies, affinées et réajustées en position et en couleur, jusqu’à ce 
qu’elles produisent l’image attendue depuis tous les angles de vue d’entrée.

Vous n’avez besoin de rien savoir de tout cela pour utiliser RadianceKit. Le mode 
débutant masque complètement ces étapes. Mais si vous voulez comprendre ce que 
signifient les valeurs de diagnostic du mode expert (itération, loss, gaussiennes, SSIM 
…) ou pourquoi certaines scènes rendent mieux que d’autres, les chapitres ultérieurs du 
manuel vous donneront les réponses.
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C H A P I T R E

Chapitre 1 — Barre de menus

La barre de menus de RadianceKit structure toutes les fonctions qui ne se trouvent 
pas directement dans la fenêtre principale ou dans l’inspecteur. Il s’agit en premier 
lieu d’actions qui agissent sur toute la scène (ouvrir, enregistrer, nouveau projet), qui 
pilotent l’entraînement (démarrer, mettre en pause, reprendre), qui pilotent le viewport 
(auto-rotation, capture d’écran, couleur de fond) et qui déclenchent les exports vers 
différents formats 3D et médias. S’ajoutent des points de saut vers toutes les fenêtres 
auxiliaires (User Guide, Pareto Dashboard, Holdout Analysis, BayesOpt Console).

Les raccourcis clavier figurent à droite de chaque entrée de menu. Conventions : ⌘  
désigne la touche Command (touche pomme), ⇧  est Shift, ⌥  est Option (Alt) et 
⌃  est Control. Exemple : ⇧⌘T  correspond à Shift+Command+T. Tous les raccourcis 

documentés ici sont en plus listés dans une fenêtre récapitulative propre via Help → 
Keyboard Shortcuts (⌘/​).

Les 42 entrées suivantes sont documentées dans l’ordre de l’inventaire (M1–M42), 
groupées par menu de premier niveau. Toutes les entrées ont été vérifiées contre l’état 
actuel du code dans (lignes 175–477). Aucune entrée n’a été supprimée ou rendue 
obsolète par rapport à l’inventaire ; une nouvelle entrée du menu Edit (Cmd-Z pour « 
Remove Image ») est prise en charge par le framework système NSUndoManager et 
n’apparaît donc pas dans le code de l’app RadianceKit (voir la remarque en fin de 
chapitre).
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Menu File

Figure 1. –  Menu Fichier déplié — entrées M1 à M6

Le menu File remplace l’entrée standard Apple « New Window » par des actions spéci
fiques au projet. Il regroupe le chargement et l’enregistrement de scènes, une liste 
Recent dynamique, l’import de workspace ainsi que la remise à zéro complète.

M1 File > Open Scene…

O Ù

Barre de menus → File → Open Scene… (⌘O).

T E C H N I Q U E

Ouvre une boîte de dialogue de sélection de fichier 
pour les formats bundle RadianceScene , .ply , 
.splat  et .spz . Sélection unique ; peut afficher 

à la fois des fichiers et des dossiers (pour le format 
bundle). Après une sélection réussie, le chemin est 
inscrit dans la liste Recent et la scène est chargée 
de manière asynchrone — la précédente est rempla
cée et le pipeline d’entraînement est initialisé avec 
l’état chargé. Les fichiers PLY/SPZ/Splat sont lus 
via les loaders de format respectifs ; le bundle 
.radiancescene  est un dossier avec un manifeste, 

un snapshot du nuage et les résultats SfM.

E N  B R E F

Vous chargez ainsi une scène 
déjà entraînée dans l’app. Fonc­
tionne avec le format propre à 
RadianceKit et avec les formats 
standards PLY, SPLAT et SPZ que 
produisent d’autres logiciels de 
splatting. Utilisez-le par exemple 
quand vous avez entraîné une 
scène pendant la nuit et que 
vous voulez continuer ou expor­
ter le lendemain. À l’ouverture, 
l’état précédent dans la fenêtre 
principale est remplacé — enre­
gistrez donc d’abord si la scène 
actuelle vous tient encore à 
cœur. Le chemin atterrit automa­
tiquement dans « Open Recent 
» (M3) pour un accès plus rapide 
la fois suivante.
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M2 File > Save Scene…

O Ù

Barre de menus → File → Save Scene… (⌘S).

T E C H N I Q U E

Ouvre une boîte de dialogue d’enregistrement avec 
le type de contenu bundle RadianceScene  et le 
nom préchargé scene.radiancescene. Écrit un dos
sier-package avec manifest.json , le nuage de 
gaussiennes sérialisé (snapshot PLY) et un dump 
du résultat SfM, de sorte qu’après réouverture 
le Continue-Training fonctionne aussi. L’entrée est 
désactivée tant qu’aucune gaussienne n’existe en
core. N’enregistre pas dans le dossier des logs 
d’entraînement, mais à l’endroit que la boîte de dia
logue indique — typiquement sous ~/​Documents/​.

E N  B R E F

Enregistre votre scène actuelle 
comme un fichier (plus exacte­
ment : comme un dossier-paquet 
qui ressemble à un fichier). Ce 
n’est qu’après cela que vous 
pourrez rouvrir cette scène plus 
tard avec « Open Scene… » (M1). 
Le paquet contient à la fois le 
nuage de gaussiennes et le ré­
sultat SfM, de sorte que vous 
pouvez aussi ajouter plus tard 
un Continue-Training (M12–M14). 
Tant que vous n’avez pas termi­
né d’entraînement, l’entrée est 
grisée. Le nom par défaut est 
scene.radiancescene — vous 
pouvez bien sûr choisir votre 
propre nom dans la boîte de dia­
logue.

M3 File > Open Recent > [noms de scène]

O Ù

Barre de menus → File → Open Recent → (liste).

T E C H N I Q U E

Sous-menu dynamique généré à partir d’une liste 
des chemins ouverts récemment (enregistrés dans 
les réglages). Chaque entrée est nommée d’après le 
fichier et chargée d’un clic. Si la liste est vide, le 
libellé désactivé « No Recent Scenes » apparaît à la 
place. À la manière d’Apple, la liste conserve les N 
dernières scènes ouvertes — la limite est appliquée 
à l’écriture dans les réglages, pas dans le builder du 
menu lui-même.

E N  B R E F

Vous voyez ici les scènes ou­
vertes récemment et pouvez y 
replonger d’un clic, sans pas­
ser par la boîte de dialogue. Si 
vous venez juste de commencer, 
la liste est vide et apparaît gri­
sée dans le menu. Chaque scène 
que vous ouvrez via « Open 
Scene… » (M1) atterrit automati­
quement dans cette liste. Quand 
elle devient trop chargée ou si 
vous voulez la vider pour des rai­
sons de confidentialité, utilisez « 
Clear Recent » (M4).
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M4 File > Open Recent > Clear Recent

O Ù

Barre de menus → File → Open Recent → Clear 
Recent.

T E C H N I Q U E

Vide la liste Recent dans les réglages. Effet im
médiat, sans dialogue de confirmation. L’entrée 
n’apparaît dans le sous- menu que s’il existe au 
moins une entrée dans la liste Recent (elle est pla
cée sous un séparateur après les chemins).

E N  B R E F

Vide la liste des scènes récem­
ment ouvertes. Pratique quand 
vous avez joué avec un jeu de 
données de test et que vous ne 
voulez plus voir les chemins. Les 
fichiers de scène eux-mêmes ne 
sont pas supprimés — seul le 
lien dans le menu. L’action est 
immédiate, sans confirmation ; 
ensuite, le sous-menu affiche « 
No Recent Scenes ». L’entrée 
n’apparaît que s’il y a effective­
ment des scènes dans la liste — 
sur une liste vide, elle est invi­
sible.

M5 File > Import COLMAP / Metashape Workspace…

O Ù

Barre de menus → File → Import COLMAP / Meta
shape Workspace… (⇧⌘I).

T E C H N I Q U E

Ouvre un sélecteur de dossier. Attend un dos
sier respectant la disposition COLMAP workspace 
(par ex. sparse/​0/​cameras.{bin,txt} avec images/​
). Après sélection, une prévérification du workspace 
est effectuée — elle reconnaît les trois dispositions 
(sparse/​0/​, sparse/​, racine) et indique si la recons
truction est binaire ( cameras.bin ) ou texte ETH3D 
( cameras.txt ). En cas de succès, le workspace 
est importé ; sinon, seul un avertissement apparaît 
dans le journal de l’app. Voir aussi le chapitre 9 « 
Backends SfM », Q6 pour la logique complète du 
pipeline.

E N  B R E F

Si vous utilisez Metashape, COL­
MAP, RealityCapture ou un logi­
ciel similaire pour la reconstruc­
tion caméra et que vous avez 
un export, vous chargez le dos­
sier ici. RadianceKit saute alors 
l’étape SfM et démarre directe­
ment avec l’entraînement — ce 
qui fait gagner des heures sur 
de grandes scènes. Le glisser-
déposer sur la fenêtre princi­
pale fonctionne pareillement. Le 
dossier attendu suit la disposi­
tion COLMAP (sparse/​0/​ avec 
cameras.*  plus un dossier 
images/​). Plus de détails sur les 
dispositions prises en charge et 
les workflows au chapitre 9 « Ba­
ckends SfM ».
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M6 File > New Project

O Ù

Barre de menus → File → New Project (⇧⌘N).

T E C H N I Q U E

Vérifie s’il existe du travail non enregistré. Si oui, 
un dialogue de confirmation apparaît avant toute 
perte. Si rien n’est à enregistrer, la remise à zéro a 
lieu directement — elle vide les images importées, 
le résultat SfM, le nuage de gaussiennes, l’état 
d’entraînement et tous les indicateurs UI associés. 
Attention : une bibliothèque de préréglages créée 
par l’utilisateur est conservée, parce qu’elle réside 
dans les réglages de l’app et non dans l’état projet.

E N  B R E F

Remet tout à zéro — comme 
si vous veniez d’ouvrir l’app 
pour la première fois. S’il reste 
du travail non enregistré, l’app 
vous demande d’abord. Utilisez 
cela quand vous voulez com­
mencer avec une toute autre 
scène. Images importées, résul­
tat SfM, nuage de gaussiennes 
et état d’entraînement sont en­
tièrement vidés. Vos préréglages 
personnels restent en revanche 
conservés, parce qu’ils résident 
dans les réglages de l’app et 
n’appartiennent pas à la scène.

Menu Mode

Figure 2. –  Menu Mode avec interrupteur Simple/Expert

Deux interrupteurs simples entre le mode débutant guidé (façon assistant en 4 étapes) 
et le mode expert complet (disposition inspecteur classique avec tous les contrôles).
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M7 Mode > Simple Mode

O Ù

Barre de menus → Mode → Simple Mode (⌘1).

T E C H N I Q U E

Bascule l’état de l’app sur le Simple Mode. La zone 
principale de l’app affiche alors le workflow guidé 
au lieu de la disposition expert. L’état de mode est 
enregistré dans les réglages (voir S1 « Default Mode 
» au chapitre 3 Réglages).

E N  B R E F

Bascule sur la variante pas-à-
pas, où l’app vous guide à travers 
import, traitement, aperçu et ex­
port. Recommandé si vous débu­
tez ou si vous voulez un résultat 
rapide. La plupart des réglages 
détaillés sont masqués — vous 
travaillez avec des préréglages 
sensés. Si vous voulez ensuite al­
ler plus loin, passez simplement 
en Expert Mode (M8). Le mode 
actif au démarrage de l’app se 
règle dans les Réglages (chapitre 
3, S1).

M8 Mode > Expert Mode

O Ù

Barre de menus → Mode → Expert Mode (⌘2).

T E C H N I Q U E

Bascule l’état de l’app en Expert Mode. La disposi
tion inspecteur complète apparaît avec toutes les 
sections (Presets, TrainingConfig, Enhancements, 
Metrics, LossChart, ProjectNavigator). En Expert 
Mode, tous les paramètres d’entraînement, sélec
teurs COLMAP, toggles Mid-Compact et diagnostics 
sont accessibles. Le Live Preview ne fonctionne 
également que dans ce mode.

E N  B R E F

Bascule en vue complète avec 
tous les contrôles. Vous voyez 
ici les graphiques de loss en 
temps réel, pouvez affiner tous 
les paramètres et gérer plu­
sieurs configurations de compa­
raison en parallèle via les pré­
réglages. Recommandé si vous 
voulez comprendre ce que fait 
l’entraînement en interne ou ex­
périmenter de manière ciblée. Le 
Live Preview, les sélecteurs COL­
MAP et les diagnostics ne sont 
également accessibles qu’ici. Si 
vous vous sentez débordé, re­
passez via M7 en Simple Mode — 
votre scène reste préservée.
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Menu Training

Figure 3. –  Menu Training avec sous-menu Continue — entrées M9 à M14

Quatre actions autour de l’exécution d’entraînement : démarrer, mettre en pause, annu
ler et prolonger d’un nombre d’itérations prédéfini. Les trois entrées Continue sont 
gérées par IAP (non cliquables dans la version d’essai gratuite).

M9 Training > Start Training

O Ù

Barre de menus → Training → Start Training (⇧⌘T).

T E C H N I Q U E

Démarre le pipeline d’entraînement de manière 
asynchrone. Préalable : un résultat SfM existe et au
cun autre pipeline ne tourne actuellement. Les deux 
conditions bloquent l’entrée si elles ne sont pas 
remplies. Au démarrage, les valeurs de configura
tion courantes sont lues, un nouveau log JSONL est 
créé sous ~/​Documents/​RadianceKit/​Logs/​training_​
YYYY-MM-DD_​HHmmss.jsonl, et selon la stratégie 
choisie le chemin classique ou MCMC est emprunté. 
L’état d’entraînement passe d’« idle » à « training ».

E N  B R E F

Appuie sur le grand bouton 
vert — dès que vous avez im­
porté des photos et que la 
reconstruction caméra est ter­
minée, l’entraînement Gaussian 
Splatting proprement dit com­
mence. Laissez l’app tourner ; 
selon le préréglage, de 1 mi­
nute (Quick) à plusieurs heures 
(MCMC Quality). L’entrée reste 
grisée tant qu’aucun résultat 
SfM n’est disponible ou tant 
qu’un autre pipeline tourne. 
Chaque exécution écrit en pas­
sant un log dans ~/​Documents/​
RadianceKit/​Logs/​, que vous 
pouvez analyser plus tard via le 
Pareto Dashboard (M40).
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M10 Training > Pause Training

O Ù

Barre de menus → Training → Pause Training.

T E C H N I Q U E

Met l’entraînement en cours en pause. N’est dé
bloqué que si l’état d’entraînement est « training 
». La pause stoppe la boucle d’itérations au pro
chain point de synchronisation sécurisé, conserve 
tout l’état GPU (buffers de gaussiennes, moments 
d’optimiseur, position du scheduler) et bascule sur 
« paused ». La reprise se fait par une nouvelle pres
sion (le titre d’entrée est statique — l’app bascule 
cependant entre pause et reprise dans la logique in
terne). Les entraînements en pause ne survivent pas 
à un quit de l’app ; dans ce cas, enregistrez plutôt la 
scène et prolongez-la plus tard via l’entrée Continue 
Training (M12–M14).

E N  B R E F

Met l’entraînement en pause 
sans perdre la progression. Pra­
tique si vous avez besoin du 
Mac un instant pour quelque 
chose de plus important. Un 
nouveau clic reprend. Ne fonc­
tionne pas au-delà des redémar­
rages d’app — si vous voulez 
vraiment continuer plus tard, ter­
minez l’entraînement avec Can­
cel (M11), enregistrez la scène 
avec Save Scene (M2) et utilisez 
ensuite Continue Training (M12–
M14). Pendant la pause, le GPU 
est totalement au repos ; la mé­
moire reste cependant occupée.

M11 Training > Cancel Training

O Ù

Barre de menus → Training → Cancel Training.

T E C H N I Q U E

Annule l’entraînement en cours. Actif tant que l’état 
d’entraînement n’est pas « idle ». Pose le flag 
d’annulation dans le moteur d’entraînement, ce qui 
termine proprement la boucle d’itérations au pro
chain point de sync, écrit l’entrée Summary finale 
dans le log JSONL et remet l’état sur « idle ». Le 
nuage entraîné jusque-là reste (peut être enregistré 
ou exporté) mais est marqué « cancelled ».

E N  B R E F

Annule définitivement 
l’entraînement en cours. L’état 
actuel reste — si après quelques 
milliers d’itérations vous avez 
déjà un résultat présentable, 
vous pouvez quand même 
l’exporter. Si vous voulez juste 
interrompre brièvement, utilisez 
plutôt Pause (M10). Dans le log 
d’entraînement, l’exécution est 
marquée « cancelled », la valeur 
finale de loss est tout de même 
écrite. Une scène annulée peut 
aussi être poursuivie plus tard 
via Continue Training (M12–M14), 
tant que l’app n’a pas été quittée 
entre-temps.
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M12 Training > Continue Training > +5 000 iterations

O Ù

Barre de menus → Training → Continue Training → 
+5,000 iterations.

T E C H N I Q U E

Poursuit l’entraînement de 5 000 itérations. Actif 
quand un entraînement terminé peut être prolongé 
et que la version complète est débloquée. La possi
bilité de reprise vaut quand un entraînement terminé 
existe et que l’état complet de l’optimiseur est en
core en mémoire. Lors du Continue, les moments 
Adam et le scheduler de LR sont poursuivis, de 
sorte que la prolongation se comporte comme une 
exécution continue 25K/45K/60K plutôt que comme 
un redémarrage. Le log JSONL reçoit une nouvelle 
entrée de configuration avec le setup incrémental. 
Disponible uniquement dans la version complète.

E N  B R E F

Ajoute 5 000 étapes 
d’entraînement supplémen­
taires. Utilisez-le quand le ré­
sultat après le premier run 
est proche mais pas encore 
tout à fait net. Ne fonctionne 
que dans la version payante. 
Contrairement à une exécution 
entièrement nouvelle, l’état de 
l’optimiseur est conservé, de 
sorte que la prolongation res­
semble à une exécution conti­
nue. Si vous avez besoin de plus 
de 5 000 étapes, prenez directe­
ment M13 (+10 000) ou M14 (+20 
000).

M13 Training > Continue Training > +10 000 iterations

O Ù

Barre de menus → Training → Continue Training → 
+10,000 iterations.

T E C H N I Q U E

Identique à M12 mais avec 10 000 itérations sup
plémentaires. Mêmes préconditions, même trajec
toire du scheduler de LR. Recommandé quand 
l’entraînement initial a été mené avec un préréglage 
mid-tier et que vous voulez voir une amélioration 
significative de qualité sans tout reprendre.

E N  B R E F

Prolonge l’entraînement de 10 
000 étapes — la valeur intermé­
diaire des trois Continue dispo­
nibles. Bon choix quand la pre­
mière exécution était correcte 
mais que vous voulez encore net­
tement améliorer. Comme M12 
et M14, la trajectoire des taux 
d’apprentissage est poursuivie 
sans rupture au lieu de redémar­
rer. Disponible uniquement dans 
la version complète.
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M14 Training > Continue Training > +20 000 iterations

O Ù

Barre de menus → Training → Continue Training → 
+20,000 iterations.

T E C H N I Q U E

Identique à M12 / M13 mais avec 20 000 itérations 
supplémentaires. Le plus grand saut Continue pré
défini. Sur les entraînements MCMC, c’est souvent 
ce qui fait la différence entre « correct » et « digne 
d’un benchmark » ; sur du Classic au-delà de 35–
40K, l’expérience montre que peu de choses s’y 
ajoutent.

E N  B R E F

Ajoute 20 000 étapes 
d’entraînement supplémen­
taires, la valeur Continue maxi­
male. Utilisez cela quand vous 
voulez vraiment extraire la der­
nière goutte de qualité. Sur de 
l’entraînement classique après 
40 000 étapes, cela n’apporte 
souvent plus grand-chose — sur 
du MCMC en revanche, c’est sou­
vent utile, parce que la conver­
gence y est plus lente. Comptez 
sur des temps d’exécution sen­
siblement plus longs selon la 
scène. Comme M12 et M13, cette 
entrée n’est disponible que dans 
la version complète.

Menu Viewport

Figure 4. –  Menu Viewport avec mode édition, contrôle caméra et sous-menu Background

Pilote le viewport 3D : mode édition pour sélection et nettoyage des gaussiennes, 
contrôle caméra (auto-rotation, lecture, enregistrement), capture d’écran, couleur de 
fond et reset.
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M15 Viewport > Enter/Exit Edit Mode

O Ù

Barre de menus → Viewport → Enter Edit Mode (ou 
« Exit Edit Mode » selon l’état). ⇧⌘E.

T E C H N I Q U E

Le titre d’entrée est dynamique et indique « Exit Edit 
Mode » ou « Enter Edit Mode » selon l’état. À la 
pression, le mode édition du renderer viewport est 
commuté. En quittant le mode édition, la sélection 
actuelle est en plus remise à zéro. Le mode édition 
active la sélection au clic sur les gaussiennes, la sé
lection par boîte et la suppression des gaussiennes 
marquées (voir la zone Editor de l’UI). Désactivé 
tant qu’aucun renderer viewport n’est attaché.

E N  B R E F

Bascule entre vue 3D normale 
et un mode édition dans le­
quel vous pouvez marquer et 
supprimer des gaussiennes indi­
viduelles (par ex. des floaters 
ou des aberrations en arrière-
plan). À la sortie, la sélection 
est automatiquement réinitiali­
sée. L’entrée reste grisée tant 
qu’aucune scène n’est visible 
dans le viewport. Le libellé bas­
cule entre « Enter Edit Mode » 
et « Exit Edit Mode » selon l’état 
— vous voyez ainsi toujours dans 
quel mode vous êtes.

M16 Viewport > Toggle Auto-Rotation

O Ù

Barre de menus → Viewport → Toggle Auto-Rotation 
(⌘⌥T).

T E C H N I Q U E

Active ou désactive la rotation continue de la camé
ra du viewport autour d’un axe vertical passant par 
le centre de la scène. Axe et vitesse proviennent 
de la configuration de contrôle caméra. L’auto-rota
tion est un effet purement viewport et n’influence 
ni l’entraînement ni l’enregistrement — si vous utili
sez en parallèle l’enregistreur vidéo turntable (M18), 
l’auto-rotation fournit exactement la trajectoire que 
l’enregistreur capture.

E N  B R E F

Fait tourner lentement la caméra 
en permanence autour de votre 
scène, pour la voir sous tous les 
angles sans faire glisser la sou­
ris. Un nouveau clic stoppe la 
rotation. Pratique pour examiner 
des scènes terminées ou comme 
animation de fond pour une dé­
mo live. Si vous enregistrez une 
vidéo en parallèle (M18), l’auto-
rotation fournit exactement le 
mouvement que l’enregistreur 
capture.
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M17 Viewport > Toggle Camera Playback

O Ù

Barre de menus → Viewport → Toggle Camera Play
back.

T E C H N I Q U E

Bascule la lecture du chemin caméra. Si un chemin 
caméra enregistré existe (par ex. d’un enregistre
ment précédent ou parce qu’un transforms.json  a 
été chargé), le chemin se joue — la caméra viewport 
ne réagit plus aux entrées souris/trackpad mais re
produit la trajectoire image par image. Une nouvelle 
pression met la lecture en pause.

E N  B R E F

Joue un trajet caméra précé­
demment enregistré ou importé. 
Vous pouvez ainsi revivre le tra­
jet original avec lequel la scène 
a été capturée ou vérifier un 
mouvement orbital prévu avant 
l’export vidéo. Pendant la lec­
ture, les entrées souris et track­
pad sont désactivées — la camé­
ra suit strictement le chemin. Un 
nouveau clic met la lecture en 
pause. Si vous n’avez ni chargé 
ni enregistré de chemin caméra, 
rien ne se passe.

M18 Viewport > Record Turntable Video

O Ù

Barre de menus → Viewport → Record Turntable 
Video.

T E C H N I Q U E

Bascule l’enregistrement du viewport. À la première 
pression, un enregistrement d’images démarre vers 
un chemin temporaire ; à la deuxième pression, 
l’enregistrement est terminé, encodé et écrit dans 
un chemin MP4 (chemin demandé via une boîte de 
dialogue d’enregistrement). Contrairement à Export 
→ Media → Orbit Video (M31) qui produit un trajet 
360° fixe à durée réglable, l’enregistreur turntable 
capture en direct ce que vous voyez dans le view
port — vous pouvez donc aussi enregistrer un trajet 
caméra manuel.

E N  B R E F

Enregistre une vidéo directement 
dans le viewport. Que la caméra 
tourne automatiquement ou que 
vous la déplaciez vous- même 
à la souris — tout ce que 
vous voyez est enregistré dans 
un fichier MP4. Contrairement à 
l’export « Orbit Video » (M31), 
vous définissez vous-même le 
trajet caméra. Un premier clic 
démarre l’enregistrement, un 
second l’arrête et vous de­
mande l’emplacement de sauve­
garde. Pratique pour montrer par 
exemple un travelling de détail 
précis qu’on ne pourrait pas ob­
tenir avec l’orbite rigide.

16 / 177



R A D I A N C E K I T Chapitre 1 — Barre de menus

M19 Viewport > Save Screenshot

O Ù

Barre de menus → Viewport → Save Screenshot 
(⇧⌘S).

T E C H N I Q U E

Capture un seul frame de viewport à pleine résolu
tion de rendu (donc pas la disposition de pixels de 
la fenêtre mais le contenu complet de la cible de 
rendu) en PNG. Le chemin est demandé via une 
boîte de dialogue. La couleur de fond (M21–M23) 
est intégrée. Les réglages d’upscaling MetalFX/MPS 
des Enhancements (voir I27/I28) ont un effet si ac
tifs — la capture montre alors la sortie upscale.

E N  B R E F

Enregistre un instantané de votre 
vue 3D actuelle en image PNG. 
Pratique pour du matériel marke­
ting ou une comparaison rapide. 
Attention : le fond fait partie de 
l’image — si vous avez besoin 
de transparence, exportez plutôt 
un fichier de scène. La résolution 
correspond à la cible de rendu 
interne, pas à la taille de votre 
fenêtre — l’image est donc sou­
vent plus nette qu’elle ne paraît 
à l’écran. Les éventuels réglages 
d’upscaling (Inspector → Enhan­
cements) sont également appli­
qués.

M20 Viewport > Copy Camera Info

O Ù

Barre de menus → Viewport → Copy Camera Info.

T E C H N I Q U E

Lit la pose caméra courante du viewport (position, 
point de visée, vecteur up) et les valeurs de FOV 
depuis le contrôle caméra, et les écrit en texte 
multi-lignes dans le presse-papiers. Le format est 
lisible (label = value par ligne), pas JSON. Pratique 
pour reproduire une vue spécifique à des fins de 
debug ou à partager avec le support.

E N  B R E F

Copie la position et la direction 
de regard actuelles de la camé­
ra sous forme de texte dans le 
presse-papiers. Si vous voulez 
par ex. montrer à un collègue 
d’où une zone de la scène paraît 
bizarre, vous collez simplement 
le texte dans un mail ou un chat. 
Le format est lisible (une ligne 
par valeur), pas du JSON. Prin­
cipalement pensé pour les rap­
ports de bug ou les demandes de 
support.
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M21 Viewport > Background > Dark Gray

O Ù

Barre de menus → Viewport → Background → Dark 
Gray.

T E C H N I Q U E

Fixe la couleur de fond du viewport à un gris foncé 
(RGB 0.1/0.1/0.1). Le renderer utilise cette couleur 
comme arrière-plan devant lequel les gaussiennes 
sont composées. La couleur par défaut au démar
rage de l’app est contrôlée par l’option S3 « Default 
Viewport Background » des réglages.

E N  B R E F

Colore le fond du viewport 3D en 
gris foncé. Choix standard pour 
la plupart des scènes — offre 
un bon contraste avec les gaus­
siennes claires comme sombres, 
sans que l’œil s’accroche à une 
surface noire ou blanche pure. La 
couleur est aussi appliquée aux 
captures d’écran (M19) et vidéos 
orbitales (M31). Si vous trouvez 
Dark Gray trop sage, essayez 
aussi Black (M22) ou White (M23) 
pour comparer. La couleur active 
au démarrage se règle dans les 
Réglages (S3).

M22 Viewport > Background > Black

O Ù

Barre de menus → Viewport → Background → Black.

T E C H N I Q U E

Fixe la couleur de fond du viewport en noir pur (RGB 
0/0/0). Utile si la scène contient beaucoup de floa
ters clairs et que vous voulez les identifier, ou pour 
du matériel marketing à ambiance sombre.

E N  B R E F

Fond noir. Bien pour des scènes 
très claires ou pour inspecter 
en mode édition et repérer de 
petites gaussiennes claires (floa­
ters) qui se perdraient dans le 
gris. Idéal aussi pour du matériel 
marketing à l’ambiance sombre 
et dramatique. La couleur est in­
tégrée aux captures d’écran et 
vidéos orbitales — si vous avez 
besoin de transparence pour un 
composite ultérieur, le noir est 
le pire choix. Pour les floaters 
sombres, basculez plutôt dans 
l’autre sens vers White (M23).
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M23 Viewport > Background > White

O Ù

Barre de menus → Viewport → Background → 
White.

T E C H N I Q U E

Fixe la couleur de fond du viewport en blanc pur 
(RGB 1/1/1). Utile si la scène contient majoritaire
ment du contenu sombre et que vous voulez voir 
des floaters sombres (bruit typique d’arrière-plan 
outdoor).

E N  B R E F

Fond blanc. Pratique quand le 
sujet rend mieux en clair sur 
sombre, ou pour trouver les aber­
rations sombres que vous pou­
vez ensuite supprimer en mode 
édition (M15). Sur les scènes out­
door, le blanc est souvent plus 
utile que le noir, parce que les 
floaters outdoor typiques sont 
plutôt sombres. Comme pour les 
autres options de fond, la cou­
leur est appliquée aux captures 
et vidéos.

M24 Viewport > Reset Camera

O Ù

Barre de menus → Viewport → Reset Camera.

T E C H N I Q U E

Réinitialise la caméra du viewport, quitte la vue Trai
ning-Camera et stoppe l’auto-rotation. La caméra 
revient ainsi à sa position initiale (typiquement : de
vant la scène, en regardant légèrement de dessus), 
l’auto-rotation est désactivée et, si le renderer affi
chait une Training-Camera (une des poses SfM), il 
repasse en Free-Camera.

E N  B R E F

Ramène la caméra du viewport 
à la position de départ. Si vous 
vous êtes perdu en tournant ou 
avez fait sortir la scène du cadre 
— un clic ici et vous voyez à nou­
veau ce que vous devriez voir. 
Désactive simultanément l’auto-
rotation si elle tourne et quitte 
une caméra d’entraînement ge­
lée pour revenir à la vue libre. 
Vous obtenez ainsi dans tous les 
cas un redémarrage propre de la 
vue.
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Menu Export

Figure 5. –  Menu Exporter avec trois groupes de sous-menus — 3D Formats, Media et 
Photogrammetry

Huit cibles d’export plus deux exports photogrammétrie, groupés en trois sections (3D 
Formats, Media, Photogrammetry). Les six premières sont construites via une routine 
helper commune qui ouvre à chaque fois une boîte de dialogue d’enregistrement et 
enregistre l’export dans le catalogue de formats. Les entrées photogrammétrie ont une 
logique propre. Tous les exports photogrammétrie et certains exports 3D ne sont dispo
nibles que dans la version complète.

M25 Export > 3D Formats > Export PLY…

O Ù

Barre de menus → Export → 3D Formats → PLY 
(⌘E).

T E C H N I Q U E

Ouvre une boîte de dialogue d’enregistrement avec 
le nom préchargé gaussians.ply . À OK, le nuage 
de gaussiennes courant est écrit au format PLY AS
CII/binaire standard — compatible avec SuperSplat, 
PolyCam, PlayCanvas et toutes les visionneuses 
3DGS courantes. Coefficients SH complets, préci
sion complète (Float32 par champ). Taille de fichier 
souvent plusieurs centaines de Mo au-delà de 500K 
gaussiennes.

E N  B R E F

Enregistre votre scène 3D en fi­
chier PLY standard. C’est le for­
mat le plus universel — presque 
tous les logiciels peuvent le 
charger, de SuperSplat à Poly­
Cam en passant par PlayCanvas. 
Les fichiers deviennent toutefois 
volumineux, souvent plusieurs 
centaines de mégaoctets. Utili­
sez PLY pour continuer en quali­
té maximale ou pour archiver. Si 
vous voulez partager la scène sur 
le web, regardez plutôt SPZ (M27) 
ou Compressed PLY (M26) — bien 
plus petits.
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M26 Export > 3D Formats > Export Compressed PLY…

O Ù

Barre de menus → Export → 3D Formats → Com
pressed PLY.

T E C H N I Q U E

Écrit le nuage de gaussiennes au format PLY 
compressé avec quantification custom des champs 
position, échelle, rotation et SH. 5 à 10× plus 
petits que le PLY non compressé (M25) avec des 
pertes visuelles minimes. Compatible avec Super
Splat (qui lit le standard Compressed PLY) et 
PlayCanvas. Nom de fichier par défaut gaussians_​
compressed.ply.

E N  B R E F

Comme le PLY normal, mais 5 à 
10 fois plus petit. La qualité reste 
presque la même. Utilisez-le si 
vous voulez partager le fichier 
en ligne ou par mail. Fonctionne 
directement avec SuperSplat et 
PlayCanvas. Si votre système 
cible a besoin de fichiers en­
core plus petits (mobile, démos 
navigateur), prenez plutôt SPZ 
(M27) — compressé encore plus 
agressivement. Pour une qualité 
d’édition complète, prenez le PLY 
non compressé (M25).

M27 Export > 3D Formats > Export SPZ…

O Ù

Barre de menus → Export → 3D Formats → SPZ.

T E C H N I Q U E

Écrit le nuage de gaussiennes au format SPZ — le 
format de splat compressé publié par Niantic avec 
une quantification agressive (~90 % plus petit qu’un 
PLY non compressé). Optimisé surtout pour les vi
sionneuses web et apps mobiles. Compatible avec 
Niantic Splatt3R, gsplat.js et la visionneuse naviga
teur de Niantic.

E N  B R E F

Un des plus petits formats. Envi­
ron 10× plus petit qu’un PLY nor­
mal. Utilisez-le surtout si vous 
voulez montrer la scène dans 
un navigateur ou la regarder via 
une app mobile. Pour une quali­
té maximale, PLY est le meilleur 
choix. SPZ est développé par 
Niantic et fonctionne directe­
ment avec gsplat.js, Splatt3R et 
la visionneuse web Niantic. À 
cause de la forte compression, 
vous ne pouvez plus facilement 
réentraîner les fichiers SPZ — 
pour l’édition, prenez PLY.
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M28 Export > 3D Formats > Export glTF…

O Ù

Barre de menus → Export → 3D Formats → glTF.

T E C H N I Q U E

Écrit un fichier .glb  (Binary glTF) avec l’extension 
KHR_gaussian_splatting. Conforme au standard, 
adapté aux pipelines qui utilisent des moteurs glTF 
tels que Babylon.js ou Three.js et qui implémentent 
l’extension KHR_gaussian_splatting.

E N  B R E F

Enregistre la scène au format 
glTF, que beaucoup de logiciels 
3D et moteurs web comprennent 
— à condition qu’ils prennent 
en charge l’extension Gaussian 
Splatting. Si vous avez un pi­
peline 3D spécifique (par ex. 
Three.js ou Babylon.js) qui com­
prend cela, c’est votre format. 
Le fichier sort en .glb  bi­
naire — un unique paquet conte­
nant tout. Pour des workflows 
splatting classiques, PLY ou SPZ 
sont généralement préférables, 
car davantage d’outils les com­
prennent directement.

M29 Export > 3D Formats > Export .splat…

O Ù

Barre de menus → Export → 3D Formats → .splat.

T E C H N I Q U E

Écrit le format antimatter15 .splat  — taille fixe 
32 octets par gaussienne (position en 3× Float32, 
échelle en 3× Float32, rotation en 4× Uint8 quater
nion normalisé, RGB+opacité en 4× Uint8). Pas de 
coefficients SH supérieurs au DC. Plus petit fichier 
directement compatible navigateur. Pour gsplat.js et 
la visionneuse de démo en ligne d’antimatter15.

E N  B R E F

Le format de visionneuse web le 
plus simple. Petit et affichable 
immédiatement dans n’importe 
quel navigateur. Perd cepen­
dant l’éclairage détaillé (les co­
efficients SH supérieurs dispa­
raissent — le splat a la même 
apparence sous tous les angles 
au lieu de réagir à la lumière). 
Bien pour des performances web 
maximales, plutôt SPZ ou PLY 
pour du photo-réalisme. Fonc­
tionne avec la visionneuse en 
ligne antimatter15 et gsplat.js. 
Chaque gaussienne occupe fixe­
ment 32 octets, ce qui rend le 
format simple et compatible — 
mais au prix de la profondeur de 
détail.
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M30 Export > 3D Formats > Export SOG…

O Ù

Barre de menus → Export → 3D Formats → SOG.

T E C H N I Q U E

Écrit le nuage de gaussiennes au format SOG. SOG 
(« Self-Organizing Gaussian ») est le format Play
Canvas avec une disposition en atlas de textures et 
compression WebP des données quantifiées. Mise à 
l’échelle avec un rapport de taille 15 à 20× meilleur 
que le PLY. L’export appelle en interne cwebp  
comme outil externe — donc potentiellement limité 
dans la variante sandbox (App Store).

E N  B R E F

Format très petit pour les work­
flows PlayCanvas. Environ 15 à 
20 fois plus petit que le PLY, 
parce que les données sont em­
paquetées dans une disposition 
d’atlas de textures et compres­
sées WebP. Si vous n’avez pas 
de workflow PlayCanvas, SPZ ou 
Compressed PLY est générale­
ment le meilleur choix. L’export 
appelle en interne cwebp  
comme outil externe — dans 
la version App Store (sandbox), 
cette étape peut être limitée.

M31 Export > Media > Export Orbit Video…

O Ù

Barre de menus → Export → Media → Orbit Video.

T E C H N I Q U E

Rend une orbite 360° autour du centre de la scène 
et l’encode en MP4 (H.264) ou MOV (HEVC, selon 
le défaut système). Contrairement à M18 (enregis
trement live), le trajet est fixé ici — la durée se règle 
dans les réglages ou à l’étape Export du Simple 
Mode.

E N  B R E F

Crée automatiquement une vi­
déo de rotation autour de votre 
scène. Aucun déplacement ma­
nuel nécessaire. Bon pour les 
réseaux sociaux ou une démo ra­
pide. Si vous voulez piloter vous-
même la caméra, utilisez plutôt 
Record Turntable Video (M18). Le 
trajet est fixe : une orbite com­
plète à 360° autour du centre de 
la scène, la durée se choisit dans 
les réglages ou à l’étape Export 
du Simple Mode. La vidéo sort 
selon le système en MP4 H.264 
ou MOV HEVC.
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M32 Export > Media > Export Web Viewer…

O Ù

Barre de menus → Export → Media → Web Viewer.

T E C H N I Q U E

Empaquette une visionneuse HTML standalone (ba
sée sur gsplat.js) et les données de gaussiennes 
encodées en base64 dans un seul fichier .html . 
Ce fichier fonctionne hors ligne dans tout navi
gateur moderne — aucune dépendance serveur, au
cune URL externe. Taille de fichier environ 1.3× plus 
grande que la variante SPZ (à cause de l’overhead 
base64).

E N  B R E F

Enregistre votre scène comme 
page web autonome. Double clic 
sur le fichier HTML → le naviga­
teur s’ouvre → scène 3D interac­
tive prête. Fonctionne sans Inter­
net, s’envoie par mail, c’est la 
façon la plus simple de partager 
le résultat avec amis ou clients. 
Le fichier contient la visionneuse 
gsplat.js complète et les don­
nées de gaussiennes dans un 
seul document — rien n’est re­
chargé du web. Taille environ un 
tiers plus grande qu’un export 
SPZ, mais sans qu’aucun logiciel 
supplémentaire ne soit néces­
saire chez le destinataire.

M33 Export > Photogrammetry > Export SfM (transforms.json)…

O Ù

Barre de menus → Export → Photogrammetry → Ex
port SfM (transforms.json).

T E C H N I Q U E

Chemin d’export propre (pas via la routine hel
per commune), parce qu’aucun nuage de gaus
siennes n’est exporté mais le résultat SfM. Ouvre 
une boîte de dialogue d’enregistrement avec 
transforms.json  en valeur par défaut et type de 

contenu json . À OK, un transforms.json  compa
tible nerfstudio est écrit, avec intrinsics caméra, 
poses (matrice 4×4 en convention NeRF) et che
mins de frames. Un texte d’aide dans l’UI signale 
que les images d’entraînement doivent être copiées 
dans un dossier frère images/​. Actif uniquement 
quand un résultat SfM existe et que la version com
plète est débloquée.

E N  B R E F

Si vous voulez réutiliser le résul­
tat SfM dans un autre logiciel 
comme nerfstudio, Brush, gsplat 
ou OpenSplat, vous exportez ici 
les positions caméra. Placez en 
plus vos images d’entraînement 
dans un dossier images/​ à côté 
du fichier transforms.json  
— sinon le logiciel cible ne 
pourra pas associer les images. 
L’entrée est grisée tant qu’aucun 
résultat SfM n’existe et ver­
rouillée dans la version d’essai 
gratuite. Pour le workflow works­
pace COLMAP, prenez plutôt M34.
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M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

O Ù

Barre de menus → Export → Photogrammetry → Ex
port SfM (COLMAP Workspace).

T E C H N I Q U E

Ouvre une boîte de dialogue d’enregistrement 
avec le nom par défaut colmap-workspace  (sans 
extension, parce que c’est un dossier). Écrit 
un workspace COLMAP standard avec sparse/​0/​
cameras.bin, images.bin , points3D.bin . Permet 
d’ouvrir une reconstruction SfM calculée ou impor
tée dans RadianceKit dans d’autres outils comme 
Postshot, Nerfstudio ou Meshroom, ou de la rechar
ger dans RadianceKit comme entrée déjà-calculée 
lors d’un A/B re-run (via M5) — ce qui économise 
du temps de calcul. Actif uniquement quand un 
résultat SfM existe et que la version complète est 
débloquée.

E N  B R E F

Comme M33, mais au format 
COLMAP au lieu de nerfstudio. 
Si vous utilisez Postshot, Mesh­
room, Nerfstudio ou un autre 
outil à workflow COLMAP, c’est 
votre export. Effet secondaire 
pratique : vous pouvez rechar­
ger ce dossier plus tard dans 
RadianceKit via M5 et économi­
ser le temps de calcul SfM à la 
prochaine exécution — sur de 
grandes scènes, un gain de plu­
sieurs heures. Comme M33, dis­
ponible uniquement si un résul­
tat SfM existe et verrouillé dans 
la version d’essai gratuite.

Menu Help

Figure 6. –  Menu Aide avec entrées documentation, dossiers et analyse

Sept entrées : deux fenêtres de documentation (User Guide, Keyboard Shortcuts), trois 
raccourcis dossiers (Training Logs, Exports, Storage) et trois fenêtres d’analyse (Pareto 
Dashboard, Holdout Analysis, BayesOpt Console). À la manière d’Apple, le menu Help 
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apparaît tout à droite. Le menu Help standard est entièrement remplacé par la variante 
propre à RadianceKit.

M35 Help > User Guide

O Ù

Barre de menus → Help → User Guide (⌘?).

T E C H N I Q U E

Ouvre la fenêtre User Guide. Affiche une navigation 
avec une sidebar de thèmes et une zone de détail 
défilante à taille par défaut 860×640. Les contenus 
sont stockés en statique (non parsés depuis du 
Markdown).

E N  B R E F

Ouvre l’aide interne à l’app. Si 
vous ne voulez pas tout relire 
dans ce manuel, vous y trouverez 
les étapes les plus importantes 
directement dans le programme. 
L’aide est construite comme une 
fenêtre propre avec une sidebar 
de thèmes — vous pouvez ainsi 
sauter sur des sujets précis. Les 
contenus sont plus courts que ce 
manuel et se concentrent sur les 
workflows les plus courants.

M36 Help > Keyboard Shortcuts

O Ù

Barre de menus → Help → Keyboard Shortcuts (⌘/).

T E C H N I Q U E

Ouvre la fenêtre Keyboard Shortcuts — une dispo
sition défilante simple avec tous les raccourcis de 
l’app, groupés par menu de premier niveau. Taille 
par défaut 440×560. Contenus également stockés 
en statique.

E N  B R E F

Ouvre une fenêtre avec la liste 
complète des raccourcis clavier. 
Si vous ne vous souvenez pas 
par exemple de la touche qui dé­
marre l’entraînement, vous y je­
tez un œil. Un récapitulatif figure 
aussi en fin de chapitre. La liste 
est groupée par menu de premier 
niveau, ce qui permet de sauter 
rapidement à la bonne section. 
Utile si vous passez de la souris 
au style clavier.
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M37 Help > Open Training Logs…

O Ù

Barre de menus → Help → Open Training Logs… 
(⇧⌘L).

T E C H N I Q U E

Calcule le dossier de logs comme ~/​Documents/​
RadianceKit/​Logs, le crée si nécessaire et l’ouvre 
dans le Finder. Chaque exécution d’entraînement y 
écrit un fichier JSONL propre training_​YYYY-MM-DD_​
HHmmss.jsonl.

E N  B R E F

Ouvre dans le Finder le 
dossier avec tous les jour­
naux d’entraînement passés. Si 
quelque chose a mal tourné ou si 
vous voulez vérifier quand exac­
tement l’entraînement a conver­
gé vers quelle valeur, vous 
trouvez cela ici sous forme 
de fichiers JSONL. Un fichier 
daté est créé par exécution 
d’entraînement — vous pouvez 
aussi les lire dans d’autres ou­
tils ou les envoyer au support 
par mail. Si vous voulez une ana­
lyse graphique, le Pareto Dash­
board (M40) est le meilleur point 
d’entrée.

M38 Help > Open Exports Folder…

O Ù

Barre de menus → Help → Open Exports Folder…

T E C H N I Q U E

Analogue à M37, mais avec ~/​Documents/​
RadianceKit/​Exports. Créé au premier auto-test ou 
au premier clic ; les chemins par défaut de tous 
les exports d’auto-test y atterrissent ensuite (par 
ex. autotest_​<timestamp>.ply). Les exports choisis 
manuellement via la boîte de dialogue NE vont PAS 
forcément dans ce dossier, mais là où l’utilisateur 
les enregistre — ce dossier est donc surtout inté
ressant pour les auto-tests.

E N  B R E F

Ouvre le dossier dans lequel 
l’app dépose ses propres exports 
(surtout les auto-tests). Si vous 
avez enregistré un export ma­
nuellement ailleurs via la boîte 
de dialogue, il est là-bas et pas 
dans ce dossier. Pratique pour 
faire le ménage ou voir l’espace 
pris par d’anciens exports de 
test. Si vous voulez un aperçu 
complet incluant logs et bundles 
de scènes, prenez plutôt Manage 
Storage (M39).
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M39 Help > Manage Storage…

O Ù

Barre de menus → Help → Manage Storage…

T E C H N I Q U E

Ouvre le Storage-Browser (voir chapitre 4 Fenêtres 
auxiliaires, IDs W7–W12). Liste toutes les scènes 
persistées, logs d’entraînement, exports et caches 
dans le dossier ~/​Documents/​RadianceKit/​ avec leur 
taille, permet Reveal-in-Finder et Move-to-Trash par 
entrée.

E N  B R E F

Ouvre un navigateur de fe­
nêtre qui vous montre combien 
d’espace RadianceKit prend sur 
votre disque — par scène, log et 
export. Vous pouvez supprimer 
directement des éléments sans 
passer par le Finder. Pratique 
après un usage prolongé, quand 
le disque se remplit — les an­
ciens logs et exports d’auto-test 
peuvent atteindre plusieurs giga­
octets. Via Reveal-in-Finder, vous 
arrivez à tout moment à la vue 
classique.

M40 Help > Pareto Dashboard…

O Ù

Barre de menus → Help → Pareto Dashboard… 
(⇧⌘D).

T E C H N I Q U E

Ouvre le Pareto Dashboard (voir chapitre 4, 
IDs W13–W22). Le dashboard charge tous les 
logs d’entraînement JSONL depuis ~/​Documents/​
RadianceKit/​Logs/​, les classe par scène et préré
glage et dessine un scatter plot Pareto (par défaut : 
Loss vs gaussiennes, optionnellement Loss vs Wall
clock ou PSNR vs itérations).

E N  B R E F

Ouvre une vue d’ensemble gra­
phique de toutes les exécutions 
d’entraînement passées. Vous 
voyez tout de suite quel run 
a fourni le meilleur compromis 
qualité/taille. Pratique pour com­
parer différents préréglages. Par 
défaut, le diagramme affiche 
Loss vs nombre de gaussiennes 
— vous pouvez aussi basculer 
sur le temps wallclock ou PSNR. 
Les données viennent des logs 
d’entraînement JSONL (M37) ; 
plus vous avez de runs, plus 
l’analyse est parlante.

28 / 177



R A D I A N C E K I T Chapitre 1 — Barre de menus

M41 Help > Holdout Analysis…

O Ù

Barre de menus → Help → Holdout Analysis… 
(⇧⌘H).

T E C H N I Q U E

Ouvre la fenêtre Holdout Analysis (voir chapitre 
4, IDs W23–W29). Charge un transforms.json , 
dessine les caméras comme un globe 3D et per
met des splits train/test (angulaires ou linéaires, 
2–8 folds). Sortie : un fold-assignment.json que 
l’entraînement peut utiliser comme test-set dans les 
configurations d’entraînement correspondantes.

E N  B R E F

Vous aide à découper vos prises 
caméra en sets d’entraînement 
et de test — pour mesurer ob­
jectivement la qualité de votre 
scène (sur des images que 
l’entraînement n’a pas vues). 
Plutôt un outil de recherche et 
de benchmark. Les caméras sont 
représentées comme un globe 
3D ; vous pouvez choisir entre 
2 et 8 folds, soit régulièrement 
par angle, soit linéairement par 
ordre. Le résultat est un petit 
fichier JSON que l’entraînement 
utilisera ensuite comme test-set.

M42 Help > BayesOpt Console…

O Ù

Barre de menus → Help → BayesOpt Console… 
(⇧⌘B).

T E C H N I Q U E

Ouvre la BayesOpt Console (voir chapitre 4, IDs 
W30–W39). Charge des espaces de recherche pré
définis (par ex. « MCMC scale-reg + opacity-reg 
+ ssim »), exécute des trials d’optimisation bayé
sienne de manière asynchrone et affiche en direct la 
courbe de convergence et le log des trials.

E N  B R E F

Une console d’auto-tuning inté­
grée. Au lieu d’essayer manuel­
lement différents paramètres, 
l’app peut les faire tourner elle-
même la nuit et vous proposer à 
la fin les meilleures valeurs pour 
votre scène. Outil très avancé — 
pour la plupart des workflows, un 
bon préréglage (voir chapitre 7) 
suffit. Vous choisissez un espace 
de recherche prédéfini (par ex. 
« MCMC scale-reg + opacity-reg 
+ ssim ») et voyez en direct la 
courbe de convergence ainsi que 
le log des trials. Comptez plu­
sieurs heures à plusieurs jours 
selon le setup.

Remarque : Cmd-Z dans le menu Edit

Depuis mai 2026, le Project Navigator en Expert Mode prend en charge la suppression 
d’images importées via le bouton moins ou la touche Backspace, et l’annulation via 
Cmd-Z . Cette action Cmd-Z apparaît dans le menu Edit de macOS (fourni par SwiftUI) 

sous l’intitulé « Undo Remove Image », tant qu’une image supprimée peut encore être 
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restaurée. Elle est enregistrée via le système standard, pas dans ; il n’y a donc pas 
d’entrée M-ID propre dans l’inventaire.

Raccourcis clavier en vue d’ensemble

Entrée de menu Raccourci

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Menu Edit (fourni par le système, en Expert Mode avec sélection active dans le Project 
Navigator) :

Action Raccourci

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete
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C H A P I T R E

Chapitre 2 — Inspecteur (Expert View)

Figure 7. –  Mode expert vide — Project Navigator à gauche (Images 0, Cameras, Log), 
viewport vide au centre, inspecteur à droite avec sections Presets / Training Configuration / 

Enhancements / Training Metrics

Inspecteur vide avant import : la sidebar gauche affiche le compteur Images 0 et 
l’indication « Drop images here / or tap + to import ». L’inspecteur à droite est pleine
ment fonctionnel mais les préréglages sont seulement informatifs (aucun entraînement 
actif). Le préréglage par défaut « Preview » (5K iters) est marqué. Camera Alignment 
sur Apple Photogrammetry, Densification Classic, SSIM Weight 0.20, Render Scale 50 
%. États vides dans Training Metrics (« Start training to see live metrics ») et Loss 
History (« Loss curve will appear during training »).
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Figure 8. –  Inspecteur avec 60 images flowers chargées — la sidebar Image affiche les 
premiers noms de fichiers frame_0001.jpg  etc., en-tête « 60 images ready »

Inspecteur après import : statut d’en-tête « 60 images ready ». La sidebar Image liste 
les 60 images importées ( frame_0001.jpg  à frame_0945.jpg , une image sur 16 du 
dataset 960-cam du bouquet comme sous-ensemble pour des itérations rapides). La 
logique auto-render-scale vérifie la résolution d’image (1536×2048 = 3,1 MP) et ajuste 
Render Scale en conséquence. Le bouton Play (vert, en bas à gauche) est désormais 
actif et démarre l’entraînement avec le préréglage actif.

Figure 9. –  Inspecteur en cours d’entraînement — viewport en direct affichant la recons
truction du bouquet flowers, barre de métriques en bas (Loss / LR / Gaussian-Count / 
itérations), carte Preset « Preview » avec badge « Modified » si paramètres ajustés

Inspecteur pendant l’entraînement : la barre de titre affiche la progression globale « 
RadianceKit — Training NN % ». Le viewport rend la reconstruction gaussienne en cours 
en temps réel (actualisé toutes les 50 itérations — intervalle de Live Preview réglable 
dans Settings → General → Training → Live Preview). Barre de métriques sous le 
viewport : loss courant, learning rate, nombre de gaussiennes et compteur d’itérations 
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(par ex. 1 600 / 5 000 avec le préréglage Preview). La carte de préréglage « Preview 
» de l’inspecteur arbore le badge « Modified » dès qu’un paramètre diverge du défaut 
intégré. La sidebar « Log » collecte les événements SfM et d’étape d’entraînement.

Figure 10. –  Inspecteur après fin d’entraînement — viewport montrant la reconstruction du 
bouquet flowers terminée (2 991 gaussiennes après 5K itérations en 13 s), barre de titre « 

Training Complete — 2 991 Gaussians »

Inspecteur après l’entraînement : la barre de titre affiche le nombre final de gaus
siennes (ici 2 991 — très compact, parce que la scène synthétique de bouquet Blender 
sur fond clair a une géométrie simple). Le viewport montre le nuage de points fini — 
navigation orbitale par glisser active (rotation autour du centre de scène). La section 
Training Metrics est maintenant remplie des valeurs finales, le Loss History Chart 
montre l’évolution sur les 5 000 itérations. La section Export en bas est maintenant 
active (tous les boutons de format activés).

L’inspecteur est la barre latérale droite en mode expert (⌘2). Il regroupe tous les 
paramètres pertinents pour l’entraînement en sept sections repliables. L’ordre par 
défaut de haut en bas au premier lancement est : Look, Préréglages, Configuration 
d’entraînement, Métriques, Diagramme de loss, Enhancements et Export. La section 
« Look » (ajustements d’image post-entraînement) est le renommage réel dans 
l’UI de l’ancienne section « Finishing » — son rawValue  d’enum interne reste « 
Finishing » pour des raisons de persistance, l’en-tête affiché s’appelle « Look ». 
Chaque section se replie en cliquant sur l’en-tête, l’ordre peut être réagencé par 
glisser-déposer (InspectorView.swift:81-97). Au premier lancement, les sept sec­
tions sont toutes repliées (inspectorCollapsedSections prend par défaut la valeur 
Set(InspectorSection.allCases)) ; l’app-state mémorise ensuite les préférences de 
pliage et d’ordre à travers les redémarrages d’app.

Une série de contrôles de l’inspecteur apparaît aussi sous forme quasi identique dans 
les Réglages (chapitre 3) — typiquement backend SfM, Sky Masking et défauts simi
laires. La séparation est voulue : les Réglages fournissent le modèle global de l’app pour 
les nouveaux projets, l’inspecteur écrase ces valeurs pour le projet actuellement ouvert. 
Qui connaît la logique d’un côté peut utiliser l’autre les yeux fermés.
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La colonne gauche en mode expert — le Project Navigator — ne fait pas partie de 
l’inspecteur mais en est le voisin direct. On y sélectionne par clic les images importées, 
on peut les prévisualiser en Quick Look avec la barre d’espace et les supprimer via le 
bouton moins ou la touche Suppr (avec Cmd-Z pour annuler). L’inspecteur suit la sélec
tion actuelle de la sidebar avec des informations de détail contextuelles, mais les sept 
sections principales restent toujours disponibles.

Section Look (L1–L5)

La section Look ( rawValue  interne toujours « Finishing ») est la section la plus haute 
de l’inspecteur et rassemble en un seul endroit les ajustements d’image post-entraîne­
ment. Tous les curseurs travaillent de façon non destructive : chaque slider réapplique 
le FinishingPass  sur un instantané pristine inchangé (couleur DC, opacité et échelle 
d’origine) — l’ajustement est donc idempotent, pas cumulatif. Le résultat apparaît 
en direct dans le viewport (WYSIWYG, exactement comme l’export ultérieur) et est 
incrusté dans chaque export. La section n’est disponible qu’après la fin d’un cycle 
d’entraînement (avant, on lit « Available after a training run completes. ») ; ses valeurs 
sont réinitialisées à chaque nouvel entraînement. Tant qu’un export est en cours, 
tous les curseurs sont verrouillés — un indice de verrou « Locked while exporting — 
the file uses the current settings. » apparaît et la GroupBox est désactivée.

L1 Curseur Saturation

O Ù

Inspecteur → Section Look → GroupBox → Satura
tion.

T E C H N I Q U E

Slider 0.5–1.2, affichage à deux décimales (par ex. 
« 1.00 »). Met à l’échelle le chroma SH-DC de 
chaque splat autour de la valeur de luminance : 1.0 
= inchangé, < 1.0 = désaturé (couleur tirée vers 
le niveau de gris), > 1.0 = plus intense. Mathémati
quement, la couleur DC est recalculée à partir de 
l’instantané pristine ( desaturateDC ), si bien que 
des déplacements répétés ne s’additionnent pas. 
Validé sur du matériel de drone DJI (viaduc de 
Pensford), qui a tendance à surcharger — le défaut 
drone est à 0.82. N’agit que sur la base de couleur 
(SH degré 0), les coefficients SH supérieurs restent 
intacts.

E N  B R E F

À quel point les couleurs du splat 
fini sont intenses. 1.00 laisse 
tout tel qu’entraîné, des valeurs 
en dessous tirent la couleur vers 
le gris — pratique pour du ma­
tériel drone ou vidéo, qui sort 
souvent sursaturé. Des valeurs 
au-dessus de 1.0 le rendent plus 
intense. Tu peux glisser dans un 
sens et dans l’autre à volonté 
sans que rien ne « s’emballe 
», car l’app recalcule toujours à 
partir de l’état d’origine inchan­
gé. Visible en direct dans le 
viewport et exactement pareil à 
l’export.
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L2 Curseur Splat length

O Ù

Inspecteur → Section Look → GroupBox → Splat 
length.

T E C H N I Q U E

Slider 0.3–1.0, affichage à deux décimales. Tire les 
trois axes d’échelle de chaque gaussienne dans 
l’espace log vers leur moyenne ( shortenScale , 
facteur alpha ) : 1.0 = inchangé, des valeurs plus 
petites arrondissent les splats « en aiguille » allon
gés, 0 donnerait des sphères pures. S’attaque aux 
splats en forme d’aiguille, sur-étirés, sans changer 
la taille globale, et réduit ainsi les artefacts typiques 
de « confetti ». Appliqué à partir de l’instantané 
pristine (échelle log d’origine), donc idempotent. 
Commute avec Splat size (L3), car les deux tra
vaillent dans l’espace log.

E N  B R E F

Arrondit les splats trop longs et 
esquilleux. 1.00 laisse la forme 
telle qu’entraînée, des valeurs 
plus basses tassent les « ai­
guilles » allongées en taches 
plus rondes — ce qui apaise 
les reconstructions granuleuses, 
gangrenées par les artefacts de 
confetti. La taille globale reste 
la même, il ne s’agit que de 
l’allongement. Se combine sans 
risque avec Splat size (L3).

L3 Curseur Splat size

O Ù

Inspecteur → Section Look → GroupBox → Splat 
size.

T E C H N I Q U E

Slider 0.5–2.0, affichage à deux décimales. Met à 
l’échelle chaque gaussienne uniformément sur les 
trois axes ( sizeScale ) : 1.0 = inchangé, < 1.0 = 
plus petit / plus dense / plus net, > 1.0 = plus 
grand / plus « pelucheux » (comble les trous entre 
les splats). Comme les échelles sont dans l’espace 
log, la multiplication est réalisée comme un offset 
additif log(factor)  — ce qui commute avec Splat 
length (L2), car un offset constant laisse l’écart-à-
la-moyenne intact. À partir de l’instantané pristine, 
donc idempotent. Nouveau dans cette version.

E N  B R E F

Met tous les splats à l’échelle, 
plus grands ou plus petits, uni­
formément. 1.00 est l’état en­
traîné, des valeurs en dessous 
resserrent et affûtent le nuage 
de points, des valeurs au-dessus 
recouvrent les trous entre les 
splats (rendu plus doux, plus « 
pelucheux »). Pratique pour re­
fermer visuellement une recons­
truction trouée ou, à l’inverse, 
révéler plus de détail. S’accorde 
sans souci avec Splat length 
(L2) — les deux curseurs ne 
s’influencent pas mutuellement.
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L4 Fade far region (avec sous-curseurs)

O Ù

Inspecteur → Section Look → GroupBox → Toggle 
« Fade far region » plus les sous-curseurs « Fade 
start ×radius » et « Fade floor ».

T E C H N I Q U E

Toggle qui active une décroissance radiale de 
l’opacité avec la distance au barycentre des camé
ras — les « far-confetti » faiblement observés à 
l’arrière-plan sont estompés. Uniquement pour les 
prises de vue en orbite : le toggle est désactivé 
si finishingContext.fadeEligible est false (vols 
linéaires, caméras trop peu nombreuses ou dégéné
rées) ; dans ce cas, au lieu des sous-curseurs, 
apparaît l’indice « Far-fade applies only to orbit 
captures (not this scene). » L’éligibilité est déter
minée via la couverture azimutale des positions 
de caméra (une orbite encercle le barycentre et 
remplit de nombreux secteurs de boussole, un vol 
linéaire seulement ~2). Deux sous-curseurs pilotent 
la géométrie : Fade start ×radius (1.0–3.0) fixe le 
rayon intérieur comme multiple du rayon d’orbite, à 
l’intérieur duquel l’opacité pleine s’applique ; Fade 
floor (0.0–1.0) est le facteur d’opacité bien au-
delà du rayon de fondu. Important : le fondu saute 
la zone du sky-dome (les gaussiennes gelées 
des indices [0, frozenCount)), pour que la coupole 
d’arrière-plan intentionnelle ne soit pas atténuée 
avec le reste.

E N  B R E F

Estompe les restes flous au bord 
extérieur de la scène — préci­
sément les amas de « far-confet­
ti » qui flottent loin derrière 
dans les prises de vue tout-au­
tour. Ne fonctionne que pour de 
vraies prises en orbite / encer­
clement ; pour des vols de drone 
en ligne droite ou trop peu de 
caméras, l’interrupteur est gri­
sé et un indice explique pour­
quoi. S’il est actif, deux réglages 
fins s’ajoutent : « Fade start 
×radius » détermine à partir 
de quelle distance (comme mul­
tiple du rayon d’encerclement) 
l’estompage commence, « Fade 
floor » à quel point les splats 
lointains restent encore visibles 
à la fin (0 = totalement dispa­
rus, 1 = inchangés). Un sky-dome 
reconstruit volontairement (I44) 
n’est jamais touché — le ciel est 
préservé.
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L5 Bouton Reset finishing

O Ù

Inspecteur → Section Look → GroupBox → « Reset 
finishing » (en bas, petit bouton).

T E C H N I Q U E

Réinitialise tous les réglages Look aux valeurs par 
défaut (FinishingPass.Settings() = Saturation 1.0, 
Fade off, Splat length 1.0, Splat size 1.0) et dé
clenche aussitôt un nouveau finishing, de sorte 
que le viewport revient à l’état entraîné inchangé. 
controlSize(.small). Comme toute la pile Look cal
cule de façon idempotente à partir de l’instantané 
pristine, « retour au défaut » est exactement la 
sortie d’entraînement d’origine — aucune perte de 
qualité à force d’aller-retour. Verrouillé comme tous 
les curseurs de la section pendant un export en 
cours.

E N  B R E F

Remet d’un clic tous les cur­
seurs Look au standard (Satu­
ration 1.00, Fade off, les deux 
curseurs Splat à 1.00) — le view­
port montre ensuite à nouveau 
exactement le résultat fraîche­
ment entraîné. Pratique si tu t’es 
perdu à jouer avec les réglages 
et veux repartir proprement de 
zéro. Comme l’app calcule tou­
jours à partir de l’état d’origine, 
il n’y a aucune perte de qualité. 
Pendant un export en cours, le 
bouton (comme les curseurs) est 
verrouillé.

Section Préréglages (I1–I11)

La section Préréglages est la voie la plus rapide pour appliquer une configuration 
éprouvée. Les préréglages intégrés (Capture Class, Classic, MCMC, Hybrid) fournissent 
des points de départ reproductibles issus de 560+ expériences documentées ; vos 
propres préréglages peuvent être enregistrés, exportés, importés et partagés. La liste 
est groupée par catégories (Capture Class, Classic, MCMC, Hybrid, Custom) et plus 
d’une catégorie peut être dépliée à la fois. Via le menu contextuel (clic droit sur une 
ligne), Export, Duplicate et — pour les préréglages personnels — Delete sont acces
sibles.
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I1 Bouton Save…

O Ù

Inspecteur → Section Préréglages → bouton Save… 
(barre d’action en bas).

T E C H N I Q U E

Ouvre un popover avec champ de texte et bou
tons Save/Cancel. L’état actuel de TrainingConfig 
est persisté comme nouveau préréglage personna
lisé (encodé en JSON, enregistré globalement à 
l’app). L’opération de save copie les 81 paramètres 
d’entraînement plus la stratégie de densification ac
tuelle. Le préréglage atterrit automatiquement dans 
la catégorie Custom, indépendamment du préré
glage intégré dont il est dérivé. Les noms vides 
et les entrées uniquement whitespace sont rejetés. 
Les noms déjà existants ne sont pas refusés — 
chaque préréglage a son ID interne propre, les dou
blons de noms sont techniquement autorisés mais 
pratiquement déroutants.

E N  B R E F

Enregistre votre configuration 
actuelle comme préréglage réuti­
lisable. Appuyez sur le bouton, 
entrez un nom dans le popover et 
cliquez Save — les 81 paramètres 
y compris la stratégie de densifi­
cation atterrissent sous le nom 
choisi dans la catégorie Custom. 
Utile quand vous vous êtes don­
né du mal et ne voulez pas re­
commencer au prochain projet. 
Particulièrement pratique pour 
des setups récurrents comme « 
Drone 4K » ou « Intérieur rapide 
». Les doublons sont technique­
ment autorisés mais déroutants 
— préférez un nom parlant.

I2 Champ Preset Name

O Ù

Popover Save → champ de texte « Preset Name ».

T E C H N I Q U E

Champ de texte simple à bordure arrondie, forme 
large. La valeur est reprise comme nom de pré
réglage lors du clic sur Save. Aucune limite de 
longueur dans l’UI, mais le nom enregistré doit être 
encodable en JSON et affichable dans les listes 
UI — emoji et caractères accentués fonctionnent. 
Le contenu est automatiquement remis à zéro à 
l’ouverture du popover. Le bouton Save reste désac
tivé tant que le champ est vide après trim. Il n’y 
a pas d’auto-suggest ni de pré-remplissage avec le 
nom du préréglage actuellement actif.

E N  B R E F

Vous tapez ici le nom de votre 
préréglage. Choisissez quelque 
chose de parlant comme « Drone 
4K 30fps » ou « Intérieur rapide 
» — cela vous aide ensuite à le 
retrouver dans la catégorie Cus­
tom. Emoji et accents autorisés, 
pas de limite stricte de longueur. 
Tant que le champ est vide ou 
ne contient que des espaces, le 
bouton Save reste grisé. À la ré­
ouverture du popover, le champ 
est de nouveau vide — il n’y a 
pas de pré-remplissage avec le 
nom du préréglage actif.
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I3 Bouton Cancel (dialogue Save)

O Ù

Popover Save → bouton Cancel (à gauche).

T E C H N I Q U E

Ferme le popover sans enregistrer. Rejette le conte
nu du champ de texte — il sera de nouveau remis 
à zéro à la prochaine ouverture par la logique du 
bouton Save… (I1). Style de bouton standard, pas 
de dialogue de confirmation, pas de raccourcis. La 
TrainingConfig actuelle reste inchangée puisque le 
chemin Save n’a même pas été exécuté.

E N  B R E F

Ferme le popover Save sans rien 
enregistrer. Si vous avez chan­
gé d’avis, vous êtes trompé de 
frappe ou avez ouvert le dialogue 
par erreur — cliquez simple­
ment Cancel. Votre configuration 
d’entraînement actuelle reste in­
changée parce que rien n’a en­
core été écrit. À la prochaine 
ouverture du popover, le champ 
nom redémarre vide. Aucune 
confirmation, aucun raccourci — 
juste un clic et c’est parti.

I4 Bouton Save (dialogue Save)

O Ù

Popover Save → bouton Save (à droite, style pro
éminent).

T E C H N I Q U E

Déclenche la persistance proprement dite. Revérifie 
qu’un nom non vide est présent (check défensif) 
puis écrit la TrainingConfig actuelle en JSON dans 
le stockage de l’app. Ferme ensuite le popover. Mis 
en valeur en bleu, désactivé tant que le champ est 
vide. Si l’enregistrement échoue (par ex. parce que 
le stockage de l’app est plein — très peu probable), 
il n’y a actuellement pas de dialogue d’erreur vi
sible ; le préréglage n’apparaîtrait simplement pas 
au prochain démarrage.

E N  B R E F

En cliquant Save, vous repre­
nez le nom et écrivez votre se­
tup actuel comme nouveau pré­
réglage. Le popover se ferme, 
le préréglage apparaît immédia­
tement dans la catégorie Cus­
tom de la liste et peut désor­
mais être activé d’un clic. Le 
bouton est mis en valeur en 
bleu ( borderedProminent ) et 
reste grisé tant que le champ 
nom est vide. Si l’enregistrement 
échoue (par ex. UserDefaults 
plein), il n’y a pas de dialogue 
d’erreur visible — le préréglage 
manquerait simplement au pro­
chain démarrage.

39 / 177



R A D I A N C E K I T Chapitre 2 — Inspecteur (Expert View)

I5 Bouton Export…

O Ù

Inspecteur → Section Préréglages → barre d’action 
→ bouton Export….

T E C H N I Q U E

Exporte le préréglage actuellement sélectionné 
comme fichier .radiancepreset  (JSON en in
terne). Désactivé si aucun préréglage n’est sélec
tionné. Au clic, l’app ouvre un dialogue Save avec 
le nom de fichier prédéfini (nom du préréglage 
+ extension .radiancepreset ). Le format enregis
tré contient la TrainingConfig complète plus les 
métadonnées (nom, catégorie, ID, flag built-in). Le 
double-clic dans le Finder ouvre l’app — mais pas 
automatiquement l’import ; l’utilisateur doit utiliser 
le bouton Import (I6).

E N  B R E F

Sélectionnez un préréglage dans 
la liste et cliquez Export — vous 
pouvez alors l’enregistrer comme 
fichier .radiancepreset  et 
par ex. l’envoyer à un collègue ou 
le transférer sur un second Mac. 
Le destinataire le recharge avec 
le bouton Import… (I6). Fonc­
tionne aussi bien pour les built-
ins que pour vos préréglages 
Custom. Le bouton est grisé tant 
que rien n’est cliqué dans la liste. 
Astuce : via le menu contextuel 
(I8), c’est encore plus rapide — 
vous n’avez pas à sélectionner le 
préréglage avant.

I6 Bouton Import…

O Ù

Inspecteur → Section Préréglages → barre d’action 
→ bouton Import….

T E C H N I Q U E

Ouvre un dialogue de fichier qui n’autorise que 
des fichiers .radiancepreset  (sélection multiple 
désactivée). À la sélection, le fichier JSON est char
gé, validé et inséré dans la catégorie Custom — 
avec un nouvel ID interne pour éviter les collisions 
avec les built-ins. L’import définit automatiquement 
la catégorie sur Custom, même si le préréglage 
exporté était à l’origine un built-in. Les fichiers 
corrompus ou incompatibles avec une version de 
schéma plus ancienne sont silencieusement rejetés, 
sans dialogue d’erreur (le journal console donne ce
pendant des indications).

E N  B R E F

Charger un fichier 
.radiancepreset  depuis le 

disque. Utile si quelqu’un vous 
envoie un setup éprouvé ou 
si vous voulez vous-même gar­
der vos préréglages préférés 
synchrones sur plusieurs Macs. 
Les préréglages importés atter­
rissent toujours dans la catégo­
rie Custom — même s’ils ont été 
exportés à l’origine depuis les 
built-ins. Les fichiers corrompus 
ou obsolètes sont silencieuse­
ment ignorés ; la raison apparaît 
dans le journal console. La sélec­
tion multiple est désactivée dans 
le dialogue, donc un fichier par 
clic.
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I7 Ligne de préréglage (activation par clic)

O Ù

Inspecteur → Section Préréglages → chaque ligne 
de préréglage dans chaque catégorie.

T E C H N I Q U E

Un clic sur une ligne de préréglage remplace tous 
les champs de la TrainingConfig par les valeurs du 
préréglage, mémorise l’ID du préréglage actif et re
met le statut Modified à zéro. La coche d’activation 
devant la ligne n’apparaît que si le préréglage est 
sélectionné ET non modifié. Dès qu’une valeur de 
la TrainingConfig est changée (curseur, stepper, 
toggle dans d’autres sections de l’inspecteur), un 
badge orange « Modified » apparaît derrière le 
nom. Les préréglages intégrés ne peuvent pas être 
écrasés — en cas de modification, vous devez créer 
une copie personnelle via le bouton Save (I1).

E N  B R E F

Un clic sur une ligne active 
le préréglage et reprend toutes 
les valeurs qui y sont enre­
gistrées dans les paramètres 
d’entraînement actuels. La coche 
devant le nom indique quel pré­
réglage est actuellement actif. 
Dès que vous bougez ensuite 
un curseur, un stepper ou un 
toggle dans les autres sections, 
un badge orange « Modified » 
apparaît derrière le nom — parce 
que votre setup diverge main­
tenant du préréglage. Les préré­
glages intégrés ne peuvent pas 
être écrasés ; si vous voulez gar­
der des modifications, créez une 
copie personnelle via le bouton 
Save… (I1) ou dupliquez le préré­
glage (I9).

I8 Menu contextuel « Export… »

O Ù

Clic droit sur chaque ligne de préréglage → pre
mière entrée « Export… ».

T E C H N I Q U E

Fonctionnalité identique à I5 (bouton Export…) mais 
plus directement accessible — sans que le préré
glage doive être sélectionné avant. Exporte directe
ment le préréglage cliqué dans la ligne. Fonctionne 
de la même façon pour toutes les catégories de 
préréglages (built-in ou Custom), sans restriction. 
L’export contient le flag built-in et la catégorie 
d’origine, mais à la réimportation la catégorie est 
remappée sur Custom comme décrit sous I6.

E N  B R E F

Chemin rapide pour l’export — 
clic droit sur le préréglage sou­
haité et sélectionnez « Export… 
». Évite de devoir d’abord cliquer 
puis appuyer sur le bouton Ex­
port…. Fonctionne de la même 
façon pour toutes les catégories, 
y compris les built-ins. Le fichier 
.radiancepreset  généré est 

identique à celui de I5 ; à la 
réimportation, il atterrit automa­
tiquement dans la catégorie Cus­
tom.
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I9 Menu contextuel « Duplicate »

O Ù

Clic droit sur chaque ligne de préréglage → 
deuxième entrée « Duplicate ».

T E C H N I Q U E

Clone le préréglage dans la catégorie Custom. 
Crée un nouvel ID interne, ajoute « Copy » au 
nom et enregistre la copie. Fonctionne aussi pour 
les préréglages intégrés — le clone est alors édi
table. L’original reste intact. La TrainingConfig est 
copiée valeur par valeur (roundtrip JSON), de sorte 
qu’aucune liaison de référence n’existe entre origi
nal et copie.

E N  B R E F

Crée une copie éditable d’un pré­
réglage dans la catégorie Cus­
tom. Pratique si vous voulez 
par ex. partir du préréglage 
built-in « Quality » et simple­
ment bouger un peu le curseur 
SSIM. Workflow : dupliquer, re­
nommer (menu contextuel ou 
nouveau Save…), ajuster, termi­
né. L’original reste intact — vous 
pouvez y revenir à tout mo­
ment. Fonctionne aussi pour les 
built-ins, ce qui est la seule fa­
çon d’en reprendre les valeurs 
comme base tout en les rendant 
éditables.

I10 Menu contextuel « Delete »

O Ù

Clic droit sur les lignes de préréglages personnels 
→ dernière entrée « Delete » (rouge, destructive).

T E C H N I Q U E

Visible uniquement pour les préréglages Custom. 
Les built-ins ne peuvent pas être supprimés. 
L’entrée est marquée destructive, apparaît en rouge 
dans le menu contextuel et est séparée par un divi
der pour qu’on ne la clique pas par mégarde. Il n’y a 
pas de dialogue de confirmation — un clic supprime 
le préréglage immédiatement. Le préréglage suppri
mé n’est pas récupérable (Cmd-Z ne fonctionne pas 
ici — l’Undo n’existe dans le build actuel que pour 
la liste d’images, pas pour les opérations sur les 
préréglages). Si le préréglage supprimé était actif, 
la TrainingConfig actuelle reste inchangée, seule la 
sélection active est mise à null.

E N  B R E F

Supprimer vos préréglages per­
sonnels. Pour les built-ins (Quick, 
Preview, Balanced, Quality, Ultra 
Detail, Drone / Aerial, 360° Wal­
karound, Photo / Object etc.), 
« Delete » n’est même pas vi­
sible — vous ne pouvez pas les 
tuer par mégarde. Attention : pas 
de confirmation et pas d’Undo, 
un clic et le préréglage est 
parti. Si vous n’êtes pas sûr, 
faites d’abord une sauvegarde 
sur disque via Export… (I5/I8) 
— vous pourrez toujours la ré­
importer. Si le préréglage était 
actif, votre TrainingConfig reste 
inchangée, seule la coche dispa­
raît.
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I11 En-tête de catégorie (déplier/replier)

O Ù

Inspecteur → Section Préréglages → chaque en-
tête de catégorie (Capture Class, Classic, MCMC, 
Hybrid, Custom).

T E C H N I Q U E

Statut plié par catégorie avec un défaut différent : le 
groupe curaté Capture Class démarre déplié, Clas
sic, MCMC, Hybrid et Custom démarrent repliés. Le 
statut n’est pas persisté — au redémarrage de l’app, 
toutes les catégories sont de nouveau dans leur état 
par défaut. La flèche chevron pivote en animation. 
Le chiffre à droite dans l’en-tête indique le nombre 
de préréglages dans cette catégorie. La zone de clic 
couvre tout l’en-tête.

E N  B R E F

Déplier et replier les catégories 
pour garder la liste de préré­
glages lisible. Au démarrage de 
l’app, le groupe Capture Class 
est ouvert, Classic, MCMC, Hy­
brid et Custom sont fermés. Clic 
sur l’en-tête (toute la zone est 
cliquable) et la liste glisse avec 
une courte animation du che­
vron. Le petit nombre à droite in­
dique combien de préréglages se 
trouvent dans la catégorie. Après 
redémarrage de l’app, l’état par 
défaut revient — l’app ne mémo­
rise volontairement pas ce sta­
tut.

Section Configuration d’entraînement (I12–I22)

Figure 11. –  Crop section Configuration d’entraînement uniquement — Camera Alignment, 
Densification, Max Iterations / Densify Until, SSIM Weight, Render Scale

Ici atterrissent les leviers centraux : quel backend SfM doit calculer, comment travaille 
la densification, combien d’itérations, quel poids SSIM. En stratégie MCMC appa
raissent deux toggles supplémentaires (« MCMC Quality » et « Auto-scale by scene »), 
masqués en mode Classic. Avec le backend Native SfM s’ajoute le champ FOV Override, 
nécessaire seulement pour des images vidéo sans focale EXIF.
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I12 Sélecteur Camera Alignment

O Ù

Inspecteur → Configuration d’entraînement → Ca
mera Alignment (sélecteur segmenté en haut).

T E C H N I Q U E

Sélecteur segmenté avec deux options : Apple Pho
togrammetry et Native (Beta). La sélection déter
mine le backend SfM utilisé à la prochaine recons
truction caméra. Elle influence en même temps les 
autres éléments de l’inspecteur visibles : Native 
affiche en plus le FOV Override (I13), nécessaire 
seulement pour les images vidéo sans EXIF.

E N  B R E F

Vous choisissez ici comment les 
positions caméra sont recons­
truites. Apple Photogrammetry 
est le standard rapide. Native 
(Beta) est le développement mai­
son conforme App Store, bon 
pour les orbites. Sur de très 
grands sets outdoor, vous pou­
vez aussi calculer les caméras 
dans Metashape ou COLMAP et 
charger le résultat via Workspace 
Import. Détails au chapitre 9.

I13 Champ FOV Override (Native SfM)

O Ù

Inspecteur → Configuration d’entraînement → FOV 
Override (visible uniquement si Camera Alignment = 
Native).

T E C H N I Q U E

Champ texte numérique (plage 0-170°), défaut 0 = 
détermination automatique depuis l’EXIF ou heuris
tique. La saisie manuelle est nécessaire quand les 
images d’entrée ont été extraites d’une vidéo qui 
ne contient pas de métadonnées de focale. Valeurs 
typiques : iPhone Wide ≈ 73°, DJI Mavic Wide-Crop 
≈ 70°, drone avec capteur plein format ≈ 84°. La va
leur est clampée sur [0, 170]. Affecte uniquement le 
pipeline SfM natif (Q4/Q5) ; Apple Photogrammetry 
ignore complètement cette valeur.

E N  B R E F

Si vos images n’ont pas d’EXIF 
(typique pour des images ex­
traites de vidéo), vous entrez ici 
la vision horizontale de la camé­
ra en degrés. Valeurs repères : 
iPhone Wide ≈ 73°, DJI Mavic 
Wide-Crop ≈ 70°, drone avec cap­
teur plein format ≈ 84°. Un 0 
laisse l’app deviner. Le champ 
n’est visible et n’agit que si vous 
avez choisi Native comme Came­
ra Alignment (I12).
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I15 Sélecteur Densification

O Ù

Inspecteur → Configuration d’entraînement → Den
sification (sélecteur segmenté, toujours visible).

T E C H N I Q U E

Bascule entre les deux stratégies de densifica
tion : Classic (procédé 3DGS original avec clone/
split/prune et seuil de gradient) et MCMC (Stochas
tic Gradient Langevin Dynamics avec relocation, 
NeurIPS 2024). Au passage de Classic à MCMC, 
l’app fixe automatiquement les champs spécifiques 
MCMC sur des valeurs par défaut éprouvées. La 
sélection détermine en plus quels éléments de 
l’inspecteur sont visibles — en MCMC, I16/I17 appa
raissent. Effet détaillé des champs au chapitre 6, 
T11–T16 (Classic) et T61–T73 (MCMC).

E N  B R E F

Le choix de stratégie central 
pour la croissance du nombre de 
gaussiennes. Classic est bien tu­
né par 459 expériences, produit 
des résultats rapides et de haute 
qualité. MCMC est l’approche 
plus récente (NeurIPS 2024), plus 
reproductible mais calcule envi­
ron 6× plus longtemps à quali­
té comparable. Détails au cha­
pitre 6 (T11–T16 Classic, T61–T73 
MCMC).

I16 Toggle MCMC Quality

O Ù

Inspecteur → Configuration d’entraînement → 
MCMC Quality (uniquement si Densification = 
MCMC).

T E C H N I Q U E

Bascule la gradient accumulation sur 2 étapes (ac
tif) ou 1 étape (inactif). Accumule les gradients 
de deux vues caméra consécutives avant le step 
d’optimiseur. Empiriquement réduit l’erreur L1 finale 
d’environ 6 % au prix d’un temps doublé. Affecte 
uniquement l’entraînement.

E N  B R E F

Mode Quality pour MCMC avec 
gradient accumulation. Rend 
empiriquement le résultat final 
environ 6 % meilleur au prix 
d’un temps doublé. En vaut la 
peine pour des rendus showcase 
finaux, plutôt pas dans le work­
flow quotidien. Visible unique­
ment quand Densification est sur 
MCMC (I15).
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I17 Toggle Auto-scale by scene

O Ù

Inspecteur → Configuration d’entraînement → Auto-
scale by scene (uniquement en MCMC).

T E C H N I Q U E

Si actif, met à l’échelle la limite supérieure effective 
Max-Gaussians avec le nombre de points d’init SfM 
× MCMC-cap-multiplier (défaut 3.0). Si désactivé, 
seule la base s’applique strictement. Introduit pour 
v1.4.5 parce que de grandes prises outdoor avec 
plus de 1000 images et une densité de points SfM 
élevée correspondante affamaient la densification 
avec le défaut rigide de cap 150K.

E N  B R E F

Laisse le nombre maximal de 
gaussiennes grandir avec la taille 
de scène. Sur les petites scènes 
vous ne verrez à peine la dif­
férence, sur les grandes scènes 
outdoor c’est souvent décisif. 
Déjà activé dans les préréglages 
built-in MCMC ; dans vos préré­
glages personnels, désactivé par 
défaut.

I18 Stepper Max Iterations

O Ù

Inspecteur → Configuration d’entraînement → 
GroupBox → Max Iterations.

T E C H N I Q U E

Stepper avec plage 1 000–100 000, pas de 1 000. 
Détermine le nombre total d’itérations d’optimiseur. 
Sweet spots empiriques : 20K (Classic Balanced, L1 
≈ 0.028), 40K (Classic Quality, L1 ≈ 0.023), 200K 
(MCMC Full, L1 ≈ 0.0246). À la modification, si la 
fonction Link (I19) est active, Densify Until est tiré 
proportionnellement.

E N  B R E F

Combien d’étapes 
d’entraînement sont parcourues. 
Règle empirique : 20 000 pour 
une bonne qualité, 40 000 pour 
l’optimum en Classic, 200 000 
pour MCMC. Doubler les itéra­
tions double grossièrement le 
temps. Avec le bouton Link actif 
(I19), Densify Until est tiré pro­
portionnellement.

I19 Bouton Link/Unlink (Densify ↔ Iterations)

O Ù

Inspecteur → Configuration d’entraînement → 
GroupBox → petit bouton Link entre Max Iterations 
et Densify Until.

T E C H N I Q U E

Bouton bascule qui fige le rapport Densify Until / 
Max Iterations. Défaut linked. Un rapport typique est 
0.5.

E N  B R E F

Petite icône type accolade entre 
Max Iterations et Densify Until. Si 
active, les deux valeurs bougent 
ensemble. Défaut lié — pour 99 
% des cas, laissez-le verrouillé.
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I20 Stepper Densify Until

O Ù

Inspecteur → Configuration d’entraînement → 
GroupBox → Densify Until.

T E C H N I Q U E

Stepper avec plage 500–50 000, pas de 500. Dé
termine l’index d’itération à partir duquel aucune 
nouvelle gaussienne n’est plus ajoutée par clone/
split (Classic) ou relocation (MCMC). Valeurs ty
piques : 15K (pour Max-Iter 30K), 20K (pour 40K), 
100K (pour 200K MCMC).

E N  B R E F

Jusqu’à quelle itération de nou­
velles gaussiennes peuvent être 
ajoutées. Plus haut = plus de dé­
tail, mais aussi fichier plus grand 
et +30 à 60 % de temps GPU par 
step. Tient normalement à Max 
Iterations via Link (I19).

I21 Slider SSIM Weight

O Ù

Inspecteur → Configuration d’entraînement → 
GroupBox → SSIM Weight.

T E C H N I Q U E

Slider 0.0–1.0 par pas de 0.05. Mélange L1-Loss 
(0.0) et SSIM-Loss (1.0). Défaut 0.2 est la valeur du 
papier 3DGS original (Kerbl 2023). Le calcul SSIM 
tourne dans le shader avec une fenêtre gaussienne 
11×11. À 0.0 (L1 seulement), l’entraînement est envi
ron 8-12 % plus rapide.

E N  B R E F

À quel point la similarité struc­
turelle est pondérée face à la 
simple comparaison de lumino­
sité. 0.2 est le standard et 
suffit pour presque toutes les 
scènes. Plus élevé (0.5+) sur des 
structures fines comme cheveux, 
fourrure ou végétation. Sans rai­
son particulière de modifier, lais­
sez 0.2.

I22 Slider Render Scale

O Ù

Inspecteur → Configuration d’entraînement → 
GroupBox → Render Scale.

T E C H N I Q U E

Slider 0.25–1.0 par pas de 0.25. Met à l’échelle la 
résolution de rendu d’entraînement par rapport à la 
taille de l’image source. 50 % réduit le temps GPU 
d’environ 75 %. Sous le slider apparaît un affichage 
live de résolution en MP. La recommandation vise 
environ 3 MP — la plage la plus efficacement trai
table par les GPU Apple Silicon.

E N  B R E F

La résolution à laquelle 
l’entraînement rend — un des 
plus grands leviers de perfor­
mance. Plein (100 %) donne 
la meilleure qualité, moitié (50 
%) économise environ 75 % de 
temps GPU. L’app vise environ 
3 MP, parce que c’est ce qui 
tourne le plus efficacement sur 
Apple Silicon. Si votre valeur en 
diverge, suivez l’avertissement « 
recommended » en orange.
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Section Enhancements (I26–I29, I42–I44)

Figure 12. –  Crop section Enhancements uniquement — trois rangées : Post-Training 
Compactification (toggle on), Viewport Scaling (picker segmenté Off/MetalFX/Lanczos), Per

ceptual Loss (slider sur « Off »). Chaque rangée avec sous-titre explique la fonction

La section Enhancements regroupe trois fonctionnalités qui améliorent la qualité 
d’image sans modifier la boucle d’entraînement centrale elle-même. Les deux premières 
(I26-I27) sont des étapes post-entraînement ou viewport : Compactification fait le 
ménage à la fin de l’entraînement, le Viewport Scaling est un pur renderer viewport 
qui n’influence pas l’entraînement en cours. La Perceptual Loss (I29) est, malgré son 
appartenance à la section, un composant d’entraînement — elle est activée pendant 
l’entraînement comme terme de loss supplémentaire, d’où la séparation d’avec les 
curseurs viewport par un divider. Depuis la v1.6, la section comporte aussi un groupe 
Outdoor (I42–I44 : Sky Masking, Mid-Training Floater Cleanup, Reconstruct Sky Dome) 
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— des options d’entraînement contre les floaters de ciel qui se trouvaient autrefois dans 
la fenêtre des Réglages et qui résident désormais ici, par projet.

I26 Toggle Post-Training Compactification

O Ù

Inspecteur → Enhancements → Post-Training Com
pactification.

T E C H N I Q U E

Active le post-processing V443 : à la fin des ité
rations d’entraînement, les gaussiennes d’opacité 
inférieure à 0.01 sont supprimées. Réduit la taille 
de fichier d’environ 55-58 % sans perte visible. 
Tourne comme passe GPU compact en fractions de 
seconde à quelques secondes.

E N  B R E F

Fait le ménage après 
l’entraînement parmi les gaus­
siennes que vous ne pouvez pas 
voir (opacité sous 1 %). Rend les 
fichiers d’export environ moitié 
plus petits sans perte visible. De­
vrait pratiquement toujours être 
actif.
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I27 Picker Viewport Scaling

O Ù

Inspecteur → Enhancements → Viewport Scaling 
(picker segmenté à trois options : Off, MetalFX, 
Lanczos).

T E C H N I Q U E

Un unique picker segmenté qui choisit l’upscaler 
viewport — les trois options sont mutuellement 
exclusives. Si la résolution d’entraînement (via I22 
Render Scale) est plus basse que la taille du view
port, le mode choisi met à l’échelle l’image rendue 
vers la taille d’affichage. Off = simple étirement 
bilinéaire. MetalFX = upscaler spatial à base de 
ML d’Apple, l’option la plus nette (le modèle ML 
est optimisé pour des arêtes nettes), overhead 
d’environ 1-2 ms par frame sur GPU M3. Lanczos 
= Metal Performance Shaders d’Apple avec resam
pling sinc à 8 taps, classique sans ML, overhead 
minimal (< 0.5 ms), qualité inférieure à MetalFX, 
mais sans le « lissage » typique du ML sur les 
structures de lignes fines. La pipeline du renderer 
est reconfigurée en direct au changement — visible 
immédiatement, sans redémarrage. Contexte : au
paravant c’étaient deux toggles séparés (MetalFX + 
Lanczos) qui pouvaient être actifs en même temps 
— un état contradictoire dans lequel MetalFX pas
sait silencieusement par-dessus Lanczos. Le picker 
supprime cet état ; un éventuel état « les-deux-
on » hérité d’anciennes sessions se guérit de lui-
même au prochain changement vers MetalFX. Agit 
uniquement sur le viewport live, pas sur les exports 
rendus (orbit video, captures) — ceux-ci sont ren
dus en pleine résolution source.

E N  B R E F

Affine l’image live dans le view­
port vers le haut — particulière­
ment utile si tu travailles avec 
une résolution d’entraînement 
réduite (Render Scale 50 %, voir 
I22). Trois niveaux dont un seul 
est actif à la fois : « Off » 
étire simplement les pixels, « 
MetalFX » utilise le machine lear­
ning d’Apple pour les arêtes les 
plus nettes (pratiquement tou­
jours le meilleur choix), « Lanc­
zos » est le filtre classique sans 
ML — prends-le comme fallback 
si MetalFX te lisse des lignes ou 
montre des artefacts dans une 
scène. Agit en direct, sans redé­
marrage. Agit seulement dans le 
viewport live, pas sur les orbit 
videos exportés ou les captures 
— ceux-ci sont rendus en pleine 
résolution source. Contrairement 
à avant, tu ne peux plus choisir 
deux modes en même temps par 
mégarde.
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I29 Slider Perceptual Loss

O Ù

Inspecteur → Enhancements → Perceptual Loss.

T E C H N I Q U E

Slider 0.0–0.2 par pas de 0.01, affichage à 0.0 
comme « Off ». Active un terme de loss supplémen
taire qui compare un blur gaussien multi-échelle 
du rendu avec l’image ground-truth (3 échelles). 
Implémentation V460. Une valeur de 0.05-0.1 amé
liore le score L1 de quelques pourcents mais 
coûte environ 5 % de temps. Au-dessus de 0.15, 
l’entraînement devient instable.

E N  B R E F

Une part de loss supplémentaire 
qui vérifie la similarité structu­
relle sur trois niveaux de flou. 
Aide sur les scènes à struc­
tures fines (cheveux, tissu, végé­
tation). Les petites valeurs sont 
plus sûres — 0.05 à 0.1 est le 
sweet spot. À 0 (Off), la fonction 
est désactivée et ne coûte rien.
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I42 Sky Masking

O Ù

Inspecteur → Enhancements (groupe Outdoor) 
→ toggle « Sky Masking ». Lié à : 
AppState.trainingConfig.skyMaskingEnabled (par 
projet, @DefaultFalse ). Défaut : false .

T E C H N I Q U E

Active la segmentation pixel ciel pré-entraînement 
basée sur Apple Vision. Avant le démarrage de 
l’entraînement, la région ciel est extraite pour 
chaque caméra d’entrée via l’Apple Vision Fore
ground Mask (Sky = Background) et associée à 
chaque caméra comme masque pixel par pixel. Pen
dant l’entraînement, la contribution au loss par pixel 
est multipliée par le complément du masque ciel 
— les pixels de ciel contribuent 0 au gradient, de 
sorte que les gaussiennes qui se projettent dans 
le ciel ne reçoivent aucun signal d’optimisation et 
ne deviennent donc pas plus « denses » ou plus 
« lumineuses ». Réduit significativement les floa
ters (taches sombres dans le ciel) sur des scènes 
outdoor/drone. Coûte ~3 % de régression L1 sur 
un entraînement classique 40K (voir memory/​dev_​
outdoor-floater-reduction.md). Utile uniquement 
pour des scènes outdoor avec ciel clairement iden
tifiable ; pour des scènes intérieures ou avec fond 
blanc, la segmentation ciel identifie de mauvaises 
zones et bloque des signaux de loss valides. La 
valeur est désormais stockée par projet (elle n’est 
plus globale à l’app) et suit le préréglage / fichier de 
scène.

E N  B R E F

Sur les prises de vue exté­
rieures avec du ciel dans l’image, 
il apparaît souvent des taches 
noires ou colorées dans le ciel 
— les « floaters ». Cette op­
tion reconnaît automatiquement 
où se trouve le ciel et indique 
à l’entraînement : « laisse le 
ciel tranquille ». Fonctionne très 
bien sur les vols de drone et 
les scènes de paysage. Sur les 
intérieurs ou les fonds sombres, 
cela peut détériorer l’image — à 
activer donc seulement quand il 
y a vraiment du ciel visible. Dé­
tails : memory/​dev_​outdoor-
floater-reduction.md.
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I43 Mid-Training Floater Cleanup

O Ù

Inspecteur → Enhancements (groupe Outdoor) → 
toggle « Mid- Training Floater Cleanup ». Lié à : 
AppState.trainingConfig.floaterCleanupEnabled 
(par projet, @DefaultFalse ). Défaut : false .

T E C H N I Q U E

Active sur l’entraînement classique 40K (préréglage 
« P4 Quality ») deux passes supplémentaires de 
density control : à l’itération 20 000 et à l’itération 
30 000. Les deux passes parcourent toutes les 
gaussiennes selon trois critères : (a) opacité très 
basse (standard 0.005), (b) taille screen-space mi
nuscule, (c) aucune contribution au loss sur les 
1000 dernières itérations. Les gaussiennes remplis
sant les trois conditions sont purgées. Effet : 
~5–15 % de gaussiennes en moins à la fin de 
l’entraînement, taches sombres visiblement réduites 
dans le ciel sur des scènes drone/outdoor. Coûte 
~1–3 % de régression L1 sur les scènes inté
rieures rapprochées, donc pas activé par défaut. 
Les deux itérations de cleanup (20K, 30K) sont 
définies en dur et ne peuvent pas être modifiées 
via l’UI ; pour des entraînements plus courts (par 
ex. P2 Preview 5K), le toggle n’a aucun effet, 
car il n’atteint jamais ces marqueurs d’itération. 
Nouveau : le toggle n’est désormais utilisable que 
si le préréglage actif utilise le densifieur Classic 
(densificationStrategy == .classic). Sous MCMC 
ou Hybrid, il est désactivé et un indice inline ap
paraît, car ces stratégies traitent de toute façon 
elles-mêmes les gaussiennes mortes (MCMC via 
relocation, Hybrid via une logique combinée reloc/
noise) — les passes de cleanup manuelles y seraient 
sans effet voire contre-productives. Référence de 
code : RadianceKitApp.swift, onglet General. Dé
tails : memory/​dev_​outdoor-floater-reduction.md.

E N  B R E F

Pendant l’entraînement, il se 
forme parfois des points gaus­
siens « morts » qui ne contri­
buent plus à la qualité d’image 
mais occupent de la mémoire. 
Cette option fait du ménage deux 
fois pendant un long entraîne­
ment (à 20K et 30K itérations) 
et supprime ces cadavres. Sur 
les scènes outdoor avec ciel, 
c’est particulièrement utile parce 
que la plupart des floaters s’y 
rassemblent. Pour de petits en­
traînements ou des gros plans 
sur des meubles, plutôt inutile. 
L’interrupteur ne s’active que si 
ton préréglage utilise le densi­
fieur Classic — avec des préré­
glages MCMC ou Hybrid, il est 
grisé (avec une courte explica­
tion), parce que ceux-ci nettoient 
eux-mêmes leurs points morts.
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I44 Reconstruct Sky Dome

O Ù

Inspecteur → Enhancements (groupe Outdoor) → 
toggle « Reconstruct Sky Dome ». Lié à : 
AppState.trainingConfig.skyDomeEnabled (par pro
jet, @DefaultFalse ). Défaut : false .

T E C H N I Q U E

Active la projection sky-dome pré-entraînement 
(V549e MVP). Après le SfM et avant le démarrage 
de l’entraînement, le masque ciel Apple Vision par
tagé avec I42 est extrait de l’image pour chaque 
caméra d’entrée, les pixels de ciel sont déprojetés 
à l’aide des intrinsics caméra sur une surface de 
sphère virtuelle (rayon standard 8× rayon de scène). 
Sur cette sphère, ~5000 nouvelles gaussiennes 
sont initialisées avec des couleurs moyennes issues 
des pixels de ciel projetés, une très grande échelle 
(1.0 en unités de scène) et une opacité initiale de 
0.95. Ces 5000 gaussiennes ne sont pas un sky-
mask au sens classique — elles sont entraînées 
comme les autres, mais maintenues dans une co
quille fine grâce à l’opacité initiale élevée. Résultat : 
sur les vues nouvelles à 360° de scènes outdoor/
drone, au lieu de confettis sombres, on voit la vraie 
couleur du ciel et des structures nuageuses. La va
leur est mémorisée à travers les redémarrages. Utile 
uniquement pour des scènes outdoor avec au moins 
une couverture caméra 360° ; sur des Object Cap
ture purs sans vue du ciel, sans effet. Statut : expé
rimental, une validation A/B plus large sur d’autres 
sets outdoor reste à faire.

E N  B R E F

Au lieu de laisser l’entraînement 
essayer de « deviner » le ciel 
à partir des quelques pixels vi­
sibles (ce qui produit des floa­
ters), RadianceKit projette les 
pixels de ciel directement sur 
une sphère virtuelle autour de 
la scène avant le démarrage 
de l’entraînement. Quand vous 
faites ensuite tourner la scène à 
360°, vous voyez du vrai ciel au 
lieu de taches noires. Fonctionne 
seulement sur les prises outdoor 
où il y a vraiment du ciel dans 
l’image. Sur les scans de salon 
ou les prises studio, sans intérêt.

54 / 177



R A D I A N C E K I T Chapitre 2 — Inspecteur (Expert View)

Section Métriques (I30–I38)

Figure 13. –  Crop section Training Metrics après un entraînement terminé sur Bouquet — 
tableau avec métriques d’entraînement (Iteration, Loss, SSIM Loss, Combined Loss, Gaussian 

Count, Learning Rate, Elapsed, ETA)

Pendant qu’un entraînement tourne, la section Métriques affiche neuf valeurs live de 
la boucle d’entraînement. Avant le démarrage d’un entraînement, la section est vide. 
Toutes les valeurs sont actualisées toutes les ~30 itérations. La section est en lecture 
seule. Pour une analyse plus profonde, utilisez les logs JSONL dans ~/​Documents/​
RadianceKit/​Logs/​.

I30 Iteration

O Ù

Inspecteur → Métriques → Iteration. Lecture seule.

T E C H N I Q U E

Affichage au format « 4523 / 40000 » — itéra
tion courante sur itérations totales planifiées. Le 
deuxième nombre correspond à la valeur Max-Itera
tions au moment du démarrage.

E N  B R E F

Où en est l’entraînement. « 
4523 / 40000 » signifie : 
4523 sur 40 000 étapes sont 
faites. Si le nombre de gauche 
reste figé pendant des minutes, 
l’entraînement est bloqué.
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I31 Loss

O Ù

Inspecteur → Métriques → Loss. Lecture seule.

T E C H N I Q U E

Valeur flottante avec six décimales. Mesure le loss 
combiné L1+SSIM plus optionnellement Perceptual 
Loss. Valeurs finales typiques : Classic Quality 40K 
iters 0.022–0.025 ; MCMC Full 200K 0.024–0.028 ; 
drone outdoor 30K 0.030–0.060 ; appartements 
0.018–0.025. Au-dessus de 0.10 après 5K → pro
blème SfM.

E N  B R E F

À quel point l’image rendue di­
verge encore de l’original. Plus 
petit est mieux. Sous 0.03 c’est 
bien, sous 0.05 OK, scènes 
outdoor 0.03-0.06. Au-dessus 
de 0.10 après plusieurs mil­
liers d’itérations est un signal 
d’alarme.

I32 Learning Rate

O Ù

Inspecteur → Métriques → Learning Rate. Lecture 
seule.

T E C H N I Q U E

Affichage en notation scientifique. Learning rate 
courante pour les paramètres de position. Démarre 
à 1.6e-4 et décroît exponentiellement à ~1.6e-6 à la 
fin.

E N  B R E F

À quel point les pas 
d’optimisation sont grands. Dé­
marre à 1.60e-04 et descend à 
environ 1.60e-06 à la fin. Le dé­
roulé est automatique — rien à 
ajuster.

I33 SH Degree

O Ù

Inspecteur → Métriques → SH Degree. Lecture 
seule.

T E C H N I Q U E

Entier 0-3. Degré de spherical harmonics pour la 
représentation couleur. Démarre à 0 et monte pro
gressivement à 3, typiquement aux itérations 1000, 
2000 et 3000.

E N  B R E F

À quel point la représentation 
couleur par gaussienne est com­
plexe. Démarre à 0 (couleur 
unique) et est portée à 3 (48 
coefficients par gaussienne, ré­
flexions dépendantes de l’angle). 
Schedule automatique.
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I34 Gaussians

O Ù

Inspecteur → Métriques → Gaussians. Lecture 
seule.

T E C H N I Q U E

Nombre actuel de gaussiennes dans le modèle. 
Classic : démarre aux init SfM (50K-300K), croît 
jusqu’à Densify Until. MCMC : monte jusqu’au cap, 
puis relocation. En MCMC, le nombre tombe à < 60 
% du cap → indicateur de collapse.

E N  B R E F

Combien de points gaussiens 
le modèle 3D a. Croît pendant 
l’entraînement jusqu’à Densify 
Until (I20). 500 000 est une va­
leur moyenne typique. Si la va­
leur tombe en MCMC sous 60 % 
du cap, c’est un indicateur de 
collapse.

I35 GPU Memory

O Ù

Inspecteur → Métriques → GPU Memory. Lecture 
seule.

T E C H N I Q U E

Estimation de la consommation buffer en Gaussian-
Count × 616 octets. Ne capture pas l’overhead 
renderer — la consommation réelle est 2-3× supé
rieure. À 500K gaussiennes : affiché ~290 Mo, réel 
~700 Mo.

E N  B R E F

Estimation de la mémoire GPU 
occupée par les gaussiennes 
elles-mêmes. La consommation 
réelle est 2-3× plus élevée. Sur 
16-18 Go, restez sous 500K gaus­
siennes ; avec M3 Max ou Studio 
(64+ Go), 1.5M est possible.

I36 Speed

O Ù

Inspecteur → Métriques → Speed. Lecture seule.

T E C H N I Q U E

Itérations par seconde. Moyenne glissante sur les 
~100 dernières itérations. Classic 20K @ 1.0 sur 
M3 Max : 25-35 it/s. À 0.5 : 80-120 it/s. À 1M+ 
gaussiennes : < 10 it/s. Chutes soudaines → thermal 
throttling.

E N  B R E F

À quelle vitesse l’entraînement 
tourne, en itérations par se­
conde. Typique 20-50 it/s. Baisse 
au cours de l’entraînement est 
normale. Chutes soudaines → 
throttling GPU ou apps concur­
rentes.
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I37 Elapsed

O Ù

Inspecteur → Métriques → Elapsed. Lecture seule.

T E C H N I Q U E

Temps écoulé en m:ss ou h:mm:ss. Mesure unique
ment le temps d’entraînement pur. C’est du wall-
clock, pas du temps CPU.

E N  B R E F

Depuis combien de temps 
l’entraînement tourne, comme 
chronomètre pur. Inclut les 
pauses. Ne couvre pas le calcul 
SfM en amont.

I38 ETA

O Ù

Inspecteur → Métriques → ETA. Lecture seule.

T E C H N I Q U E

Temps restant estimé. Calcul : (Max Iterations − ité
ration actuelle) / it/s. Ne tient pas compte du ralen
tissement typique en fin — réellement, la fin atterrit 
10-20 % au-dessus.

E N  B R E F

Combien de temps il reste à at­
tendre. Une estimation approxi­
mative : ajoutez 15 % pour com­
penser le ralentissement en fin 
d’entraînement. Affiche « – » 
quand la speed est à 0.
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Section Diagramme de loss (I39–I41)

Figure 14. –  Crop section Loss History uniquement après un entraînement terminé — 
Current, Min, courbe bleue de loss, et en dessous chart Gaussian Count en orange

La section Diagramme de loss visualise l’évolution de l’entraînement dans le temps. Elle 
se compose de deux charts : un chart de courbe de loss (grand, en haut, bleu) et un 
chart Gaussian Count (plus petit, en bas, orange). Les deux sont construits en direct 
pendant l’entraînement.

I39 Affichage Current Loss

O Ù

Inspecteur → Diagramme de loss → label gauche. 
Lecture seule.

T E C H N I Q U E

Valeur flottante du dernier point sample de loss, 
formatée avec quatre décimales. Identique à I31 
mais en plus compact.

E N  B R E F

La valeur de loss actuelle en no­
tation plus courte qu’en section 
Métriques. Inhérent identique à 
I31 mais juste à côté du chart.

59 / 177



R A D I A N C E K I T Chapitre 2 — Inspecteur (Expert View)

I40 Affichage Min Loss

O Ù

Inspecteur → Diagramme de loss → label droit « 
Min: 0.0245 » (vert). Lecture seule.

T E C H N I Q U E

Minimum de toutes les valeurs de loss jamais vues. 
Recomputé en direct depuis l’historique. La ligne 
pointillée verte au bord inférieur du chart marque 
cette position Y.

E N  B R E F

La valeur de loss la plus basse 
vue par cet entraînement — en 
vert parce que « best so far ». 
La ligne pointillée verte au bord 
inférieur marque cette position.

I41 Chart Gaussian Count

O Ù

Inspecteur → Diagramme de loss → deuxième chart 
en dessous (orange). Lecture seule.

T E C H N I Q U E

Diagramme linéaire du nombre de gaussiennes sur 
les itérations. En Classic : montée continue jusqu’à 
Densify Until, puis plate. En MCMC : montée raide 
jusqu’au cap, puis ligne horizontale. Si la courbe 
descend → bug MCMC-Collapse.

E N  B R E F

Comment évolue le nombre 
de gaussiennes au cours de 
l’entraînement. En Classic, mon­
tée puis plat. En MCMC, mon­
tée raide puis horizontale. Si la 
courbe fléchit vers le bas → 
signe du bug MCMC-Collapse de 
v1.4.4.

Comment lit-on la courbe de loss ?

Le chart de loss est l’outil de diagnostic le plus important de l’inspecteur. La forme 
saine typique est une chute rapide dans les 1000-3000 premières itérations (d’environ 
0.15 à environ 0.05), suivie d’une descente lente et régulière jusqu’à la fin (jusqu’à 
0.020-0.030).

Que signifie un plateau sur le loss ? Si la courbe reste plate sur plusieurs milliers 
d’itérations, deux lectures possibles : (a) L’entraînement a « convergé » — c’est « fini 
». (b) L’entraînement « bloque » — optimisation stagnante. Distinguer : si la valeur est 
dans une plage typiquement bonne (0.020-0.030 intérieur/objet, 0.040-0.060 outdoor) 
et la courbe plate depuis 5K, c’est convergé. Si nettement plus élevée (par ex. 0.08), 
ça bloque.

Attention plateau Gaussian ≠ plateau loss. Un plateau dans le nombre de gaus
siennes signifie seulement que la densification a cessé d’ajouter de nouveaux points — 
pas que l’entraînement est terminé.

Règle d’arrêt : si la courbe de loss est au-dessus de 0.08 après 5000+ itérations et 
ne descend plus, il y a de fortes chances que la reconstruction SfM soit foireuse. Aban
donnez, regardez au chapitre 9, basculez le cas échéant, puis redémarrez.
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Quand utiliser l’inspecteur ?

Référence rapide : quelle section + quels contrôles pour quel cas d’usage typique ?
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Tâche courante Section IDs des contrôles

Désaturer les couleurs du splat 
fini

Look L1 (Saturation)

Arrondir les splats en aiguille / 
confetti

Look L2 (Splat length)

Combler un nuage troué / 
agrandir les splats

Look L3 (Splat size)

Estomper les « far-confetti » 
lointains sur les orbites

Look L4 (Fade far region)

Annuler les ajustements Look Look L5 (Reset finishing)

Charger un setup préfabriqué Préréglages I7 (clic sur la ligne)

Enregistrer son propre setup Préréglages I1 → I2 → I4

Partager un setup Préréglages I5 (Export) ou I6 (Import)

Changer de backend SfM Configuration 
d’entraînement

I12 (voir chap. 9)

Images vidéo sans focale EXIF Configuration 
d’entraînement

I13 (FOV Override)

Performance COLMAP Configuration 
d’entraînement

I14

Classic à MCMC Configuration 
d’entraînement

I15

Faire tourner plus longtemps Configuration 
d’entraînement

I18 + I20 (couplés via I19)

Diviser le temps GPU par deux Configuration 
d’entraînement

I22 (Render Scale à 50 %)

Qualité MCMC +6 % Configuration 
d’entraînement

I16 (MCMC Quality)

Scène outdoor avec beaucoup 
de points

Configuration 
d’entraînement

I17 (Auto-scale by scene)

Configurer chemin COLMAP Configuration 
d’entraînement

I23 / I24 / I25

Exports plus petits Enhancements I26

Viewport plus net Enhancements I27 (Viewport Scaling → Me
talFX)

Alternative à MetalFX Enhancements I27 (Viewport Scaling → Lanc
zos)

Détail fin sur structures déli
cates

Enhancements I29 (Perceptual Loss 0.05-0.1)

Surveiller l’entraînement Métriques I30, I36, I38
Estimer la qualité tôt Métriques I31 (Loss < 0.05 après 5K = 

bien)
Soupçon de problème SfM Métriques + Dia

gramme de loss
I31 + I39 (Loss > 0.08 après 

5K)
Convergence vs blocage Diagramme de loss I39 + I40Problème de densification Diagramme de loss I41 (courbe Gaussian descend 
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C H A P I T R E

Chapitre 3 — Réglages

La fenêtre des réglages s’ouvre via RadianceKit → Réglages… ou le raccourci clavier 
standard ⌘, . Elle contient deux onglets : General et AI Helpers. Contrairement aux 
valeurs de l’inspecteur du chapitre 2, les réglages de cette fenêtre agissent de manière 
globale à l’application (à travers tous les projets) — ils sont persistés et survivent aux 
redémarrages de l’app. L’onglet General regroupe trois sections thématiques : Interface, 
Viewport et Training. (Les trois toggles Outdoor-Floater — Sky Masking, Mid-Training 
Floater Cleanup et Reconstruct Sky Dome — qui se trouvaient autrefois ici ont migré, 
depuis la v1.6, dans la section Enhancements de l’Expert-Inspector, où ils sont désor
mais stockés par projet ; voir chapitre 2, I42–I44.) L’onglet AI Helpers active les helpers 
ML on-device (Vision, CoreML) pour le prétraitement SfM et d’entraînement.

D’anciens contrôles permettant d’activer ou de désactiver tous les AI-Helpers d’un seul 
geste n’existent plus dans la version actuelle — ils ne sont donc pas documentés ici. 
L’ancienne section « Coming Soon » pour les helpers pas encore livrés a également été 
supprimée et n’est pas référencée ici.
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Onglet General

Figure 15. –  Réglages → onglet General avec interface, viewport, entraînement et section 
expérimentale
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S1 Default Mode

O Ù

Réglages → General → Interface → sélecteur Default 
Mode. Lié à :. Défaut : .simple .

T E C H N I Q U E

Contrôle dans lequel des deux modes UI 
l’application s’ouvre au prochain démarrage. « 
Simple Mode » est le workflow guidé en 4 étapes 
(Import → Processing → Preview → Export, docu
menté au chapitre 10 sous Z1–Z4), « Expert Mode » 
la disposition classique à trois panneaux avec Navi
gator, viewport 3D et Expert-Inspector du chapitre 
2. La valeur est mémorisée à travers les redémar
rages. Même effet que le menu Mode → Simple Mode 
(⌘1) / Mode → Expert Mode (⌘2), à ceci près que 
le menu commute la session en cours, tandis que 
ce sélecteur fixe le défaut pour les sessions futures. 
Les deux modes accèdent au même état projet 
— projets, caméras et configuration d’entraînement 
sont préservés lors du changement de mode. Les 
boutons de toolbar spécifiques au mode sont reren
dus immédiatement.

E N  B R E F

Vous choisissez ici avec quelle 
interface RadianceKit démarrera 
la prochaine fois. « Simple Mode 
» est le mode débutant : quatre 
étapes claires, préréglages im­
posés, peu d’options. « Expert 
Mode » est la disposition com­
plète de la boîte à outils avec 
tous les curseurs visibles au cha­
pitre 2. Vous pouvez à tout mo­
ment passer de l’un à l’autre via 
le menu « Mode » sans perdre 
vos images ni la progression 
d’entraînement.

S2 Language

O Ù

Réglages → General → Interface → sélecteur Lan
guage. Lié à :. Défaut : .system  (suit la langue 
macOS).

T E C H N I Q U E

Choisit la langue d’affichage de toute l’UI de l’app, 
indépendamment de la langue système macOS. Ra
dianceKit est localisé en 17 langues ( de , en , pl , 
en-AU , ar-SA , plus 12 autres). En « System », 

l’app suit la langue macOS. Pour un choix explicite, 
le réglage de langue est mémorisé à travers les re
démarrages ; un effet complet exige généralement 
un redémarrage de l’app, parce que les bundles de 
localisation ne sont chargés qu’au démarrage. Les 
298 clés de localisation documentées dans le projet 
sont toutes prises en compte, y compris tous les 
textes des sous-vues et tooltips d’aide.

E N  B R E F

Si votre Mac est en anglais mais 
que vous préférez l’interface Ra­
dianceKit en français (ou inver­
sement), vous le réglez ici. La 
plupart des textes basculent im­
médiatement. Certains dialogues 
n’apparaissent dans la nouvelle 
langue qu’après un redémarrage 
de l’app.

65 / 177



R A D I A N C E K I T Chapitre 3 — Réglages

S3 Viewport Background

O Ù

Réglages → General → Viewport → sélecteur Back
ground. Lié à :. Défaut : .darkGray  (RGB 0.1, 0.1, 
0.1).

T E C H N I Q U E

Fixe la couleur de fond par défaut du viewport 3D. 
Trois options : « Dark Gray » (RGB 0.1, 0.1, 0.1 — 
défaut), « Black » (0, 0, 0) et « White » (1, 1, 1). 
Le réglage persiste le défaut pour les nouveaux pro
jets et sessions à travers les redémarrages et met 
simultanément à jour le renderer Metal en cours. 
Les mêmes options se retrouvent dans le menu 
Viewport → Background (M21, M22, M23), mais le 
sélecteur des réglages fixe le défaut tandis que le 
menu commute l’affichage courant. Important pour 
captures d’écran et vidéos de démo : les fonds 
blancs font mieux ressortir les floaters verts/bleus, 
les fonds sombres sont préférables pour des rendus 
propres.

E N  B R E F

La couleur derrière vos modèles 
3D dans la fenêtre d’aperçu. 
Le gris foncé est le défaut et 
convient à la plupart des scènes. 
Le blanc est bien pour les cap­
tures d’écran, le noir paraît plus 
chic pour les rendus. Vous pou­
vez basculer la couleur à tout 
moment via le menu « Viewport 
→ Background » pour la scène en 
cours — ce réglage définit seule­
ment la couleur qui sera active à 
la prochaine ouverture.
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S4 Auto-Rotate After Training

O Ù

Réglages → General → Viewport → toggle « Auto-
Rotate After Training ». Lié à :. Défaut : false .

T E C H N I Q U E

Démarre, juste après la fin de l’entraînement, une 
rotation turntable continue de la caméra du view
port autour du centre de gravité de la scène (vitesse 
standard ~0.3 rad/s). Concrètement utile pour des 
sessions de démo, des comparaisons A/B et pour 
juger immédiatement, depuis une vue 360°, si des 
« floaters » se sont formés en bord de scène. Effet 
visuel identique au menu Viewport → Toggle Auto-
Rotation (M16, ⌘⌥T), à ceci près que ce toggle 
déclenche le comportement automatiquement après 
l’entraînement au lieu de le faire manuellement. Peut 
être interrompu à tout moment via le menu ou en 
cliquant dans le viewport (ce qui met la rotation en 
pause). N’a aucune influence sur les performances 
d’entraînement — la rotation ne se lance qu’une fois 
le training terminé.

E N  B R E F

Si activé, la scène 3D tourne 
automatiquement dès la fin de 
l’entraînement — comme un car­
rousel. Pratique si vous lancez 
un entraînement la nuit et voulez 
voir le résultat en mouvement le 
matin sans avoir à cliquer. Pour 
de longues sessions où vous sur­
veillez l’entraînement, laissez-le 
plutôt désactivé.
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S5 Live Preview Interval

O Ù

Réglages → General → Training → 
sélecteur Live Preview. Lié à : 
AppState.trainingConfig.livePreviewInterval. 
Défaut : 0  (Off).

T E C H N I Q U E

Détermine à quel intervalle d’itérations le snapshot 
d’entraînement en cours est rendu dans le viewport 
3D. Quatre valeurs discrètes : 0 (« Off »), 50, 250, 
1000 itérations. Quand le Live Preview est actif, 
l’entraîneur copie le buffer de gaussiennes depuis le 
GPU vers un buffer de rendu séparé et déclenche 
un redessin du viewport. En « Off », le viewport 
n’est mis à jour qu’après la fin de l’entraînement. 
Coût de performance : toutes les 50 itérations 
~5–10 % plus lent sur M3 Ultra, toutes les 250 
itérations ~1–2 % plus lent, toutes les 1000 itéra
tions non mesurable. Overhead mémoire constant 
~2 Go pour le buffer de snapshot, indépendam
ment de l’intervalle. La valeur sert de défaut pour 
les nouveaux entraînements ; après le démarrage, 
l’inspecteur d’entraînement affiche la valeur live 
réelle de ce training. À l’intervalle 50, l’impression 
visuelle est une « croissance » fluide du nuage de 
points ; à 1000, l’effet est saccadé.

E N  B R E F

Pendant l’entraînement, vous 
pouvez choisir à quelle fré­
quence la vue 3D se rafraîchit. 
« Off » signifie : pas de mise 
à jour pendant l’entraînement (le 
plus rapide). « Every 50 Itera­
tions » montre presque en temps 
réel la naissance de votre scène 
(un peu plus lent). Pour observer 
tranquillement de petits entraî­
nements, « Every 250 » est un 
bon compromis.
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S6 Throttle Delay

O Ù

Réglages → General → Training 
→ sélecteur Throttle. Lié à : 
AppState.trainingConfig.throttleDelayMs. Dé
faut : 0  (Off).

T E C H N I Q U E

Insère un délai artificiel en millisecondes entre les 
itérations d’entraînement. Quatre valeurs discrètes : 
0 (« Off »), 2 (« Light »), 5 (« Moderate »), 10 (« 
Eco »). But : sur les entraînements longs (plusieurs 
heures), le GPU est sinon chargé à 100 %, ce qui 
ralentit nettement l’UI système (le curseur saccade, 
les autres apps deviennent lentes). Le délai throt
tle donne au GPU des pauses pendant lesquelles 
d’autres tâches peuvent s’exécuter. Le coût en per
formance est important : à 5 ms de throttle, un 
entraînement typique 40K dure environ 50–80 % 
plus longtemps que sans throttle. Au mode « Eco 
» (10 ms), le délai par itération est plus long 
que l’itération elle-même — facteur 2–3× plus lent. 
Quand le throttle est actif, une mention apparaît 
sous le sélecteur : « Throttle is on. Training will be 
slower than usual. » L’app elle-même ne réagit pas 
sensiblement mieux — seules les autres apps en 
profitent.

E N  B R E F

Si votre Mac chauffe trop pen­
dant un long entraînement ou si 
d’autres programmes deviennent 
trop lents, activez ici un frein. « 
Off » donne plein gaz au GPU (le 
plus rapide). « Light » fait une 
petite pause entre chaque étape 
(un peu plus lent, mais le sys­
tème réagit mieux). « Eco » est 
le frein le plus fort — bien pour 
des entraînements de nuit sur 
un MacBook qui ne doit pas trop 
chauffer.
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Onglet AI Helpers

Figure 16. –  Réglages → onglet AI Helpers avec interrupteur maître et sous-toggles
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S11 AI Helpers enabled (Master)

O Ù

Réglages → AI Helpers → première section → toggle 
« AI Helpers enabled ». Lié à :. Défaut : true .

T E C H N I Q U E

Interrupteur maître pour toutes les fonctionnalités 
AI-Helpers du pipeline. Désactivé, les pipelines 
d’import et de SfM sautent complètement toutes 
les étapes de prétraitement basées sur le ML — 
aucun appel Apple Vision, aucun chargement de 
modèle CoreML, aucun réveil du NPU. Activé, les 
sous-toggles individuels (S12–S13) sont consultés. 
La valeur est mémorisée à travers les redémarrages. 
Affecte les étapes suivantes : (a) frame-quality 
pre-check avant SfM (S12), (b) détection de loop 
closure (S13). Important : désactivé, les deux sous-
toggles sont désactivés et grisés visuellement. La 
mention de pied de page souligne que tous les 
AI-Helpers fonctionnent strictement on-device — 
aucun upload d’image, aucun traitement cloud. La 
garantie de confidentialité vient de l’utilisation ex
clusive du framework Apple Vision (local sur le 
Neural Engine) et de modèles CoreML qui résident 
directement dans le bundle de l’app.

E N  B R E F

L’interrupteur principal pour 
toutes les fonctions qui utilisent 
du machine learning en interne. 
Par défaut sur « on », parce que 
les helpers font gagner beau­
coup de temps sans que vos 
images quittent le Mac. Si vous 
voulez les désactiver entière­
ment (par ex. pour économiser la 
batterie ou parce que votre Mac 
n’a pas de NPU), désactivez-le ici 
— les deux sous-options ci-des­
sous deviennent alors automati­
quement grises et ne font plus 
rien.
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S12 Frame quality check

O Ù

Réglages → AI Helpers → section Available → toggle 
« Frame quality check ». Lié à :. Défaut : true .

T E C H N I Q U E

Active le frame-quality screener (Phase 3.11) qui 
analyse chaque image importée avant l’appel SfM. 
Étapes du pipeline par image : (a) filtre de variance 
laplacienne d’Apple Vision (détection de flou — 
seuil ~150), (b) check sur/sous- exposition par his
togramme (seuil : >5 % de pixels à 0 ou 255), 
(c) détection d’image vide (écart-type < 5 sur tous 
les pixels). Les images qui passent les trois checks 
continuent directement. Celles qui en ratent au 
moins un déclenchent une boîte de dialogue modale 
de confirmation qui liste chaque image probléma
tique avec miniature et raison et demande si elle 
doit être supprimée. Important : aucune suppres
sion automatique — le dialogue est toujours requis, 
l’utilisateur garde la décision finale. Performance : 
~50 ms par image sur M3 Ultra, parallèle. Désacti
vé, toutes les images sont transmises à SfM sans 
contrôle. Quand le master (S11) est désactivé, ce 
toggle est visuellement grisé et sans effet. Statut 
livré selon la mémoire : SHIPPED 2026-05-23.

E N  B R E F

Avant l’entraînement proprement 
dit, l’app regarde chaque photo : 
est-elle floue ? complètement 
sombre ou blanche ? vide ? Si 
oui, elle vous demande si vous 
voulez la jeter — elle ne sup­
prime jamais rien automatique­
ment. Cela vous évite plus tard 
de nombreuses heures, parce 
qu’une seule image très floue 
peut parfois ruiner tout un en­
traînement. Par défaut « on », 
parce que l’effort est presque nul 
et le bénéfice grand.
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S13 Loop closure detection

O Ù

Réglages → AI Helpers → section Available → toggle 
« Loop closure detection ». Lié à :. Défaut : true .

T E C H N I Q U E

Active la détection de loop closure basée sur l’Apple 
Vision Feature Print. Pour chaque image importée, 
un vecteur de features d’environ 768 dimensions 
est calculé, représentant un embedding neuronal du 
contenu d’image. Toutes les feature prints sont en
suite comparées deux à deux par similarité cosinus. 
Les paires avec similarité > 0.85 et distance d’index 
> 50 (donc images non voisines) sont identifiées 
comme « candidates loop closure » et écrites dans 
un fichier sidecar JSONL dans le dossier du projet. 
Informationnel seulement — la séquence d’images 
importée n’est pas modifiée. But : donner au solveur 
SfM (en particulier COLMAP) un indice que ces 
images appartiennent à un cluster dans l’espace 3D. 
Pour le SfM natif, l’information sidecar est actuel
lement seulement documentaire ; COLMAP utilise 
les hints en interne via un fichier custom matches 
(intégration manuelle possible, pas reliée automati
quement). Performance : ~200 ms par image sur 
M3 Ultra, parallèle. Désactivé, aucune feature print 
n’est générée. Quand le master (S11) est désactivé, 
grisé visuellement.

E N  B R E F

Si vous tournez autour d’un ob­
jet en prenant des photos et 
revenez à la fin au point de 
départ, savoir cela aide énor­
mément l’ordinateur. Cette op­
tion reconnaît automatiquement 
quelles de vos photos ont été 
prises « presque au même en­
droit » et l’écrit dans un petit 
fichier auxiliaire. Les outils SfM 
(surtout COLMAP) peuvent utili­
ser cette information pour pro­
duire une reconstruction 3D plus 
propre. Par défaut « on », parce 
que cela tourne sans votre inter­
vention et ne modifie rien à vos 
images.

Réglages reflets de l’inspecteur

Les autres entrées de réglages (S17–S33) de l’inventaire sont des reflets de l’Expert-
Inspector et documentées au chapitre 2 (contrôles d’inspecteur I12–I29). Elles 
n’apparaissent pas physiquement dans la fenêtre des réglages, mais ont seulement été 
listées dans l’inventaire parce qu’elles passent par des propriétés de TrainingConfig  
persistées via et ont à ce titre un caractère formel de réglage. Pour les explications de 
fond, voir là-bas.
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Quand utiliser quoi ?

Réglage Portée Persistance

S1 Default Mode Global app Redémarrage app

S2 Language Global app Redémarrage app

S3 Viewport Back
ground

Global app (défaut) + runtime Redémarrage app

S4 Auto-Rotate Af
ter Training

Global app Redémarrage app

S5 Live Preview In
terval

Défaut nouveaux entraînements Redémarrage app

S6 Throttle Delay Défaut nouveaux entraînements Redémarrage app

S11 AI Helpers 
Master

Global app Redémarrage app

S12 Frame quality 
check

Global app Redémarrage app

S13 Loop closure 
detection

Global app Redémarrage app

Global app = agit sur tous les projets. Défaut nouveaux entraînements = agit seulement 
sur le prochain entraînement créé, les sessions en cours restent inchangées. Entraîne
ment courant = agit immédiatement sur la configuration d’entraînement en cours, mais 
ne persiste pas sans réimport explicite.
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C H A P I T R E

Chapitre 4 — Fenêtres auxiliaires

En plus de la fenêtre principale (viewport 3D et inspecteur), RadianceKit gère sept 
autres fenêtres, toutes ouvertes via le menu Help. Trois d’entre elles — Pareto Dash
board, Holdout Analysis, BayesOpt Console — sont des outils d’analyse indépendants. 
Pour chacune un argument CLI permet de faire pointer la fenêtre dès le démarrage sur 
un fichier précis ( --dashboard-dir , --holdout-file , --bayesopt-autorun ).

Les quatre fenêtres simples (User Guide, Keyboard Shortcuts, Manage Storage, plus les 
sous-entrées Open Training Logs / Open Exports Folder) reçoivent une courte entrée 
par contrôle. Les trois fenêtres d’analyse sont documentées plus en détail. À la fin du 
chapitre, une section de renvois croisés vers l’inspecteur.

User Guide (W1–W4)

Figure 17. –  Fenêtre User Guide avec sidebar à gauche et contenu Markdown rendu à droite

Ce que c’est : une fenêtre d’aide intégrée qui rend le guide_<langue>.md  livré avec 
l’app. La langue est déduite des réglages.

QUAND L’OUVRIR  Pour un rappel rapide sur un point précis. La référence détaillée est ce 
manuel ; la fenêtre d’aide intégrée est l’équivalent d’un --help  en ligne de commande.
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W1 NavigationSplitView (sidebar + détail)

O Ù

Help → User Guide (⌘?).

T E C H N I Q U E

Disposition à deux colonnes avec sidebar étroite 
(au moins 180 pt) pour l’arborescence et zone de 
détail défilante pour le contenu Markdown. Taille 
min 700 × 500 pt. À la première ouverture, charge 
le guide_<lang>.md  depuis le bundle (fallback 
guide_en.md ), le parse en blocs et extrait la struc

ture des titres pour la sidebar.

E N  B R E F

L’aide intégrée : à gauche la liste 
des sujets, à droite le contenu. 
La langue se règle automatique­
ment. Fonctionne hors ligne mais 
est une version courte — la réfé­
rence complète est ce manuel.

W2 List (sidebar des titres)

O Ù

Colonne gauche dans la fenêtre User Guide.

T E C H N I Q U E

Liste des titres H2 et H3 du Markdown courant. Les 
H4 et plus profonds sont ignorés. ID d’ancre géné
rés par slugification du texte.

E N  B R E F

La barre de navigation à gauche. 
Tapez une entrée pour sauter à la 
section.

W3 Button (titre → saut d’ancre)

O Ù

Un bouton par ligne de sidebar.

T E C H N I Q U E

Chaque entrée est un bouton qui définit l’ancre cou
rante avec animation douce 0,3 s.

E N  B R E F

Un clic vous mène à l’endroit cor­
respondant.

W4 ScrollView (contenu détaillé)

O Ù

Colonne droite.

T E C H N I Q U E

Zone de contenu défilante avec lazy rendering — les 
longs guides peuvent avoir plus de 200 blocs Mark
down. Largeur max 720 pt.

E N  B R E F

Le texte d’aide. Défilant, largeur 
lisible.
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Keyboard Shortcuts (W5–W6)

Figure 18. –  Fenêtre Keyboard Shortcuts — cinq groupes Navigation/Views/Capture/Editor/
Training

CE QUE MONTRE L’IMAGE  Liste de référence statique en cinq sections. Navigation : glisser 
souris, Shift+Drag, molette (zoom), WASD, Q/E, F (orbite/vol), double-clic (recentrer), 
Cmd+molette (FOV). Views : R, T, P, B, 0-9, flèches. Capture : S, V, C. Editor : Tab, 
clic, Option+clic, X/Delete, Cmd-Z, [/]. Training : M9–M14.

Ce que c’est : un aperçu statique des raccourcis. Contenu codé en dur.

QUAND L’OUVRIR  Quand vous cherchez le chemin le plus rapide pour faire quelque chose 
dans le viewport.
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W5 ScrollView (zone de contenu)

O Ù

Help → Keyboard Shortcuts (⌘/).

T E C H N I Q U E

Zone défilante simple. Padding 20 tout autour. Co
lonne gauche fixée à 180 pt. Aucune interaction 
sauf défilement.

E N  B R E F

Cheat-sheet statique pour vérifi­
cation rapide.

W6 VStack (sections de raccourcis)

O Ù

Dans le ScrollView.

T E C H N I Q U E

Sections empilées alignées à gauche avec 16 pt 
d’espacement.

E N  B R E F

Le regroupement des touches 
par fonction.
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Manage Storage (W7–W12)

Figure 19. –  Fenêtre Manage Storage — en-tête « 693 items · 16.74 GB total », tableau de 
fichiers PLY exportés triés par date

CE QUE MONTRE L’IMAGE  Vue tableau de tous les fichiers gérés par RadianceKit. Toolbar : 
« Show in Finder » + « Refresh ». Chaque ligne : icône, nom de fichier, date, taille, 
loupe (Reveal), corbeille (Move to Trash).

Ce que c’est : un aperçu d’occupation disque pour tout ce que RadianceKit dépose 
sous ~/​Documents/​RadianceKit/​ — logs, exports, scènes, bundles capture, imports. 
N’est PAS un nettoyage automatique — vous décidez par entrée.

QUAND L’OUVRIR  Quand le disque se remplit. Les logs et les exports s’accumulent.
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W7 Bouton « Show in Finder »

O Ù

En-tête en haut à droite.

T E C H N I Q U E

Ouvre tout le dossier ~/​Documents/​RadianceKit/​ 
dans le Finder.

E N  B R E F

Ouvre le dossier dans le Finder.

W8 Bouton « Refresh »

O Ù

En-tête, à côté du bouton Finder.

T E C H N I Q U E

Déclenche un scan en arrière-plan. Parcourt chaque 
sous-dossier connu et génère une entrée par enfant 
direct. Calcule la taille récursive (préfère la consom
mation disque réelle avec hardlinks APFS).

E N  B R E F

Relit la liste si vous avez changé 
des choses dans le Finder.

W9 List (entrées storage)

O Ù

Contenu principal sous l’en-tête.

T E C H N I Q U E

Liste avec disposition par ligne : icône SF Symbol, 
nom, sous-titre, compteur d’octets, boutons Reveal 
et Trash. Tri primaire par type, secondaire par date 
décroissante.

E N  B R E F

Liste de toutes vos données triée 
par type et fraîcheur.

W10 Bouton de ligne « Reveal in Finder »

O Ù

Par ligne, icône loupe.

T E C H N I Q U E

Ouvre le Finder et sélectionne l’élément spécifique.

E N  B R E F

Saute dans le Finder sur cette 
entrée.

80 / 177



R A D I A N C E K I T Chapitre 4 — Fenêtres auxiliaires

W11 Bouton de ligne « Move to Trash »

O Ù

Par ligne, icône corbeille.

T E C H N I Q U E

Déclenche le dialogue (W12). Après confirmation, 
opération macOS « mettre à la corbeille » (réver
sible).

E N  B R E F

Met l’entrée à la corbeille. Dia­
logue d’abord.

W12 ConfirmationDialog (confirmation de suppression)

O Ù

Déclenché par W11.

T E C H N I Q U E

Dialogue standard avec titre dynamique et message 
indiquant la récupération depuis la corbeille. Deux 
boutons : destructive et Cancel.

E N  B R E F

Question de sécurité. « Move to 
Trash » est réversible tant que la 
corbeille n’est pas vidée.

Pareto Dashboard (W13–W22)

Figure 20. –  Pareto Dashboard — état vide avant import de rapport

État vide avec call-to-action « Open Reports Folder… ».

81 / 177



R A D I A N C E K I T Chapitre 4 — Fenêtres auxiliaires

Figure 21. –  Pareto Dashboard avec 129 rapports de benchmark chargés — Gaussians vs 
PSNR avec Pareto Front, filtres Scene/Strategy/Mip

CE QUE MONTRE L’IMAGE  Toolbar affiche « 129 reports of 129 ». Axes : X sur Gaussians , 
Y sur PSNR (dB) . Scatter : points verts = Classic, bleus = MCMC. Ligne pointillée = 
Pareto Front. Chips de filtre : scènes, 2 stratégies, 3 options Mip.

Ce que c’est : un outil de comparaison multi-run. Chaque run d’entraînement (avec 
--benchmark ) produit un rapport JSON avec PSNR, SSIM, LPIPS, gaussiennes et 

temps. Le dashboard lit un dossier entier de rapports et les trace en scatter 2D avec 
axes sélectionnables. La Pareto Front (points non dominés) est dessinée en pointillé.

QUAND L’OUVRIR  Après au moins trois ou quatre rapports. Avec moins de points, la fron
tière n’est pas significative.

COMMENT INTERPRÉTER  Les deux axes sont libres. Un point est Pareto-optimal si aucun 
autre n’est au moins aussi bon sur les deux dimensions. Les points sur la ligne sont les 
vrais candidats « meilleur préréglage ».

CHIPS DE FILTRE  Restreindre à une scène, stratégie (Classic ou MCMC) ou Mip on/off.

Action suivante : enregistrer la meilleure configuration comme préréglage via 
l’inspecteur.

W13 Bouton « Open Reports Folder… »

O Ù

Toolbar en haut à gauche.

T E C H N I Q U E

Ouvre un dialogue de sélection. Task d’arrière-plan 
parse tous les .json . Rapports défectueux affi
chés en sidebar. Aussi via CLI : --dashboard-dir /​
chemin/​.

E N  B R E F

Choisit le dossier des rap­
ports. Standard ~/​Documents/​
RadianceKit/​Reports/​. 
Charge tout d’un coup.
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W14 Sélecteur « X-Axis »

O Ù

Au-dessus du chart, à gauche.

T E C H N I Q U E

Sélecteur menu avec toutes les métriques (PSNR, 
SSIM, LPIPS, Gaussian-Count, time). Défaut Gaus
sian-Count.

E N  B R E F

Métrique sur l’axe horizontal. Gé­
néralement « temps » ou « gaus­
siennes ».

W15 Sélecteur « Y-Axis »

O Ù

Au-dessus du chart, à côté de X-Axis.

T E C H N I Q U E

Identique à W14, défaut PSNR.

E N  B R E F

Axe vertical. Normalement PSNR 
ou SSIM.

W16 Toggle « Show Pareto Front »

O Ù

À droite des sélecteurs d’axes.

T E C H N I Q U E

Toggle macOS standard. Si actif, ligne avec Pareto 
Front 2D dessinée en pointillé gris semi-transpa
rent.

E N  B R E F

Affiche la ligne des « meilleurs 
jusqu’à présent ». Désactivez-la 
si elle gêne.

W17 Chips filtre « Scene »

O Ù

Sidebar droite.

T E C H N I Q U E

Chips pour chaque scène présente. Multi-sélection 
possible.

E N  B R E F

Clic sur un nom de scène filtre. 
Multi-sélection. Vide = toutes.
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W18 Chips filtre « Strategy »

O Ù

Sous le filtre Scene.

T E C H N I Q U E

Comme W17 mais pour stratégies (« classic », « 
mcmc »).

E N  B R E F

Filtre Classique ou MCMC. Par 
défaut, les deux actifs.

W19 Chips filtre « Mip-Splatting »

O Ù

Sous le filtre Strategy.

T E C H N I Q U E

Filtre ternaire (au lieu d’un set) : « All » / « On » / 
« Off ». Mip-Splatting évalué en phase Q1.5 comme 
amélioration multi-échelle expérimentale ; conservé 
comme flag opt-in.

E N  B R E F

Pour comparer Mip on/off. Sinon 
ignorer.

W20 ChipButton (toggle filtre)

O Ù

Composant helper utilisé dans W17/W18/W19.

T E C H N I Q U E

Wrapper bouton minimaliste. Si actif → couleur 
d’accent avec texte blanc. Sinon fond neutre.

E N  B R E F

Les boutons de filtre arrondis.

W21 Chart (scatter Pareto)

O Ù

Zone centrale du dashboard.

T E C H N I Q U E

Diagramme Swift-Charts avec deux couches : un 
point par rapport (couleur par stratégie, symbole 
par Mip) ; ligne Pareto Front si toggle actif. Overlay 
capte la souris : point hover le plus proche sous 24 
px.

E N  B R E F

Le nuage de points. Chaque point 
= un run. Hover pour tooltip.
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W22 Tooltip (détail au survol)

O Ù

Sous le chart, affiché au hover.

T E C H N I Q U E

Stack horizontal : scène, tag stratégie, séparateur, 
métriques PSNR/SSIM/LPIPS/Gs/Time. Tag Mip si 
activé.

E N  B R E F

Carte détail en bas pendant le 
survol. Toutes les métriques d’un 
coup.

Holdout Analysis (W23–W29)

Figure 22. –  Holdout Analysis — état vide avant chargement d’un transforms.json

État vide avec « Open transforms.json… ». Accepte les formats NeRF-Studio et Instant-
NGP.

85 / 177



R A D I A N C E K I T Chapitre 4 — Fenêtres auxiliaires

Figure 23. –  Holdout Globe avec 100 caméras NeRF-Blender Mic, 5 Folds de 20 caméras 
chacun, stratégie Angular active

CE QUE MONTRE L’IMAGE  En-tête montre le fichier et le nombre de caméras. Sidebar 
gauche : sélecteur Strategy (Angular ou Linear), slider k-Folds, sélecteur Test Fold, 
bouton Export. Panneau central : projection 3D-globe des caméras — vertes = Train, 
rouges = Test Fold actuel. Sidebar droite : Mean Nearest Angle par fold.

Ce que c’est : un visualiseur 3D pour votre arrangement caméra avec logique de cross-
validation. Vous chargez un transforms.json  ; l’app projette les directions de regard 
sur une sphère unité et les découpe en k folds avec marqueur de fold de test.

QUAND L’OUVRIR  Pour faire de l’évaluation holdout. Le standard « every-8th view » est 
linéaire ; « angular » stratifie sur l’espace des angles de vue.

COMMENT INTERPRÉTER  Angular (standard) : découpe par longitude en k secteurs égaux, 
bon pour orbites classiques. Linear (round-robin) : index = (image modulo k), fonc
tionne si pas de biais spatial.

Dans le globe 3D : verts (Training) et rouges (Test). Rouges clusterisés en un coin = 
mauvais holdout. Uniformes = bon. Score « Mean nearest angle » : petit = test proche 
du training (facile), grand = test loin (généralisation dure).

 Vous exportez via M33 un fichier nerfstudio. Ouvrez Holdout (⇧⌘H), chargez le 
JSON, regardez le globe. k=5 par défaut. Si les marqueurs sont uniformes : « Export 
fold-assignment.json », et au prochain run avec --benchmark , cette répartition est 
utilisée comme test-holdout.
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W23 Bouton « Open transforms.json… »

O Ù

Toolbar en haut à gauche.

T E C H N I Q U E

Dialogue de fichier limité aux JSON. Le loader parse 
le format nerfstudio et instant-ngp. Aussi via CLI : 
--holdout-file /​chemin/​.

E N  B R E F

Charge votre JSON de poses ca­
méra.

W24 Sélecteur « Strategy »

O Ù

Sidebar gauche, en haut.

T E C H N I Q U E

Radio avec deux options. Changement déclenche 
recalcul automatique des folds.

E N  B R E F

Angular pour orbites uniformes 
(standard, sûr), Linear si pas de 
cluster spatial.

W25 Slider « k Folds »

O Ù

Sidebar gauche, milieu.

T E C H N I Q U E

Slider 3 à 10, pas 1. k=5 standard (20 % de test 
par fold). k=10 beaucoup de données. k=3 peu de 
données.

E N  B R E F

Combien de folds. 5 est standard 
et convient presque toujours.

W26 Sélecteur « Test Fold »

O Ù

Sidebar gauche, sous slider k.

T E C H N I Q U E

Sélecteur menu. Options 0..<k. Si index ≥ k, auto-
remis à 0.

E N  B R E F

Quel fold est test. Parcourez pour 
voir chaque fold dans le globe.
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W27 Bouton « Export fold-assignment.json »

O Ù

Sidebar gauche, en bas.

T E C H N I Q U E

Dialogue avec nom par défaut fold-
assignment.json. Encode la répartition (par frame : 
fold + meta stratégie).

E N  B R E F

Enregistre la répartition train/
test. Vous pouvez passer ce fi­
chier à l’entraînement.

W28 SCNView (globe caméra 3D)

O Ù

Panneau central.

T E C H N I Q U E

Vue globe SceneKit. Sphère wireframe (rayon 1, 36 
segments), trois axes colorés, et une petite sphère 
marqueur (rayon 0.03) par caméra. Mise à jour ma
tériaux : rouge pour Test, vert pour Training. Souris : 
rotation, zoom, pan.

E N  B R E F

Le globe 3D des positions camé­
ra. Vert = Training, Rouge = Test. 
Souris pour tourner et zoomer.

W29 FoldCard (tap to select fold)

O Ù

Sidebar droite, section « Angular Correlation ».

T E C H N I Q U E

Une carte par fold avec deux lignes (haut : « Fold N 
» + cams, bas : « Mean nearest angle » + valeur en 
degrés). Tap sélectionne le fold.

E N  B R E F

Petite carte par fold avec 
compte de caméras et distance 
moyenne. Clic sélectionne ce 
fold.
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BayesOpt Console (W30–W39)

Figure 24. –  BayesOpt Console — état vide avant le démarrage du trial

État vide avec sélecteur Search-Space, slider Trial Budget (défaut 40), Random Seed 
(42).

Figure 25. –  BayesOpt Console après 40 trials — Convergence chart monte abruptement, 
Best Value 0.9943

CE QUE MONTRE L’IMAGE  Statut « Finished — best 0.9943 after 40 trials ». Sidebar 
gauche : Search-Space, Trial Budget 40, Seed 42, liste paramètres. Centre : Conver
gence chart avec points gris (LHS), bleus (BayesOpt) et orange (restart). Sidebar 
droite : Trial Log avec tag init/bo/restart.

Ce que c’est : une console d’optimisation bayésienne pour la recherche 
d’hyperparamètres. BayesOpt cherche avec le moins d’expériences possible l’optimum 
d’une fonction inconnue.

Important : la version livrée mène l’optimisation contre un objectif de démo synthé
tique, pas contre de vrais runs (durerait des jours). La fenêtre doit montrer le compor
tement de l’optimiseur. Pour de vrais tunings (comme en phase Q7), un workflow CLI 
offline séparé est utilisé.

QUAND L’OUVRIR  Trois cas : comprendre BayesOpt, planifier une nouvelle classe de 
scène, inspecter les search-spaces par défaut.
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COMMENT INTERPRÉTER  - Convergence chart : Y = meilleure objective atteinte. X = trial. 
Ligne plate 20+ trials → optimum trouvé. - Tableau Trial : trial avec valeur et tag. 
Meilleur trial avec étoile jaune. - Inspecteur Search-Space : paramètres du préréglage 
et plages.

W30 Bouton « Start »

O Ù

Toolbar gauche, Idle/Finished.

T E C H N I Q U E

Reset trial-list, passe en Running, génère Run-ID, 
lance task en arrière-plan. Initial samples = min(8, 
budget /​ 4 + 1). Protection stale-run.

E N  B R E F

Démarre une nouvelle optimisa­
tion avec search-space, budget 
et seed actuels.

W31 Bouton « Pause »

O Ù

Toolbar gauche, Running.

T E C H N I Q U E

Active pause-gate. Le runner attend en polling 50 
ms. Trial en cours se termine, aucun nouveau lancé.

E N  B R E F

Met le run en pause. Calcul en 
cours se termine.

W32 Bouton « Stop »

O Ù

Toolbar gauche, Running et Paused.

T E C H N I Q U E

Interrompt le task runner, passe en Finished State. 
Trials calculés restent visibles. Bouton rouge.

E N  B R E F

Annule définitivement. Trials res­
tent visibles, Best Config expor­
table.

W33 Bouton « Resume »

O Ù

Toolbar gauche, Paused.

T E C H N I Q U E

Lève pause-gate. Le task runner détecte la levée et 
lance le prochain trial.

E N  B R E F

Reprend un run en pause.
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W34 Bouton « Save Best Config »

O Ù

Toolbar droite (disabled si pas de bestTrial).

T E C H N I Q U E

Dialogue avec nom par défaut 
bayesopt-best.json . Construit payload : préré

glage, index, valeur, paramètres décodés.

E N  B R E F

Enregistre les valeurs du meilleur 
trial en JSON. Reprenez ces va­
leurs manuellement dans votre 
préréglage.

W35 Sélecteur de préréglage « Search Space »

O Ù

Sidebar gauche, en haut.

T E C H N I Q U E

Quatre options : « RadianceKit defaults (6-dim) », « 
Mip subset (2-dim) », « densify-until + ssim-weight 
+ grad-thresh », « Bowl demo (1-dim) ». Pendant 
un run, non modifiable.

E N  B R E F

Quel search-space BayesOpt ex­
plore. Standard « RadianceKit 
defaults ». Pour Mip ciblé « 
Mip subset ». Pour comprendre 
BayesOpt « Bowl demo ».

W36 Slider « Trial Budget »

O Ù

Sidebar gauche, sous Search-Space.

T E C H N I Q U E

Slider 10 à 200, pas 5. Défaut 40. Règle : dimension 
d → 10d à 20d trials.

E N  B R E F

Combien d’essais max. Plus = 
mieux mais plus long.

W37 Slider « Random Seed »

O Ù

Sidebar gauche, sous budget.

T E C H N I Q U E

Slider 1 à 100, pas 1. Défaut 42. Seed pour LHS et 
noise. Même seed + même search-space + même 
budget = séquence identique.

E N  B R E F

Contrôle le générateur aléatoire. 
Même seed = même run.
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W38 Chart (Convergence)

O Ù

Colonne centrale.

T E C H N I Q U E

Swift-Charts avec deux couches : ligne « best-so-
far » monotone, un point par trial coloré par phase. 
Légende en haut à gauche.

E N  B R E F

Chart d’évolution. Ligne conti­
nue = meilleur trouvé. Plate long­
temps = optimum trouvé.

W39 Tableau (Trial Log)

O Ù

Colonne droite.

T E C H N I Q U E

Zone défilante avec lignes trial. Par ligne : numéro 
monospaced, valeur, tag de phase, étoile jaune si 
meilleur. Auto-scroll vers la fin.

E N  B R E F

Tableau de tous les essais. Défile 
auto avec nouveaux trials.

Fenêtre principale : courbe de loss et Gaussian Count (I39–I41, 
renvoi)

Trois affichages de l’inspecteur méritent une explication propre, parce qu’ils sont 
visibles pendant un entraînement et qu’il y a des règles empiriques pour juger d’un 
déroulé sain.

Quand la courbe est saine ? Trois phases : (1) Warmup — les 200–500 premières ité
rations, le loss tombe de ~0.15–0.25 à environ la moitié. (2) Densification — entre ~500 
et densifyUntilIteration, le loss continue à descendre. Le compteur de gaussiennes 
augmente. (3) Refinement — ensuite, queue de plus en plus plate. Valeurs finales 
typiques : Tanks-&-Temples Truck P4 Quality → L1 ≈ 0.023 ; outdoor Mip-NeRF360 
souvent 0.04–0.07.

Que signifie un plateau ? Deux interprétations : (a) convergé, plus rien à faire ; (b) 
bloqué (minimum local, cap au buffer-limit). Distinction : regardez le compteur de gaus
siennes. Plat ET proche du cap MCMC = limite. Compteur qui croît mais loss qui ne 
descend pas = bloqué.

Quand abandonner ? Règle : 10K itérations sans amélioration du Min-Loss → arrêter.

Le plateau Gaussian Count n’est PAS un signal « fini ». Il signifie seulement que 
MCMC a atteint le cap ou que la densification Classic est épuisée. La vraie question 
« fini » n’est posée que par l’analyse holdout — PSNR/SSIM/LPIPS sur un test-set indé
pendant.
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PSNR/Holdout est la vérité, le loss n’est qu’un proxy. Un loss bas ne signifie pas un 
bon modèle — overfitting. Pour la qualité finale, regardez les métriques holdout.

Règles empiriques

• User Guide et Keyboard Shortcuts : aide statique. Pour la profondeur, utilisez ce 
manuel.

• Manage Storage à ouvrir dès que le disque tombe sous 10 %.
• Pareto Dashboard utile à partir de 3-4 rapports. X = coûts, Y = qualité.
• Holdout Analysis : avant de publier des benchmarks PSNR.
• BayesOpt Console : surtout pour comprendre. Vrais tunings → CLI offline.
• Plateau de loss et plateau de gaussiennes à interpréter séparément. La vraie qualité = 

PSNR holdout.
• 10K itérations sans amélioration → arrêter.
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C H A P I T R E

Chapitre 6 — Configuration 
d’entraînement

Figure 26. –  Préréglage Preview exporté en JSON dans TextEdit — champs id/name/catego
ry/version/createdAt/description, trainingConfig avec tous les paramètres pertinents

CE QUE MONTRE L’IMAGE  Un export JSON typique de préréglage. Champs top-level : id  
(UUID), name , category , version, timestamp, description. L’objet imbriqué contient 
les paramètres critiques pour la reproductibilité. Au moment de l’import, tout le bloc 
est désérialisé dans la structure TrainingConfig  et les défauts de la version d’app 
remplissent les champs manquants.

La structure TrainingConfig  est le cœur de chaque exécution d’entraînement dans 
RadianceKit. Elle réunit chaque paramètre qui influence l’entraînement — du nombre 
maximum d’itérations aux huit learning rates en passant par les champs spéciaux pour 
MCMC, Mip-Splatting, le curriculum et la logique de cap scene-aware. Vous la modifiez 
dans la sidebar (Expert View), l’enregistrez comme préréglage ou la transmettez en 
JSON.
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Ce chapitre est du matériel de référence pour utilisateurs avancés et auteurs de scripts. 
Il liste les 81 champs publics, les 9 préréglages statiques et la méthode publique 
unique. Le fichier source est TrainingConfig.swift — en cas de doute, le doc comment 
qui s’y trouve et le défaut de l’initializer font foi.

R E M A R Q U E  ·  U I  V S  P R É R É G L AG E / C L I

Seuls 12 des 81 champs ont un curseur, toggle ou sélecteur direct dans 
l’inspecteur (build App Store sandboxed) : T1, T2, T17, T20, T22, T38, T56–T58, 
T60, T61, T73. Les 69 autres champs sont fixés via le préréglage (chapitre 7) et 
ne peuvent être écrasés directement que par CLI (chapitre 5). Cette séparation 
est voulue : les défauts restent stables et éprouvés en production, les utilisateurs 
avancés disposent cependant d’une issue de secours.

Sommaire :

1. Itération (T1–T2)
2. Learning Rates (T3–T10)
3. Densification — Classic (T11–T16)
4. Loss (T17–T20)
5. Progression du degré SH (T21)
6. Performance (T22–T25)
7. Diagnostic et préparation du nuage de points (T26–T30)
8. Régularisation (T31–T37)
9. Refinement (T38–T44)

10. Sky Dome (T45–T48)
11. Adam + LR Schedule (T49–T55)
12. Post-traitement + Apple AI (T56–T60)
13. MCMC Densification (T61–T73)
14. Mip-Splatting (Q1.5) (T74–T76)
15. Densification adaptative (Q5) (T77–T79)
16. Curriculum (Q6) (T80–T81)
17. Préréglages statiques (TP1–TP9)
18. Méthode : resolveMcmcMaxGaussians
19. Quel champ pour quoi ? (Cheat-sheet)
20. Champs dangereux
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Itération (T1–T2)

T1 maxIterations

D É TA I L S

Défaut : 30 000 ; 35 000 ( .full ) ; 200 000 
( .fullMCMC ). Plage : 1 000 – 500 000.

T E C H N I Q U E

Nombre total d’itérations d’entraînement. Une itéra
tion = forward render d’une caméra training, back
ward pass sur toutes les composantes de loss et 
step Adam. Affecte directement les autres sche
dules. Sweet spot empirique : Classic 20K–35K, 
MCMC 60K–200K.

E N  B R E F

Combien de temps l’app calcule. 
Plus d’itérations = meilleur ré­
sultat, mais au-delà d’un seuil, 
l’amélioration plafonne et le 
temps grimpe beaucoup. Les 
préréglages sont calibrés : Quick 
1 000, Preview 5 000, Balanced 
20 000, Quality 35 000, MCMC 
Quality 200 000.

T2 densifyUntilIteration

D É TA I L S

Défaut : 15 000 ; 5 000 ( .full ) ; 160 000 
( .fullMCMC ).

T E C H N I Q U E

Index d’itération à partir duquel la densifica
tion s’arrête (clone/split en Classic, relocation en 
MCMC). Trop haut épuise le buffer GPU, trop bas 
limite le détail final. Lié à T1 via le bouton Link de 
l’inspecteur (ratio typique 0.5).

E N  B R E F

Jusqu’à quelle itération de nou­
veaux gaussiens sont créés. 
Après, seules position et couleur 
s’affinent. Couplé à Max Itera­
tions via le bouton Link.

Learning Rates (T3–T10)

T3 positionLearningRate

D É TA I L S

Défaut : 1.6e-4.

T E C H N I Q U E

LR initial pour les positions des gaussiens. Décroît 
exponentiellement vers positionLearningRateFinal 
(T4) sur une courbe cosinus.

E N  B R E F

À quelle vitesse les positions des 
points 3D s’ajustent au début. 
Trop haut = explosion ; trop bas = 
convergence lente.
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T4 positionLearningRateFinal

D É TA I L S

Défaut : 1.6e-6.

T E C H N I Q U E

Valeur finale du schedule de LR position.

E N  B R E F

Où la LR position atterrit en fin 
d’entraînement. Petit pour fixer 
les positions.

T5 shDCLearningRate

D É TA I L S

Défaut : 2.5e-3.

T E C H N I Q U E

LR pour le coefficient DC des spherical harmonics 
— la couleur de base par gaussien.

E N  B R E F

Vitesse d’apprentissage de la 
couleur de base.

T6 shRestLearningRate

D É TA I L S

Défaut : 1.25e-4.

T E C H N I Q U E

LR pour les coefficients SH supérieurs (bands 1–3) 
— réflexions dépendantes de la direction.

E N  B R E F

Vitesse d’apprentissage des co­
efficients de couleur qui gèrent 
les reflets.

T7 opacityLearningRate

D É TA I L S

Défaut : 0.05.

T E C H N I Q U E

LR pour l’opacité (avant sigmoïde). Affecte la rapidi
té avec laquelle les gaussiens deviennent visibles 
ou invisibles.

E N  B R E F

Vitesse à laquelle les points ap­
paraissent ou disparaissent.

T8 opacityLearningRateFinal

D É TA I L S

Défaut : 0.05 (pas de decay par défaut).

T E C H N I Q U E

Valeur finale de la LR opacité.

E N  B R E F

LR finale pour l’opacité.
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T9 scaleLearningRate

D É TA I L S

Défaut : 5e-3.

T E C H N I Q U E

LR pour les trois échelles par gaussien (log-space).

E N  B R E F

Vitesse d’apprentissage de la 
taille des points.

T10 rotationLearningRate

D É TA I L S

Défaut : 1e-3.

T E C H N I Q U E

LR pour le quaternion de rotation.

E N  B R E F

Vitesse d’apprentissage de 
l’orientation des points gaus­
siens.

Densification — Classic (T11–T16)

T11 densifyGradThreshold

D É TA I L S

Défaut : 2.0e-6. Doit matcher T22 : 1.0× → 1e-6, 
0.5× → 2e-6, 0.25× → 4e-6. Champ dangereux.

T E C H N I Q U E

Seuil de gradient pour le clone/split en Classic. Plus 
bas = plus de densification = plus de gaussiens. 
Une division par deux peut produire 2 à 4× plus de 
gaussiens et saturer le GPU.

E N  B R E F

Seuil sensible : déclenche la 
création de nouveaux points. 
Baisser = plus de détail mais 
risque OOM. Doit correspondre à 
Render Scale.

T12 densifyFromIteration

D É TA I L S

Défaut : 500.

T E C H N I Q U E

Itération de démarrage de la densification.

E N  B R E F

À partir de quand commencer à 
ajouter des gaussiens.
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T13 densifyInterval

D É TA I L S

Défaut : 100.

T E C H N I Q U E

Intervalle entre les passes de densification (en ité
rations).

E N  B R E F

Combien d’itérations entre deux 
vagues de densification.

T14 pruneOpacityThreshold

D É TA I L S

Défaut : 0.005.

T E C H N I Q U E

Seuil d’opacité en dessous duquel un gaussien est 
prunné pendant la densification.

E N  B R E F

À quelle opacité minimale un 
point est éliminé.

T15 opacityResetInterval

D É TA I L S

Défaut : 3 000 ; 100 000 dans .preview  (≈ désac
tivé). Champ dangereux pour les entraînements 
courts.

T E C H N I Q U E

Toutes les N itérations, l’opacité de tous les gaus
siens est ramenée à une valeur basse. Force le 
système à réapprendre la visibilité. Sur les courts 
entraînements, peut détruire la convergence.

E N  B R E F

Remet l’opacité à zéro toutes les 
N itérations pour forcer un réap­
prentissage. À éviter si entraîne­
ment court.

T16 maxScreenSize

D É TA I L S

Défaut : 20.

T E C H N I Q U E

Taille screen-space maximale en pixels au-dessus 
de laquelle un gaussien est forcé à se split.

E N  B R E F

Si un point devient trop gros à 
l’écran, on le divise.
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Loss (T17–T20)

T17 ssimWeight

D É TA I L S

Défaut : 0.20. Plage : 0.0 – 1.0.

T E C H N I Q U E

Mélange L1/SSIM. 0.0 = uniquement L1, 1.0 = uni
quement SSIM. Défaut 0.2 du papier 3DGS original.

E N  B R E F

Combien de poids à la similari­
té structurelle vs luminosité par 
pixel. 0.2 est le défaut robuste.

T18 ssimWeightRefinement

D É TA I L S

Défaut : 0.20.

T E C H N I Q U E

Poids SSIM pendant la phase refinement (après 
densification).

E N  B R E F

Poids SSIM dans la phase finale 
d’affinage.

T19 edgeLossWeight

D É TA I L S

Défaut : 0.0.

T E C H N I Q U E

Poids d’un terme de loss supplémentaire sur les 
arêtes détectées via Sobel.

E N  B R E F

Si > 0, force le modèle à mieux 
préserver les contours.

T20 skyMaskingEnabled

D É TA I L S

Défaut : false.

T E C H N I Q U E

Active le sky masking pré-entraînement basé sur 
Apple Vision. Voir S7 au chapitre 3.

E N  B R E F

Active la détection du ciel pour 
réduire les floaters en outdoor.
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Progression du degré SH (T21)

T21 shDegreeUpgradeIterations

D É TA I L S

Défaut : [1000, 2000, 3000] .

T E C H N I Q U E

Aux trois itérations marquées, le degré SH aug
mente de 1 (jusqu’à 3 max). Plus tôt = couleurs 
riches plus vite mais moins stable.

E N  B R E F

Trois itérations où la complexi­
té couleur grimpe. Plus tard = 
couleurs simples plus longtemps 
mais entraînement stable.

Performance (T22–T25)

T22 trainingRenderScale

D É TA I L S

Défaut : 1.0. Plage : 0.25–1.0.

T E C H N I Q U E

Mise à l’échelle de la résolution de rendu pendant 
l’entraînement. 0.5 économise environ 75 % de 
temps GPU. Doit matcher T11.

E N  B R E F

Plus c’est petit, plus c’est rapide 
mais moins détaillé. 0.5 est un 
bon compromis pour la plupart 
des sources.

T23 resolutionWarmupScale

D É TA I L S

Défaut : 0.5.

T E C H N I Q U E

Échelle utilisée pendant la phase de warmup initial.

E N  B R E F

Résolution réduite pour le dé­
marrage rapide.

T24 tileSize

D É TA I L S

Défaut : 16.

T E C H N I Q U E

Taille des tiles GPU pour le rendering pipeline. 
16×16 est le sweet spot Apple Silicon.

E N  B R E F

Paramètre GPU bas niveau, à ne 
pas toucher.
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T25 throttleDelayMs

D É TA I L S

Défaut : 0.

T E C H N I Q U E

Délai artificiel entre itérations (0, 2, 5, 10 ms). Ra
lentit le GPU pour garder le système réactif.

E N  B R E F

Frein pour ne pas chauffer le Mac 
sur les longs entraînements.

Diagnostic et préparation du nuage de points (T26–T30)

T26 depthDistortionWeight

D É TA I L S

Défaut : 0.0.

T E C H N I Q U E

Poids d’un terme de régularisation de distorsion de 
profondeur.

E N  B R E F

Régularisation expérimentale, 
défaut à 0.

T27 singleViewOverfit

D É TA I L S

Défaut : false.

T E C H N I Q U E

Mode debug : entraîne sur une seule vue pour over
fitting.

E N  B R E F

Outil de debug seulement.

T28 maxCameras

D É TA I L S

Défaut : 0 (illimité).

T E C H N I Q U E

Limite supérieure du nombre de caméras utilisées si 
> 0.

E N  B R E F

Limite le nombre d’images pour 
des tests rapides.
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T29 maxInitialPoints

D É TA I L S

Défaut : 0 (illimité).

T E C H N I Q U E

Limite supérieure du nombre de points SfM utilisés 
pour l’initialisation.

E N  B R E F

Limite la taille du nuage de 
points initial.

T30 cameraClusterOutlierMultiplier

D É TA I L S

Défaut : 3.0.

T E C H N I Q U E

Multiplicateur de variance pour détecter des camé
ras outliers par clustering.

E N  B R E F

Filtre des caméras aberrantes 
après SfM.

Régularisation (T31–T37)

T31 coarseToFineBlurRadius

D É TA I L S

Défaut : 0.

T E C H N I Q U E

Rayon de blur appliqué pour le coarse-to-fine lear
ning.

E N  B R E F

Régularisation expérimentale.

T32 scaleRegWeight

D É TA I L S

Défaut : 0.0.

T E C H N I Q U E

Poids d’une régularisation sur les échelles des 
gaussiens (pénalité scale).

E N  B R E F

Évite des points trop grands.
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T33 anisotropyRegWeight

D É TA I L S

Défaut : 0.0.

T E C H N I Q U E

Poids de la pénalité d’anisotropie. Pénalise les 
gaussiens trop allongés (rapport scale max/min > 
seuil).

E N  B R E F

Évite les points en forme 
d’aiguille (floaters typiques out­
door).

T34 scaleRatioPruneThreshold

D É TA I L S

Défaut : 10.0.

T E C H N I Q U E

Si rapport scale max/min > seuil, gaussien candidat 
à prune.

E N  B R E F

Seuil au-delà duquel un gaussien 
aiguille est éliminé.

T35 opacityRegWeight

D É TA I L S

Défaut : 0.0.

T E C H N I Q U E

Poids de la régularisation L1 sur les opacités.

E N  B R E F

Pousse vers des opacités plus 
petites en moyenne.

T36 opacityDecayFactor

D É TA I L S

Défaut : 1.0 (pas de decay).

T E C H N I Q U E

Facteur multiplicatif de decay sur l’opacité après 
chaque cycle de densify. V546 HTGS Eurographics 
2025.

E N  B R E F

Réduit progressivement l’opacité 
des gaussiens inactifs.
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T37 opacityDecayInterval

D É TA I L S

Défaut : 0.

T E C H N I Q U E

Intervalle entre deux passes d’opacity decay.

E N  B R E F

Période entre deux applications 
du decay.

Refinement (T38–T44)

T38 gradientAccumulationSteps

D É TA I L S

Défaut : 1 ; 2 si MCMC Quality.

T E C H N I Q U E

Accumule les gradients sur N vues avant le step. 
Améliore L1 d’environ 6 % en MCMC au prix d’un 
temps doublé.

E N  B R E F

Mode Quality : meilleure préci­
sion, temps doublé.

T39 testViewIndices

D É TA I L S

Défaut : [] . Champ dangereux.

T E C H N I Q U E

Indices de caméras à exclure de l’entraînement 
comme test-holdout. Laisser le flag --benchmark  
gérer cela.

E N  B R E F

Définit le test-set pour bench­
marks. Ne pas toucher manuelle­
ment.

T40 refinementPruneInterval

D É TA I L S

Défaut : 0.

T E C H N I Q U E

Intervalle de pruning pendant la phase refinement.

E N  B R E F

Quand pruner en phase finale.
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T41 refinementPruneOpacityThreshold

D É TA I L S

Défaut : 0.005.

T E C H N I Q U E

Seuil d’opacité pour le pruning en phase refinement.

E N  B R E F

Seuil de visibilité minimum en 
phase finale.

T42 midTrainingCompactificationIterations

D É TA I L S

Défaut : [] .

T E C H N I Q U E

Liste d’itérations où une compactification intermé
diaire est exécutée (par ex. 20K et 30K pour S8).

E N  B R E F

Itérations où on fait le ménage 
en cours d’entraînement.

T43 frustumCullEnabled

D É TA I L S

Défaut : false.

T E C H N I Q U E

Active le frustum culling : élimine les gaussiens hors 
de toutes les frustums caméra.

E N  B R E F

Supprime les points qu’aucune 
caméra ne voit.

T44 frustumCullExpansion

D É TA I L S

Défaut : 1.1.

T E C H N I Q U E

Facteur d’expansion des frustums caméra avant 
culling.

E N  B R E F

Marge de sécurité pour le frus­
tum culling.
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Sky Dome (T45–T48)

T45 skyDomeEnabled

D É TA I L S

Défaut : false.

T E C H N I Q U E

Active la reconstruction d’un sky dome via projec
tion sphérique des pixels de ciel. Voir S10.

E N  B R E F

Reconstitue un vrai ciel autour 
des scènes outdoor.

T46 skyDomeSampleCount

D É TA I L S

Défaut : 5 000.

T E C H N I Q U E

Nombre de gaussiens initialisés sur le sky dome.

E N  B R E F

Combien de points pour recons­
tituer le ciel.

T47 skyDomeRadiusMultiplier

D É TA I L S

Défaut : 8.0. P9 Outdoor utilise 59.0.

T E C H N I Q U E

Multiplicateur du rayon de scène pour la sphère du 
dome.

E N  B R E F

Taille du dôme céleste — plus 
grand = ciel plus lointain.

T48 frozenGaussianCount

D É TA I L S

Défaut : 0.

T E C H N I Q U E

Nombre des N premiers gaussiens à geler (pas 
d’optimisation). Préparé pour V1 mais pas active
ment utilisé.

E N  B R E F

Paramètre interne, généralement 
0.
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Adam + LR Schedule (T49–T55)

T49 adamResetIteration

D É TA I L S

Défaut : 0.

T E C H N I Q U E

Itération où les moments Adam sont remis à zéro.

E N  B R E F

Reset des moments d’optimiseur, 
utilisé rarement.

T50 positionLRScheduleEndIteration

D É TA I L S

Défaut : 0 (= utilise T1).

T E C H N I Q U E

Itération où le schedule de LR position atteint sa 
valeur finale.

E N  B R E F

Où la LR position arrive à sa va­
leur finale.

T51 extendedPhaseLRDecay

D É TA I L S

Défaut : false.

T E C H N I Q U E

Active une phase prolongée de decay LR après den
sifyUntilIteration.

E N  B R E F

Schedule de decay supplémen­
taire en fin d’entraînement.

T52 adaptiveDensifyThreshold

D É TA I L S

Défaut : 0.

T E C H N I Q U E

Seuil pour ajuster densifyGradThreshold en cours 
d’entraînement.

E N  B R E F

Réglage dynamique du seuil de 
densification.
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T53 mergeAfterDensification

D É TA I L S

Défaut : false.

T E C H N I Q U E

Active une fusion de gaussiens proches après den
sification.

E N  B R E F

Optimisation expérimentale.

T54 densifyPhase2FromIteration

D É TA I L S

Défaut : 0. Champ dangereux.

T E C H N I Q U E

Démarrage d’une seconde phase de densification. 
Two-phase densification a échoué en tests (cas
cade vers 0 gaussiens). Laisser à 0.

E N  B R E F

Expérimental, ne pas activer.

T55 densifyPhase2UntilIteration

D É TA I L S

Défaut : 0. Champ dangereux.

T E C H N I Q U E

Fin de la phase 2 de densification. Voir T54.

E N  B R E F

Expérimental, laisser à 0.

Post-traitement + Apple AI (T56–T60)

T56 postTrainingCompactification

D É TA I L S

Défaut : true.

T E C H N I Q U E

Active la compactification V443 après 
l’entraînement : supprime les gaussiens d’opacité < 
0.01. Réduit la taille de fichier d’environ 55-58 %.

E N  B R E F

Fait le ménage final. À laisser 
toujours actif.
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T57 metalFXUpscaling

D É TA I L S

Défaut : true.

T E C H N I Q U E

Active MetalFX dans le renderer viewport (voir I27).

E N  B R E F

Affine l’image live dans le view­
port.

T58 mpsLanczosScaling

D É TA I L S

Défaut : false.

T E C H N I Q U E

Active MPS Lanczos comme upscaler viewport. 
Ignoré si MetalFX (T57) actif.

E N  B R E F

Fallback à l’upscaling classique.

T59 livePreviewInterval

D É TA I L S

Défaut : 0 (off).

T E C H N I Q U E

Intervalle d’itérations entre snapshots du viewport 
en direct (0, 50, 250, 1000).

E N  B R E F

À quelle fréquence le view­
port se rafraîchit pendant 
l’entraînement.

T60 perceptualLossWeight

D É TA I L S

Défaut : 0.0.

T E C H N I Q U E

Poids de la perceptual loss (V460). 0.05-0.1 amé
liore le L1 ; > 0.15 rend l’entraînement instable.

E N  B R E F

Aide sur les structures fines 
(cheveux, feuillage). 0.05-0.1 
sweet spot.
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MCMC Densification (T61–T73)

T61 densificationStrategy

D É TA I L S

Défaut : .classic . Options : .classic , .mcmc .

T E C H N I Q U E

Stratégie de densification. MCMC = Stochastic Gra
dient Langevin Dynamics + relocation (NeurIPS 
2024).

E N  B R E F

Choix entre l’algorithme clas­
sique 3DGS ou le plus récent 
MCMC.

T62 mcmcMaxGaussians

D É TA I L S

Défaut : 150 000. Mass-extinction floor à 150 000 
si 0.

T E C H N I Q U E

Cap maximal de gaussiens en mode MCMC. Voir 
resolveMcmcMaxGaussians.

E N  B R E F

Nombre max de points en MCMC. 
Plus haut = plus de détail mais 
plus de mémoire GPU.

T63 mcmcNoiseScale

D É TA I L S

Défaut : 5e-5.

T E C H N I Q U E

Échelle du bruit gaussien ajouté à chaque étape 
Langevin.

E N  B R E F

Combien de bruit aléatoire dans 
l’optimisation MCMC.

T64 mcmcOpacityRegWeight

D É TA I L S

Défaut : 0.0. Champ dangereux.

T E C H N I Q U E

Régularisation MCMC opacité. Mis à 0.01 en 1.4.3 → 
mass-extinction (460K → 5 gaussiens). Depuis 1.4.4 
fixé à 0.0.

E N  B R E F

Ne pas toucher, peut provoquer 
un effondrement.
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T65 mcmcScaleRegWeight

D É TA I L S

Défaut : 0.0. Champ dangereux.

T E C H N I Q U E

Régularisation MCMC scale. Même histoire que T64.

E N  B R E F

Ne pas toucher.

T66 mcmcRelocationInterval

D É TA I L S

Défaut : 100.

T E C H N I Q U E

Intervalle entre les passes de relocation des gaus
siens morts.

E N  B R E F

Fréquence de redistribution des 
points morts en MCMC.

T67 mcmcWarmupIterations

D É TA I L S

Défaut : 500.

T E C H N I Q U E

Itérations de warmup avant la première relocation.

E N  B R E F

Délai initial avant que la reloca­
tion démarre.

T68 mcmcDeadOpacityThreshold

D É TA I L S

Défaut : 0.01.

T E C H N I Q U E

Opacité en dessous de laquelle un gaussien est 
considéré mort pour la relocation.

E N  B R E F

Seuil pour identifier les points à 
recycler.

T69 mcmcNoiseDecayEnd

D É TA I L S

Défaut : 160 000 (80 % de 200K iters).

T E C H N I Q U E

Itération où le decay du bruit MCMC se termine.

E N  B R E F

Où le bruit MCMC s’estompe.
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T70 mcmcGrowthRate

D É TA I L S

Défaut : 1.0.

T E C H N I Q U E

Taux de croissance des nouveaux gaussiens via re
location par itération.

E N  B R E F

Vitesse de croissance MCMC.

T71 mcmcSigmoidK

D É TA I L S

Défaut : 100.0.

T E C H N I Q U E

Paramètre k du sigmoïde de sampling des profon
deurs.

E N  B R E F

Forme de la fonction 
d’échantillonnage MCMC.

T72 mcmcCapMultiplier

D É TA I L S

Défaut : 3.0. P9 Outdoor 5.32. Champ dangereux.

T E C H N I Q U E

Multiplicateur appliqué au nombre de points SfM 
pour calculer le cap effectif si auto-scale actif. Mul
tiplier > 5 sur grandes scènes peut produire des 
millions de gaussiens (OOM).

E N  B R E F

Multiplie le nombre de points 
SfM pour fixer le cap. Attention à 
grand multiplier × grande scène.

T73 mcmcAutoScaleByScene

D É TA I L S

Défaut : true dans les built-ins MCMC, false 
ailleurs.

T E C H N I Q U E

Si actif, scale T62 par T72 × nombre de points SfM.

E N  B R E F

Adapte automatiquement le cap 
à la taille de scène.

Mip-Splatting (Q1.5) (T74–T76)

Phase Q1.5 « closed no-win » 2026-05-25. Mip-Splatting reste opt-in, défaut OFF. 
Détails dans le verdict docs/​plans/​2026-05-25-phase-q1.5-final-verdict.md.
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T74 useMipSplatting

D É TA I L S

Défaut : false. Champ dangereux.

T E C H N I Q U E

Active le pipeline Mip-Splatting (3D smoothing + 2D 
filtre). Sur certaines scènes outdoor, dégrade même 
le PSNR.

E N  B R E F

Désactivé par défaut, ne pas ac­
tiver sauf pour recherche.

T75 mipSmoothing3DScale

D É TA I L S

Défaut : 0.1.

T E C H N I Q U E

Échelle du smoothing 3D pré-filter.

E N  B R E F

Paramètre Mip-Splatting expéri­
mental.

T76 mipFilter2DVariance

D É TA I L S

Défaut : 0.3.

T E C H N I Q U E

Variance du filtre 2D post-Mip.

E N  B R E F

Paramètre Mip-Splatting expéri­
mental.

Densification adaptative (Q5) (T77–T79)

Phase Q5 SHIPPED opt-in 2026-05-25 ; seule, FAIL (0/3) ; en bundle avec Q6, gate 
PASS (1/3). Verdict docs/​plans/​2026-05-27-phase-q5q6.md.

T77 adaptiveDensification

D É TA I L S

Défaut : false.

T E C H N I Q U E

Active une logique de densification adaptative qui 
ajuste le seuil de gradient en fonction de la conver
gence locale.

E N  B R E F

Densification plus intelligente, 
opt-in.
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T78 adaptiveWindow

D É TA I L S

Défaut : 500.

T E C H N I Q U E

Fenêtre d’itérations pour l’évaluation adaptative.

E N  B R E F

Période sur laquelle on observe 
la convergence.

T79 adaptiveDensifyMultiplier

D É TA I L S

Défaut : 1.5.

T E C H N I Q U E

Multiplicateur du seuil de gradient si convergence 
stable.

E N  B R E F

Combien le seuil est relâché en 
mode adaptatif.

Curriculum (Q6) (T80–T81)

Phase Q6 gate PASS 2/3 2026-05-25 (bundle avec Q5). Q6 est porteur du gate-pass.

T80 curriculumResolutionRamp

D É TA I L S

Défaut : false.

T E C H N I Q U E

Active une montée progressive de la résolution 
d’entraînement (curriculum learning).

E N  B R E F

Démarre en basse résolution et 
augmente progressivement.

T81 curriculumSHProgression

D É TA I L S

Défaut : false.

T E C H N I Q U E

Active une progression curriculum des coefficients 
SH (plus lente que T21).

E N  B R E F

Augmentation progressive de la 
complexité couleur.
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Préréglages statiques (TP1–TP9)

Neuf préréglages livrés dans TrainingConfig.swift comme static let . Les préré
glages utilisateur du chapitre 7 sont construits sur ces bases.

TP1 .preview

D É TA I L S

maxIterations 5 000, densifyUntilIteration 3 500, 
ssimWeight 0.20, renderScale 0.50.

T E C H N I Q U E

Préréglage rapide pour l’aperçu. Lié à P2 Preview du 
chapitre 7.

E N  B R E F

Lecture rapide pour voir si la 
scène est reconstructible.

TP2 .full

D É TA I L S

maxIterations 35 000, densifyUntilIteration 5 000, 
opacityDecayFactor < 1.

T E C H N I Q U E

Préréglage Classic Quality avec opacity decay V546 
HTGS.

E N  B R E F

Le meilleur classique — lié à P4 
Quality.

TP3 .fullClassicPaper

D É TA I L S

maxIterations 30 000.

T E C H N I Q U E

Préréglage du papier 3DGS original (Kerbl 2023) 
sans améliorations RadianceKit.

E N  B R E F

Réplique du papier original, à des 
fins de benchmarking.

TP4 .fullMCMC

D É TA I L S

maxIterations 200 000, mcmcMaxGaussians 150 
000, ssimWeight 0.05.

T E C H N I Q U E

Préréglage MCMC Quality complet. Lié à P7.

E N  B R E F

La meilleure variante MCMC.
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TP5 .fullMCMCMip

D É TA I L S

Comme TP4 plus useMipSplatting = true.

T E C H N I Q U E

Variante avec Mip-Splatting activé. Pour recherche 
seulement (Q1.5 closed no-win).

E N  B R E F

Variante recherche avec Mip-
Splatting actif.

TP6 .classicBalanced

D É TA I L S

maxIterations 20 000, ssimWeight 0.20.

T E C H N I Q U E

Lié à P3 Balanced — sweet spot Classic.

E N  B R E F

Bon compromis qualité/temps en 
classique.

TP7 .mcmcPreview

D É TA I L S

maxIterations 60 000, mcmcMaxGaussians 100 
000.

T E C H N I Q U E

Aperçu MCMC. Lié à P5.

E N  B R E F

Aperçu MCMC.

TP8 .mcmcBalanced

D É TA I L S

maxIterations 120 000, mcmcMaxGaussians 150 
000.

T E C H N I Q U E

Palier intermédiaire MCMC. Lié à P6.

E N  B R E F

Compromis MCMC.

TP9 .quickTest

D É TA I L S

maxIterations 1 000, renderScale 0.25.

T E C H N I Q U E

Préréglage diagnostic 30 s. Lié à P1 Quick.

E N  B R E F

Test express, 30 secondes.
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Méthode : resolveMcmcMaxGaussians

Signature : public func resolveMcmcMaxGaussians(initialPointCount: Int, 
bufferCapacity: Int) -> Int

TECHNIQUE  Source de vérité unique pour « quel est le cap de croissance MCMC effectif 
». Logique :

1. base = T62 > 0 ? T62 : 150_​000 (le mass-extinction floor protège contre les bugs 
d’init type incident 1.4.3)

2. Si T73 mcmcAutoScaleByScene && initialPointCount > 0 &&
 T72 mcmcCapMultiplier > 0 :
• scaled = max(base, ceil(initialPointCount × T72)) sinon

scaled = base

3. Si bufferCapacity > 0  : return min(scaled, bufferCapacity)
4. Sinon return scaled

Exemple : Bicycle (Mip-NeRF 360, 194 images) → init SfM ~156K points, 
T62 = 150 000 , T72 = 5.32 , buffer 8M. Cap résolu = min(8M, max(150K, ceil(156K 
× 5.32))) = min(8M, 830K) = 830K.

EN BREF  Calcule le vrai nombre maximum de splats en MCMC. Prend votre réglage, 
regarde combien de points votre scène a au début, et met à l’échelle avec le multiplier 
si l’auto-scale est activé. Cela adapte le cap à la scène. Vous n’avez pas à appeler la 
méthode — l’entraînement l’utilise en interne.
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Quel champ pour quoi ? (Cheat-sheet)

Objectif Champs à régler

Plus de détail au 
loin

T62 mcmcMaxGaussians haut, T72 mcmcCapMultiplier 5+

Plus de détail gé
néral (Classic)

T1 maxIterations  haut (≤ 40K), T2 densifyUntilIteration ≤ 
14 % de T1

Réduire les floa
ters en drone

T43 frustumCullEnabled on, T20 skyMaskingEnabled on, 
T45 skyDomeEnabled  on

Beau ciel outdoor T45 skyDomeEnabled  on, T47 skyDomeRadiusMultiplier 30–60

Fichier export plus 
petit

Stratégie .mcmc  (T61), T56 postTrainingCompactification on, 
T62 mcmcMaxGaussians ≤ 200K

Entraînement plus 
rapide

T22 trainingRenderScale 0.5, T1 maxIterations  divisé par 
deux — mais pas les deux !

Meilleures hautes 
lumières

T21 shDegreeUpgradeIterations avec [2K, 5K, 8K] , MCMC + 
200K iter

Garder le Mac ré
actif

T25 throttleDelayMs 5–10 (coûte ~15 % de temps)

Live preview plus 
fréquente

T59 livePreviewInterval à 10–20

Transitions plus 
douces dans les 

ombres

T17 ssimWeight  légèrement haut (0.15–0.25), pas au-dessus de 
0.3

Intérieurs com
pacts

Préréglage P10 Indoor ( T72 = 1.76 )

Champs dangereux

Ces champs peuvent provoquer OOM, crash, mass-extinction des gaussiens ou des 
benchmarks inutilisables. À manipuler avec précaution :

• T11 densifyGradThreshold — une division par deux peut produire 2 à 4× plus de 
gaussiens et saturer le GPU. Doit correspondre à T22 trainingRenderScale (1.0× → 
1e-6, 0.5× → 2e-6, 0.25× → 4e-6).

• T72 mcmcCapMultiplier — sur grandes scènes avec > 200K points SfM init et multi
plier > 5, le cap résolu atteint plusieurs millions de gaussiens. OOM possible sur Macs 
36 Go. P9 Outdoor 5.32 ne fonctionne que parce que bicycle a 156K points init → cap 
830K.

• T39 testViewIndices — mise manuelle peut rendre les benchmarks inutilisables. Lais
ser le flag --benchmark  le régler.
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• T64 mcmcOpacityRegWeight et T65 mcmcScaleRegWeight — mis à 0.01 en bêta 1.4.3 
→ mass-extinction (460K → 5 gaussiens en une itération). Fixés à 0.0 depuis 1.4.4 ; 
l’augmentation manuelle peut reproduire le problème.

• T15 opacityResetInterval — s’il n’est pas à 100 000+ (effectivement off) et 
l’entraînement < 10 000 itérations, le reset détruit la convergence. .preview  est 
donc à 100 000 malgré maxIterations = 5 000.

• T54/​T55 densifyPhase2* — two-phase densification a échoué en tests (cascade vers 
0 gaussiens). Laisser à 0.

• T74 useMipSplatting — Q1.5 closed no-win 2026-05-25, peut même dégrader le 
PSNR sur certaines scènes outdoor. Défaut off, opt-in recherche uniquement.

Si un champ figure sur cette liste et vous voulez le modifier, faites d’abord une 
sauvegarde de votre préréglage actuel (export JSON) et réfléchissez à si vous pourrez 
mesurer le résultat de manière reproductible — sinon vous ne saurez pas si vous avez 
provoqué une amélioration ou une régression.
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C H A P I T R E

Chapitre 7 — Préréglages de qualité 
intégrés

Figure 27. –  Section Préréglages avec les quatre groupes dépliés — CAPTURE CLASS 
(4 préréglages : Drone/Aerial, 360° Walkaround, 360° Walkaround (High Detail), Photo/

Object), CLASSIC (5 préréglages : Quick/Preview/Balanced/Quality/Ultra Detail), MCMC (3 
préréglages, mention « No threshold tuning »), HYBRID (1 préréglage : Balanced (Hybrid))

CE QUE MONTRE L’IMAGE  Section Préréglages dans l’inspecteur, les quatre groupes dé
pliés. CAPTURE CLASS avec les quatre préréglages réels curatés (Drone / Aerial, 360° 
Walkaround, 360° Walkaround (High Detail), Photo / Object) — c’est le groupe principal 
et le seul visible en mode débutant. CLASSIC avec Quick (1K iters), Preview (5K iters, 

121 / 177



R A D I A N C E K I T Chapitre 7 — Préréglages de qualité intégrés

sélection active avec une coche bleue), Balanced (20K iters), Quality (35K iters) et Ultra 
Detail (35K iters). MCMC avec le sous-titre « No threshold tuning » — MCMC n’a pas 
besoin de seuil densify-until : Preview (60K iters, 100K gaussiennes), Balanced (120K, 
150K), Quality (200K, 150K). HYBRID avec le Balanced (Hybrid) (20K iters, 150K gaus
siennes). Action-row en pied : Save…, Export…, Import…

Un préréglage est une configuration prête à l’emploi pour l’entraînement. RadianceKit 
livre treize préréglages intégrés en quatre groupes : quatre préréglages Capture-Class 
(P9–P12) — des recettes curatées et validées à l’œil sur du vrai matériel communautaire 
pour les types de prises réels (drone, parcours 360°, photo-objet), et l’axe principal de
puis la v1.6 —, cinq préréglages Classic (P1–P5 : Quick/Preview/Balanced/Quality/Ultra 
Detail), trois préréglages MCMC (P6–P8) et un préréglage Hybride (P13) qui combine 
les stratégies Classic et MCMC. Les anciens préréglages « Scene-Class » (Render/3D, 
Outdoor, Indoor, tunés en phase Q7 contre des scènes Mip-NeRF 360 et NeRF-Blender) 
ont été retirés comme groupe visible en v1.6 — la Capture-Class, validée à l’œil sur du 
vrai footage, est désormais l’axe principal ; les configurations tunées en Q7 ne restent 
conservées qu’en interne. Vous sélectionnez les préréglages dans la barre latérale, sec
tion Préréglages, ou en mode débutant lors de l’import. Les boutons +  ouvrent des 
dialogues pour créer vos propres préréglages à côté — les treize intégrés ne peuvent 
pas être supprimés, mais peuvent être dupliqués.

En vue expert, les préréglages apparaissent groupés par type de prise et par stratégie 
(Capture Class / Classic / MCMC / Hybride). Un clic sur une entrée écrit la configuration 
d’entraînement associée dans l’état courant. Ce n’est pas un instantané — si vous tou
chez ensuite à des curseurs, l’état change mais le préréglage lui-même reste inchangé ; 
un indicateur coloré affiche alors « modified ».

Quel préréglage est le bon dans quelle situation dépend surtout du type de scène et du 
matériel. Les trois tableaux récapitulatifs en fin de chapitre résument cela.
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P1 — Quick

O Ù

Inspecteur → Section Préréglages → Groupe « Clas
sic » → entrée « Quick ». Suffixe UUID …001 .

T E C H N I Q U E

Préréglage de diagnostic avec 1 000 itérations, stra
tégie de densification classique (adaptative) et une 
mise à l’échelle de résolution d’entraînement de 
0.25× (l’image d’entrée est réduite à 25 % avant 
entraînement). Ne sert pas à livrer une scène, mais 
à vérifier rapidement si la configuration (poses ca
méra, nuage de points, série d’images) montre un 
mouvement plausible dans les valeurs de loss. Sur 
un M3 Ultra, typiquement moins de 30 secondes 
sur 50–200 images. La petite résolution masque la 
qualité d’image réelle, mais maintient la mémoire et 
le coût de rendu très bas. Est aussi choisi automa
tiquement comme préréglage par défaut au premier 
démarrage si le système a moins de 10 Go de RAM.

E N  B R E F

Test de fonctionnement rapide. 
Vous mettez les images, atten­
dez à peine une demi-minute, re­
gardez si le contour brut de la 
scène apparaît. Si l’image dans 
la visionneuse ressemble à une 
tache floue — c’est normal, c’est 
attendu. Si en revanche vous ne 
voyez que des points sombres ou 
une forme complètement défor­
mée, les poses caméra sont pro­
bablement fausses (voir chapitre 
9). Pour un résultat présentable, 
il vous faudra ensuite au moins 
P2 ou P3.

P2 — Preview (Classic)

O Ù

Inspecteur → Section Préréglages → Groupe « Clas
sic » → entrée « Preview ». Suffixe UUID …002 .

T E C H N I Q U E

5 000 itérations de densification Classic, échelle 
de résolution 0.5×, taux d’apprentissage doublé par 
rapport au standard. La densification (clonage + 
split) est active sur les 2 500 premières itérations, 
puis seulement le pruning. Préréglage par défaut 
pour les systèmes avec ≥ 10 Go de RAM. Sur un 
M3 Ultra, typiquement de 90 secondes à 3 minutes 
pour une scène de 200 images. Donne une impres
sion utilisable de la géométrie et des poses caméra, 
mais les textures sont visiblement adoucies — la ré
solution de rendu 0.5× ne peut pas être contournée 
directement en réentraînant avec P3 ou P4 parce 
que les taux d’apprentissage sont calibrés pour la 
demi-résolution.

E N  B R E F

Le standard « juste pour voir 
». Si vous venez d’importer de 
nouvelles images et voulez voir 
si la scène est reconstructible, 
c’est le bon niveau. Environ 2–
3 minutes d’attente, ensuite vous 
pouvez tourner dans la vision­
neuse 3D et juger s’il vaut la 
peine d’investir dans d’autres 
entraînements. Ce n’est que si 
le résultat d’aperçu paraît déjà 
bon que Balanced ou Quality en 
valent la peine.
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P3 — Balanced (Classic)

O Ù

Inspecteur → Section Préréglages → Groupe « Clas
sic » → entrée « Balanced ». Suffixe UUID …005 .

T E C H N I Q U E

20 000 itérations de densification Classic à pleine 
résolution d’image. La densification s’effectue sur 
les 15 000 premières itérations, à partir de l’iter 
3 000 avec un intervalle de densify de 100. 
Empiriquement le « sweet spot » des sessions 
d’entraînement documentées : en densification 
classique sur Horse Full et Truck, le L1-Loss se sta
bilise entre les iters 18 000 et 22 000 ; un entraîne
ment plus long n’apporte plus d’amélioration signifi
cative en dessous de Quality (P4). Sur un M3 Ultra, 
typiquement 30–60 secondes sur 200 images, 5–8 
minutes sur 1 000+ images.

E N  B R E F

Le « bon compromis ». La plu­
part des scènes rendent déjà 
bien avec ce préréglage sans de­
voir attendre une heure. Si vous 
voulez montrer le résultat final 
quelque part (réseaux sociaux, 
site web, démo client), c’est sou­
vent suffisant. Ce n’est que si 
vous voulez zoomer dans le mo­
dèle splat ou avoir les détails de 
la texture de surface que le saut 
vers P4 Quality ou P7 MCMC en 
vaut la peine.

P4 — Quality (Classic)

O Ù

Inspecteur → Section Préréglages → Groupe « Clas
sic » → entrée « Quality ». Suffixe UUID …003 .

T E C H N I Q U E

35 000 itérations de densification Classic avec « 
Opacity Decay » V546 (HTGS, Eurographics 2025) : 
après chaque cycle de densify, l’opacité de toutes 
les gaussiennes existantes est multipliée par un fac
teur < 1.0, ce qui supprime de manière fiable au pru
ning les gaussiennes devenues inactives et permet 
d’atteindre, à nombre d’itérations identique, un L1-
Loss 14 % meilleur que la variante 35 000 classique. 
La perte SSIM est activée ( ssimWeight=0.05 ). Sur 
un M3 Ultra, typiquement 2–4 minutes sur 200 
images. Fournit sur NeRF-Blender (Lego, Chair, 
Drums) un L1 final ≈ 0.023 — meilleure variante 
Classic des 560+ expériences documentées. Atten
tion : nécessite ~3–5 Go de mémoire GPU ; sur les 
systèmes 8 Go, P3 est le choix sûr.

E N  B R E F

La meilleure variante classique. 
Donne une texture nette et une 
géométrie fine, surtout sur les 
prises d’objet (une sculpture, 
une chaise, un vase). Sur de 
grandes scènes outdoor ou dans 
des pièces, vous percevrez à 
peine la différence avec Balan­
ced — là, passer à un préréglage 
MCMC (P6–P8) ou un préréglage 
Capture-Class (P9–P12) apporte 
davantage que le saut de P3 à P4. 
Qui veut le maximum absolu de 
la famille Classic prend P5 Ultra 
Detail.
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P5 — Ultra Detail (Classic)

O Ù

Inspecteur → Section Préréglages → Groupe « Clas
sic » → entrée « Ultra Detail ». Suffixe UUID …008 .

T E C H N I Q U E

Environ 35 000 itérations de densification Classic 
— le vainqueur du passage held-out de la Quality-
Matrix (2026-06-10). Sur les trois scènes Mip-NeRF 
360 testées, Ultra Detail bat le préréglage MCMC 
« Quality » intégré (P8) à temps wall-clock compa
rable d’environ +0.94 dB PSNR. C’est donc le préré
glage qualité le plus fort du groupe Classic et la 
variante Classic la plus nette que RadianceKit livre. 
Sur un M3 Ultra, typiquement dans le même cré
neau de temps que P4 Quality (2–5 minutes sur 200 
images), mais demande un peu plus de mémoire 
GPU ; sur les systèmes 8 Go, P3 reste le choix sûr.

E N  B R E F

Le palier Classic le plus net et le 
vainqueur held-out de nos tests 
de qualité : sur de vraies scènes, 
environ un décibel mieux que la 
variante MCMC « Quality » — 
pour un temps d’attente simi­
laire. Si vous voulez une fidélité 
de détail maximale avec la den­
sification classique éprouvée et 
que vous avez assez de mémoire 
GPU, c’est le premier choix. Si la 
mémoire ne suffit pas ou si vous 
avez besoin d’un fichier d’export 
aussi petit que possible, restez 
sur P4 Quality ou un préréglage 
MCMC.

P6 — Preview (MCMC)

O Ù

Inspecteur → Section Préréglages → Groupe « 
MCMC » → entrée « Preview ». Suffixe UUID …006 .

T E C H N I Q U E

60 000 itérations de densification MCMC (3DGS-
MCMC, NeurIPS 2024) avec un cap de 100 000 
gaussiennes. MCMC remplace la logique heuristique 
clone/split par une relocation Markov-Chain Monte-
Carlo : les gaussiennes mortes sont relocalisées par 
échantillonnage pondéré sigmoïde, ce qui donne un 
nombre contrôlé et reproductible de gaussiennes. 
Le cap plafonne dur le nombre maximal à 100K — 
cela économise de la mémoire et du temps de ren
du, mais coûte en détail. Sur un M3 Ultra, typique
ment 5–8 minutes sur 200 images. Convient comme 
« test de fonctionnement MCMC » — aide à juger 
si un passage de Classic à MCMC en vaut la peine 
avant d’investir plus de temps dans P7 ou P8.

E N  B R E F

Comme P2 Preview, mais avec 
la méthode MCMC plus récente. 
Donne souvent des nuages de 
splats un peu plus compacts et 
plus uniformément répartis que 
la variante Classic. Pour une pre­
mière évaluation d’une scène, les 
5–8 minutes suffisent générale­
ment. Si le résultat d’aperçu vous 
plaît, l’étape suivante est P7 (Ba­
lanced) ou directement P8 (Qua­
lity MCMC).
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P7 — Balanced (MCMC)

O Ù

Inspecteur → Section Préréglages → Groupe « 
MCMC » → entrée « Balanced ». Suffixe UUID 
…007 .

T E C H N I Q U E

120 000 itérations MCMC avec un cap de 150 
000 gaussiennes. Le palier intermédiaire MCMC — 
presque le nombre final de gaussiennes de P8 Qua
lity, mais seulement 60 % des itérations. Empirique
ment, le L1-Loss dans les sessions documentées se 
situe à 0.026–0.028 sur Horse Full, contre 0.0246 
pour P8 — environ 7 % plus élevé, pour la moitié du 
temps d’attente. Sur un M3 Ultra, typiquement 8–
15 minutes sur 200 images. Utilise un procédé qui 
met à l’échelle le cap de gaussiennes effectif sur la 
densité de points du nuage SfM d’entrée (voir T75 
au chapitre 6).

E N  B R E F

MCMC avec un niveau de détail 
correct mais sans la longue exé­
cution complète de P8. Pour la 
plupart des scènes, cela suffit, 
surtout si vous voulez faire en­
trer une exécution MCMC dans 
une pause déjeuner. Si la mé­
moire est juste (par exemple sur 
des processeurs M avec seule­
ment 16 Go), restez ici — P8 de­
mande plus de mémoire GPU.

P8 — Quality (MCMC)

O Ù

Inspecteur → Section Préréglages → Groupe « 
MCMC » → entrée « Quality ». Suffixe UUID …004 .

T E C H N I Q U E

200 000 itérations MCMC avec un cap de 150 
000 gaussiennes, perte SSIM 0.05, décroissance du 
bruit MCMC sur 80 % des itérations. Meilleur L1 
mono-run dans les 560+ expériences : 0.0238 sur 
Horse Full, moyenné sur 3 essais 0.0246 (contre 
P4 0.0230 sur la même scène). MCMC fournit en 
plus 71 % de gaussiennes en moins (150K contre 
~524K) — décisif si vous voulez livrer le résultat 
sur le web, parce que le nuage plus petit produit 
des fichiers d’export nettement plus petits. Temps 
d’entraînement sur un M3 Ultra typiquement de 20–
35 minutes sur 200 images ; sur des sets de 1 000+ 
images plutôt 1–2 heures. Meilleur choix si vous 
voulez la qualité d’image maximale pour une taille 
finale minimale.

E N  B R E F

La meilleure variante MCMC. 
Donne des nuages de splats très 
propres et compacts — idéal si 
vous voulez ensuite embarquer 
le résultat dans une visionneuse 
3D web ou l’envoyer en fichier 
(le fichier est plus petit qu’avec 
P4 Quality à qualité visuelle com­
parable). Il vous faudra cepen­
dant de la patience — sur de 
grandes prises, plus d’une heure 
d’attente. Planifiez plutôt cela 
comme une exécution « nuit ».
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Figure 28. –  Groupe CAPTURE CLASS déplié avec les quatre préréglages réels curatés — 
Drone / Aerial (MCMC, 40K iters, Cap 1,5 M), 360° Walkaround (MCMC, 40K, Cap 1,5 M), 

360° Walkaround (High Detail) (Hybride, 40K, Cap 1,5 M, opt-in) et Photo / Object (Hybride, 
40K, Cap 1,5 M). Ce groupe est tout en haut et le seul visible en mode débutant.

CE QUE MONTRE L’IMAGE  Inspecteur avec le groupe CAPTURE CLASS déplié — le groupe 
de préréglages principal depuis la v1.6, le seul affiché en mode débutant. Chaque en
trée est une recette validée à l’œil sur du vrai matériel communautaire pour un type de 
prise concret (drone, parcours 360°, photo-objet), et non une valeur optimisée contre 
un set de test académique. Une sélection par clic écrit la configuration d’entraînement 
associée dans l’état courant.
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P9 — Drone / Aerial

O Ù

Inspecteur → Section Préréglages → Groupe « Cap
ture Class » → entrée « Drone / Aerial ». Suffixe 
UUID …010 .

T E C H N I Q U E

Préréglage Capture-Class pour les orbites aériennes 
et de drone de bâtiments et de paysages. Densi
fier MCMC, 40 000 itérations, cap 1,5 M de gaus
siennes, perte SSIM 0.5 plus terme Edge-Aware 0.1. 
L’élément décisif est la pénalité d’anisotropie de 
poids 0.003 à un seuil de ratio de 6 — le « tueur 
de spaghettis » contre les artefacts typiquement 
en forme d’aiguille que produit le footage de drone. 
Validé sur un vrai vol de drone DJI 4K au-dessus 
du viaduc de Pensford (vérifié à l’œil, pas seulement 
par métrique).

E N  B R E F

Pour les prises aériennes — vols 
de drone autour d’un bâtiment, 
au-dessus d’un paysage, le long 
d’une façade. La forte pénalité 
d’anisotropie balaie les artefacts 
en forme d’aiguille ou de spa­
ghetti que le matériel de drone 
produit volontiers. Si votre maté­
riel est pris depuis le sol, Photo / 
Object ou un préréglage Classic 
convient plutôt.

P10 — 360° Walkaround

O Ù

Inspecteur → Section Préréglages → Groupe « Cap
ture Class » → entrée « 360° Walkaround ». Suffixe 
UUID …011 .

T E C H N I Q U E

Préréglage Capture-Class pour les vidéos de par
cours 360°. Densifier MCMC, 40 000 itérations, cap 
1,5 M de gaussiennes, perte SSIM 0.5 plus terme 
Edge-Aware 0.1, pénalité d’anisotropie douce (poids 
0.001 à un seuil de ratio 15). Les masques de per
sonnes et de ciel sont actifs. Le préréglage attend 
une vidéo équirectangulaire 360° qui est reprojetée 
en interne en crops perspectifs d’environ 90° de 
large avant le démarrage de l’entraînement. Validé 
sur des parcours 360° 8K avec perche à selfie 
(scène Monument, vérifié à l’œil).

E N  B R E F

Pour les vidéos de parcours 360° 
— vous vous déplacez avec une 
caméra 360° ou une perche à 
selfie dans une pièce ou au­
tour d’un objet. RadianceKit dé­
compose lui-même le panorama 
sphérique en angles de vue nor­
maux et masque les passants et 
le ciel. Pour une netteté maxi­
male sur le même matériel, es­
sayez en plus la variante High 
Detail (P11).
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P11 — 360° Walkaround (High Detail)

O Ù

Inspecteur → Section Préréglages → Groupe « Cap
ture Class » → entrée « 360° Walkaround (High 
Detail) ». Suffixe UUID …013  (Opt-in).

T E C H N I Q U E

Préréglage Capture-Class opt-in pour les vidéos de 
parcours 360° avec un détail maximal. Densifier hy
bride (clonage/split classique par gradient absolu + 
bruit MCMC + relocation), 40 000 itérations, cap 
1,5 M de gaussiennes, pénalité d’anisotropie 0.0015 
à un seuil de ratio 15, perte SSIM 0.2 et terme 
Edge-Aware 0 — la recette screen-split « r50 » ver
rouillée. Sur du matériel 360°, il bat le préréglage 
MCMC standard « 360° Walkaround » (P10) en 
PSNR, en LPIPS et en confettis visibles, et cela avec 
environ un tiers du nombre de splats. Il se tient 
délibérément en opt-in à côté du préréglage 360° 
standard, jusqu’à ce qu’il soit validé sur davantage 
de scènes.

E N  B R E F

L’alternative plus nette au préré­
glage 360° standard (P10) : plus 
de détail, moins de confettis, fi­
chier nettement plus petit. Il se 
tient délibérément à côté plutôt 
que de le remplacer — confir­
mé jusqu’ici sur une poignée de 
scènes. Si votre parcours 360° 
est pris proprement, essayez 
d’abord ce préréglage et compa­
rez le résultat avec P10.

P12 — Photo / Object

O Ù

Inspecteur → Section Préréglages → Groupe « Cap
ture Class » → entrée « Photo / Object ». Suffixe 
UUID …012 .

T E C H N I Q U E

Préréglage Capture-Class pour les orbites d’objet à 
partir de photos individuelles nettes (pas de vidéo). 
Densifier Hybride-t1 (avec relocation), 40 000 itéra
tions, cap 1,5 M de gaussiennes, perte SSIM 0.5 
plus terme Edge-Aware 0.1, pénalité d’anisotropie 
douce (poids 0.001 à un seuil de ratio 15), Opacity 
Decay 0.9995 toutes les 50 itérations, pas de mas
king. Validé sur 163 photos haute résolution de 41 
MP d’un squelette (vérifié à l’œil). Peu de vues 
(jusqu’à environ 600) restent ainsi sous le seuil de 
collapse hybride.

E N  B R E F

Pour les prises d’objet à partir 
de photos individuelles nettes — 
vous tournez autour d’une sculp­
ture, d’un modèle, d’un produit 
avec l’appareil et prenez des 
photos plutôt qu’une vidéo. Pas 
de masking, parce que les photos 
nettes ont en général un arrière-
plan propre. Pour des sources vi­
déo, prenez plutôt un préréglage 
360° ou Drone.
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P13 — Équilibré (Hybride)

O Ù

Inspecteur → Section Préréglages → Groupe « Hy
bride » → entrée « Équilibré (Hybride) ». Suffixe 
UUID …009 .

T E C H N I Q U E

20 000 itérations avec la stratégie de densification 
hybride : le clone/split classique piloté par le gra
dient place la capacité là où la loss en a besoin, 
le bruit SGLD du MCMC continue d’explorer, et les 
gaussiennes mortes sont relocalisées au lieu d’être 
perdues au pruning. La décroissance d’opacité 
(V546) remplace les resets d’opacité ; une pénalité 
d’anisotropie (poids 0.001, seuil de ratio 15) tient 
en respect les splats en forme d’aiguille. Le cap 
de gaussiennes s’adapte à la scène (base 150K, 
scene-aware ×3.0). Validé sur cinq scènes contre 
le MCMC pur à budget égal : en moyenne +0.45 
dB PSNR avec 20–30 % de gaussiennes en moins 
(stonehenge +1.23, family +0.82, garden +0.47 dB). 
Sur un M3 Ultra, typiquement 5–10 minutes sur 200 
images.

E N  B R E F

Un solide premier choix pour 
un résultat final : plus de dé­
tails nets que les préréglages 
MCMC pour un fichier de taille 
comparable, en une fraction du 
temps d’entraînement de P8. 
Si vous n’avez le temps que 
pour un seul run qualité et 
qu’aucune des Capture-Classes 
ne convient clairement, com­
mencez ici. Les préréglages Clas­
sic restent meilleurs pour les 
tests rapides, et les préréglages 
Capture-Class (P9–P12) sont le 
premier choix quand votre scène 
correspond clairement à l’un de 
ces types de prises.
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Quand utiliser quel préréglage ?

Scénario Premier test Run principal

Test de fonctionnement 
de nouvelles images, < 

30 s

P1 Quick —

Orbite d’objet à partir 
de photos individuelles 

nettes

P2 Preview P12 Photo / Object

Scan d’objet seul (vidéo), 
< 500 photos

P2 Preview P4 Quality ou P8 Quality 
MCMC

Vidéo de parcours 360° P6 Preview MCMC P10 360° Walkaround (net : 
P11 High Detail)

Orbite aérienne / drone, 
paysage

P6 Preview MCMC P9 Drone / Aerial

Livraison web (petit, 
compact)

P2 P8 Quality MCMC (plus pe
tit fichier à qualité pleine)

Détails nets en peu de 
temps, export compact

P2 ou P6 P13 Équilibré (Hybride)

Fidélité de détail maxi
male, stratégie Classic

P3 ou P6 P5 Ultra Detail

Impression, marketing, 
plein détail

P3 ou P6 P4 Quality (Classic) ou P5 
Ultra Detail
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Comparaison rapide
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Pré­
réglage

Stra­
tégie

Iters Max-
Gs

Échelle 
rendu

Temps typique (200 images, 
M3 Ultra)

Q-Sweep

P1 Quick Classic 1 000 ∞ 0.25× ~30 s —

P2 
Preview

Classic 5 000 ∞ 0.5× 2–3 min —

P3 
Ba
lan
ced

Classic20 000 ∞ 1.0× 30–60 s —

P4 Qua
lity

Classic35 000 ∞ 1.0× 2–4 min V546 
HTGS

P5 
Ul
tra 
De
tail

Classic ~35 
000

∞ 1.0× 2–5 min Ma
trix Δ+0.94 

dB

P6 
Preview 
MCMC

MCMC60 000 100 
K

1.0× 5–8 min —

P7 
Ba
lan

ced MCMC

MCMC 120 
000

150 
K

1.0× 8–15 min —

P8 Qua
lity MCMC

MCMC 200 
000

150 
K

1.0× 20–35 min V544a

P9 Drone / 
Ae
rial

MCMC40 000 1.5 
M

1.0× 10–25 min Œil / 
Via
duc

P10 360° 
Wal

karound

MCMC40 000 1.5 
M

1.0× 10–25 min Œil / 
Mo
nu

ment

P11 360° 
Wal

karound 
(High 
De
tail)

Hy
bride

40 000 1.5 
M

1.0× 10–25 min Œil 
(opt-
in)

P12 Pho
to / 
Ob
ject

Hy
bride

40 000 1.5 
M

1.0× 10–25 min Œil / Sque
lette

P13 Équi
libré 
(Hy

bride)

Hy
bride

20 000 150 
K

1.0× 5–10 min Ma
trix Δ+0.45 

dB
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Préréglages personnels

Le bouton Save… dans la section Préréglages (I1 au chapitre 2) enregistre la configura
tion d’entraînement courante comme préréglage personnel. Les préréglages personnels 
ne sont pas « Built-in » et peuvent être renommés, exportés (en JSON), partagés 
par glisser-déposer, dupliqués et supprimés. Les treize préréglages intégrés P1–P13 ne 
sont pas affectés par le bouton de suppression.

Règle empirique : si vous modifiez quelque chose dans un préréglage et que vous 
voulez le réutiliser souvent — Sky-Dome activé, poids SSIM plus élevé pour une cer
taine classe de scène, nombres d’itérations différents — enregistrez la variante comme 
préréglage personnel. Ainsi, lors du prochain run, vous saurez tout de suite qu’il s’agit 
d’une configuration différente du standard.
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C H A P I T R E

Chapitre 8 — Formats d’export

Figure 29. –  Sélection des formats d’export en mode débutant — six cartes de format

Figure 30. –  Grille de formats d’export en direct après un entraînement de 5K iter sur le 
bouquet flowers — les six cartes avec calcul dynamique de taille (PLY 742 KB sélectionné, 
SPZ 74 KB, glTF 708 KB, .splat 96 KB, Orbit Video ~Zero KB, Web Viewer 133 KB), Export 

History à droite avec PLY déjà enregistré

Ce que montre l’image (2 991 gaussiennes, SH degree 3, bouquet Blender de test 
exempt de droits) : les indications de taille sous chaque carte de format sont calculées 
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en direct à partir du nombre actuel de gaussiennes et de l’overhead du format — pas en 
dur. À partir de 2 991 gaussiennes (SH degree 3), on obtient 742 KB de PLY, 74 KB de 
SPZ (facteur ~10× plus petit par quantification), 708 KB de glTF (avec l’extension KHR_​
gaussian_​splatting, donc quasi équivalent au PLY), 96 KB de .splat (format compressé 
à 24 octets par gaussienne). Orbit Video affiche « ~Zero KB » parce que la taille 
n’est connue qu’après encodage MP4. Web Viewer (133 KB) regroupe un fichier HTML 
autonome avec une visionneuse WebGL embarquée et des données splat compressées 
— plus grand qu’un .splat pur à cause de l’overhead de la visionneuse. Export History à 
droite liste l’export PLY déjà terminé (« training_20260527T211321Z.ply, 743 KB, 23:13 
») avec un pill de format et l’action Reveal-in-Finder.

Un entraînement terminé fournit un nuage de gaussiennes — une collection de quelques 
centaines de milliers à plusieurs millions de distributions gaussiennes 3D qui, ensemble, 
reconstruisent la scène. RadianceKit propose dix façons d’écrire ce nuage sur le 
disque. Six sont des formats de données 3D purs (PLY, Compressed PLY, SPZ, SOG, 
glTF, .splat), un empaquette le nuage avec une visionneuse HTML prête à l’emploi (Web 
Viewer), un rend un fichier MP4 à partir d’une orbite caméra (Orbit Video), et deux 
n’exportent aucun contenu gaussien mais seulement le résultat SfM (poses caméra 
et nuage de points grossier) pour réutilisation dans d’autres pipelines d’entraînement 
(transforms.json + workspace COLMAP).

Lequel choisir dépend de l’objectif. Pour l’archivage complet des données sans perte de 
qualité, prenez PLY. Pour une visionneuse web sur votre propre site, .splat ou la vision
neuse web intégrée suffit généralement. Si le fichier doit être minimal, SPZ ou SOG 
en valent la peine. Pour réutiliser le résultat SfM dans Nerfstudio, Postshot ou Brush, 
transforms.json et le workspace COLMAP sont les bons chemins.

Toutes les fonctions d’export se trouvent dans le menu « Export » ainsi qu’en mode 
débutant à la dernière étape de l’assistant. La plupart des formats sont pleinement 
conformes au sandbox et fonctionnent dans la version App Store. Seul SOG requiert un 
binaire externe ( cwebp ) qui n’est pas obligatoirement présent dans le build App Store 
— détails en E4.
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E1 — PLY (.ply)

O Ù

Barre de menu → Export → 3D Formats → Export 
PLY… (⌘E). Mode débutant : étape Export → carte 
de format « PLY ». Taille : typiquement 100 % (va
leur de référence). Compatible avec : SuperSplat, 
PolyCam, toutes les visionneuses 3DGS.

T E C H N I Q U E

PLY est le format canonique de stockage pour le 
3D Gaussian Splatting. RadianceKit écrit un fichier 
binaire little-endian avec la disposition standard de 
propriétés 3DGS : par gaussienne, position à trois 
composantes, trois normales toujours à zéro, trois 
coefficients DC-SH ( f_dc_0..2 ) pour la couleur 
RGB de base, puis jusqu’à 45 coefficients SH sup
plémentaires ( f_rest_0..44 ) dans la disposition 
channel-major transposée définie par le papier Ker
bl 2023 (d’abord tous les coefficients du canal R, 
puis tous ceux du G, puis tous ceux du B), suivis de 
l’opacité logit (valeurs pré-sigmoïde brutes), trois 
échelles en log-space et une rotation quaternion 
wxyz. Le degré SH maximal exporté est plafonné 
au minimum entre le souhait utilisateur et le degré 
réellement appris ; le défaut est 3 (45 coefficients 
« rest »). Avant l’écriture, la taille du payload est 
calculée en entier 64 bits pour intercepter les dé
passements sur les nuages très volumineux. Le fi
chier est écrit atomiquement, ce qui occupe briève
ment le double de l’espace disque pour les grands 
nuages.

E N  B R E F

C’est le « fichier original ». Plus 
gros fichier, plus haute compati­
bilité, aucune perte. Si vous ne 
savez pas quel format prendre, 
prenez PLY — il s’ouvre dans 
presque tous les outils 3DGS. 
Pour 1 million de gaussiennes, 
cela représente entre 200 et 800 
Mo selon le degré SH. Si le fichier 
devient trop gros, regardez E2 
(PLY compressé) ou E3 (SPZ).
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E2 — Compressed PLY (.ply)

O Ù

Barre de menu → Export → 3D Formats → Export 
Compressed PLY…. Mode débutant : carte de format 
« Compressed PLY ». Taille : environ 10–20 % par 
rapport au PLY (compression 5× à 10×). Compa­
tible avec : SuperSplat, moteur PlayCanvas, vision
neuses web.

T E C H N I Q U E

La variante PlayCanvas du format PLY avec quan
tification par chunks. Les gaussiennes sont regrou
pées par chunks de 256. Par chunk, des bornes 
min/max pour position, échelle et couleur sont sto
ckées séparément dans l’en-tête ; les gaussiennes 
individuelles référencent leurs valeurs relativement 
à ces bornes et sont compressées sur 32 bits 
chacune : position et échelle en packing 11-10-11 
bits, rotation en quaternion « smallest-three » 
2-10-10-10 bits, couleur en 8-8-8-8 RGBA. Les co
efficients SH plus élevés sont quantifiés sur 8 bits 
seulement par composante ( shCoeffCount * 3  
uchar par gaussienne). Le format reste un PLY à en-
tête ASCII et est donc fondamentalement validable 
avec les outils PLY, mais les propriétés vertex sont 
déclarées comme champs uint . Le degré SH est 
par défaut à 0 (aucun coefficient « rest ») pour 
maximiser la compression — des degrés SH plus 
élevés peuvent être choisis explicitement.

E N  B R E F

La variante PLY peu encom­
brante. Compatibilité moteur 
identique au PLY normal, mais 5 
à 10 fois plus petit. SuperSplat 
et PlayCanvas le lisent native­
ment. Pour le déploiement web, 
presque toujours meilleur qu’un 
PLY normal. La perte de qualité 
due à la quantification est géné­
ralement invisible à l’œil, sauf si 
la scène contient des détails ex­
trêmement haute fréquence.
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E3 — SPZ (.spz)

O Ù

Barre de menu → Export → 3D Formats → Export 
SPZ…. Mode débutant : carte de format « SPZ ». 
Taille : environ 10 % par rapport au PLY (90 % plus 
petit). Compatible avec : Niantic Scaniverse, Nian
tic Spatial Fields, MetalSplatter.

T E C H N I Q U E

Le format SPZ-v2 de Niantic. Les positions sont em
paquetées en fixed-point 24 bits (ce qui donne en
viron 0,25 mm de résolution), les échelles en quan
tification 8 bits en log-space, les rotations en smal
lest-three 8 bits (en v2 seuls xyz sont stockés, w 
est dérivé par le décodeur depuis la norme du qua
ternion), les opacités en valeurs 8 bits sigmoïdes. 
DC-SH est stocké avec une formule de packing 
spécifique SPZ (dc_​raw * 0.15 * 255 + 0.5 * 
255), les bandes SH plus élevées sur 5 bits (bande 
1) ou 4 bits (bandes 2-3) par coefficient. Tout le 
blob binaire empaqueté est ensuite compressé avec 
gzip standard (RFC 1952), ce qui donne un conte
neur gzip avec les magic bytes 1f 8b . RadianceKit 
appelle pour cela le gzip  système, parce que l’API 
zlib intégrée d’Apple produit un framing proprié
taire Apple qui ne serait pas compatible avec les 
lecteurs SPZ de Spatial Fields ou MetalSplatter. Le 
gzip  système reste appelable même à l’intérieur 

du sandbox macOS.

E N  B R E F

Le plus petit fichier standard. Si 
vous connaissez Scaniverse de 
Niantic — c’est le format que 
cette app utilise. Très petit, très 
adapté au chargement sur mo­
bile. Directement utilisable dans 
la visionneuse cloud propre à 
Niantic (Spatial Fields). Environ 
90 % plus petit qu’un PLY conte­
nant les mêmes données, tout 
en restant pour la plupart des 
scènes visuellement quasi indis­
cernable.
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E4 — SOG (.sog)

O Ù

Barre de menu → Export → 3D Formats → Export 
SOG…. Mode débutant : carte de format « SOG ». 
Taille : environ 5–6 % par rapport au PLY (compres
sion 15× à 20× — l’option la plus petite). Compa­
tible avec : moteur PlayCanvas, éditeur SuperSplat.

T E C H N I Q U E

« Spatially Ordered Gaussians » — un format 
PlayCanvas qui stocke le nuage GPU-ready dans 
plusieurs images WebP sans perte. Toutes les gaus
siennes sont d’abord triées spatialement par code 
Morton 3D (Z-order 30 bits, 10 bits par axe), ce 
qui procure aux images une cache locality ulté
rieure dans le renderer. Puis les positions sont 
quantifiées en valeurs 16 bits avec transformation 
log symétrique (pour une meilleure dynamique) et 
réparties en deux images RGBA ( means_l.webp  
pour les 8 bits inférieurs, means_u.webp  pour les 
supérieurs). Les rotations sont encodées en smal
lest-three avec 3×8 bits plus un mode 2 bits dans 
une image RGBA (le mode atterrit en alpha sous 
la forme 252 + largest ). Les échelles et le DC-
SH sont quantifiés via un codebook à 256 entrées 
chacun (réparti par percentiles sur toutes les va
leurs), les indices atterrissent dans scales.webp  
et sh0.webp . Les cinq images plus un meta.json  
avec codebooks et bornes sont empaquetés dans 
un fichier ZIP (encodeur custom, parce que le sand
box bloque le zip  système) et enregistrés avec 
l’extension .sog .

Attention sandbox : SOG est la seule option 
de format qui requiert un binaire externe. L’étape 
d’encodage WebP appelle cwebp  depuis /​usr/​
local/​bin/​cwebp ou /​opt/​homebrew/​bin/​cwebp. Si 
aucun binaire cwebp n’est trouvé, le code retombe 
sur un encodage PNG brut — mais : le fallback 
PNG ne fonctionne pas dans SuperSplat. Dans 
la version App Store, évaluez la disponibilité se
lon la variante de build ; dans la variante déve
loppeur, cwebp doit être installé via Homebrew 
( brew install webp ).

E N  B R E F

Le plus petit format 3DGS qui 
soit, nettement plus petit que 
SPZ. Mais : il faut l’outil cwebp  
sur votre Mac, parce que Radian­
ceKit ne peut pas générer tous 
les formats d’image lui-même. 
Installez-le une fois avec Home­
brew, et tout fonctionne. Dans la 
version App Store, il se peut qu’il 
ne soit pas pleinement fonction­
nel — si l’export produit du PNG 
au lieu de WebP, vous ne pour­
rez pas ouvrir le fichier directe­
ment dans SuperSplat. Sans Ho­
mebrew, prenez plutôt SPZ (E3).

140 / 177



R A D I A N C E K I T Chapitre 8 — Formats d’export

E5 — glTF (.glb)

O Ù

Barre de menu → Export → 3D Formats → Export 
glTF…. Mode débutant : carte de format « glTF 
». Taille : comparable au PLY. Compatible avec : 
visionneuses glTF avec extension KHR_​gaussian_​
splatting (draft standard Khronos).

T E C H N I Q U E

Écrit un fichier binaire .glb  autoporteur (pas 
de fichier bin séparé) conformément à la spéci
fication d’extension KHR_​gaussian_​splatting. Les 
positions sont stockées comme données vertex 
POSITION  glTF classiques (float3), tous les autres 

attributs (rotation en float4, échelle en float3, opa
cité en float, coefficients SH en float3 × shCoeff
Count) résident dans des attributs vertex supplé
mentaires et sont référencés via l’extension. Impor
tant : glTF utilise un système de coordonnées 
droite Y-up, COLMAP/3DGS travaille en Y-down/
Z-forward. L’exporteur applique donc une rotation 
de 180° autour de l’axe X — les positions sont 
réécrites en (x, -y, -z) , les quaternions ajustés 
en (w, x, -y, -z) . Cela donne une représentation 
géométriquement correcte, droite (non en miroir) 
dans les visionneuses glTF. Les chunks JSON et 
binaires sont paddés sur 4 octets comme l’exige le 
standard GLB.

E N  B R E F

Le format standard officiel Khro­
nos pour les données 3D, dans 
la toute nouvelle extension pour 
les Gaussian Splats. Avantage : 
glTF est répandu dans tous les 
grands moteurs 3D (Babylon.js, 
Three.js, Unity, Unreal). Inconvé­
nient : en 2026, l’extension est 
encore en draft, beaucoup de vi­
sionneuses ne la prennent pas 
encore en charge. Utile surtout si 
vous intégrez des données splat 
dans un pipeline glTF existant ou 
si vous écrivez une visionneuse 
déjà compatible glTF.
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E6 — Splat (.splat)

O Ù

Barre de menu → Export → 3D Formats → Ex
port .splat…. Mode débutant : carte de format 
« .splat ». Taille : exactement 32 octets par gaus
sienne. Compatible avec : gsplat.js, visionneuses 
web (référence antimatter15), la plupart des démos 
3DGS dans le navigateur.

T E C H N I Q U E

Le format .splat  antimatter15 — 32 octets par 
gaussienne, pas d’en-tête, pas d’indirection. Dispo
sition par entrée : 3 × float32 position (coordonnées 
monde), 3 × float32 échelle (transformée exp de
puis le log-space du buffer interne), 4 × uint8 
couleur RGBA (coefficient DC-SH mis à l’échelle 
avec SH_C0 = 0.282...  et clampé sur [0,255]), 4 × 
uint8 quaternion (w,x,y,z, normalisé et encodé dans 
la plage octet comme 128 + 128*q ). Seul le DC-
SH est stocké — les bandes SH plus élevées sont 
rejetées. Cela rend le format extrêmement compact 
mais coûte les variations de couleur dépendantes 
de la vue qui apparaissent sur les reflets ou les 
hautes lumières spéculaires. L’ordre d’écriture est 
exactement l’ordre d’index du nuage (aucun tri 
spatial), les visionneuses web comme gsplat.js  
rendent à partir de cela.

E N  B R E F

Le format de choix si vous vou­
lez afficher le splat dans votre 
propre visionneuse web avec 
gsplat.js . Très compact (32 

octets par gaussienne), mais pas 
de degré SH supérieur — donc 
pas de reflets brillants ni de 
fines variations de couleur se­
lon l’angle. Pour la plupart des 
applications web, ce n’est pas 
un problème, car la couleur DC 
suffit largement et l’absence de 
view-dependence se remarque à 
peine.
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Figure 31. –  Web Viewer ouvert dans Firefox — bouquet rendu avec sphères marqueurs 
de caméra environnantes, barre d’onglets en haut visible, aucune configuration CDN/serveur 

nécessaire. Le flowers-01.html  autonome ouvert directement depuis le Finder par 
double-clic dans le navigateur par défaut — le programme WebGL2 embarqué rend immé
diatement le nuage de gaussiennes, sans réseau ni serveur. Les marqueurs noirs autour du 
bouquet sont les caméras d’entraînement, affichables à la demande. Glisser-souris rotation, 

molette zoom.

143 / 177



R A D I A N C E K I T Chapitre 8 — Formats d’export

E7 — Web Viewer (.html)

O Ù

Barre de menu → Export → Media → Export Web 
Viewer…. Mode débutant : carte de format « Web 
Viewer ». Taille : données splat encodées base64 
(≈ 4/3 d’overhead) + environ 5 KB de shell HTML/
JS. Compatible avec : tout navigateur moderne 
avec WebGL2 (tous les desktops, iOS 15+, Android 
5+).

T E C H N I Q U E

Empaquette le nuage de gaussiennes avec un ren
derer WebGL2 écrit entièrement en inline dans un 
unique fichier .html . Aucune dépendance CDN, 
pas de WASM, pas de second fichier. Le nuage 
est d’abord encodé en interne en binaire .splat  
(même logique 32 octets qu’en E6), puis embarqué 
en base64, puis décodé par atob  dans le naviga
teur. Le renderer intégré effectue son propre tri 
WebGL2, le contrôle d’orbite à la souris et un tri 
CPU par frame ; tout le code JS (shaders, mathéma
tiques, boucle) est visible dans le HTML produit. 
La convention d’axes à la frontière stockage-ren
derer est exactement la même qu’en E5 : posi
tion (x, -y, -z) , quaternion (w, x, -y, -z) . Un 
overlay de branding peut être affiché en option 
(commutateur du free-tier). Comme tout est inline, 
le fichier fonctionne aussi directement depuis le 
protocole file:/​/​ — aucun serveur web local né
cessaire pour tester.

E N  B R E F

Un unique fichier HTML que 
vous pouvez envoyer à quelqu’un 
par mail ou intégrer sur une 
page web. Double-clic dans le 
Finder, et le navigateur affiche 
votre scène avec rotation à la 
souris. Pas d’upload vers un 
cloud, pas de second fichier, 
pas de serveur. Idéal pour les 
présentations clients, le portfo­
lio, les pièces jointes. Inconvé­
nient : le fichier devient environ 
un tiers plus gros à cause de 
l’encodage base64 par rapport à 
un .splat  brut — pour de très 
grandes scènes, l’hébergement 
séparé du fichier .splat  avec 
une visionneuse standard en 
vaut donc la peine.
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Figure 32. –  Image extraite de flowers-01.mp4 — bouquet rendu en profil, plate-forme 
blanche avec marqueurs caméra visibles, fond noir (fond viewport par défaut, modifiable 

dans les réglages). La caméra contourne la scène sur une trajectoire paramétrique (élévation 
et distance fixes, yaw tourne), durée typique 6–10 secondes à 30 ou 60 fps. Résolution 

d’image modulable de 480p à 8K via VideoPreset.
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E8 — Orbit Video (.mp4/.mov)

O Ù

Barre de menu → Viewport → Record Turntable Vi
deo OU barre de menu → Export → Media → Export 
Orbit Video…. Mode débutant : carte de format « 
Orbit Video » avec slider de durée 3–30 s. Taille : 
dépend de durée, résolution, débit. Compatible 
avec : toutes les plateformes (H.264 et HEVC sont 
les standards Apple).

T E C H N I Q U E

Rend le nuage de gaussiennes le long d’une orbite 
caméra paramétrique et encode chaque image via 
AVAssetWriter en un fichier MP4 ou MOV. La confi
guration de l’orbite contrôle la vitesse de rotation 
(tours), distance, élévation, FOV, durée et facteur 
ease-in/out. L’export de vidéo orbitale passe par le 
ForwardPass PROPRE à RadianceKit avec évaluation 
SH complète — pixel-identique au viewport intégré 
(WYSIWYG). Par image, la matrice d’ajustement 
monde (calculée par le renderer pour faire tourner 
les coordonnées internes vers le monde orbital 
Y-up) est multipliée par la caméra, puis un flip 
de convention caméra (camFlip : orbite Y-up → 
COLMAP Y-down) est appliqué. La cible de rendu 
offscreen est passée via IOSurface en CVPixelBuffer 
pour l’encodeur. L’encodeur prend en charge H.264 
et HEVC, un débit configurable et des résolutions 
de 480p à 8K. Avant la première image, le renderer 
attend 200 ms pour que le tri initial des splats soit 
terminé. Cet export est GPU-bound — en 8K avec 
des millions de gaussiennes, le temps de rendu par 
image atteint plusieurs secondes, soit des durées 
totales de rendu de 10–30 minutes pour 6 s de 
vidéo.

E N  B R E F

Un fichier MP4 prêt à l’emploi 
avec une rotation autour de votre 
scène. Parfait pour les réseaux 
sociaux, le marketing, les pré­
sentations. Vous pouvez régler la 
durée (3–30 secondes), le sens 
et la vitesse de rotation. Le fi­
chier s’intègre directement sur 
YouTube, Instagram, dans Power­
Point et partout ailleurs. Parfois 
lent, parce que l’app doit rendre 
chaque image en entier — pour 
une vidéo 8K, comptez cinq à 
trente minutes selon le nombre 
de gaussiennes.
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E9 — SfM Transforms (transforms.json)

O Ù

Barre de menu → Export → Photogrammetry → Ex
port SfM (transforms.json)…. Taille : typiquement 1–
10 KB (uniquement poses + intrinsics, pas d’images, 
pas de gaussiennes). Compatible avec : nerfstudio, 
Brush, gsplat, OpenSplat, Meshroom, tous les en
traîneurs 3DGS feed-forward modernes.

T E C H N I Q U E

Écrit le format transforms.json  de nerfstudio avec 
une liste de poses caméra plus des intrinsics par
tagés. Par caméra, la matrice de vue (en interne 
RadianceKit : World-to-Camera en convention COL
MAP) est inversée, puis les vecteurs de base Y et 
Z caméra-locaux sont retournés pour convertir vers 
la convention nerfstudio (style OpenGL, caméra 
regardant le long de -Z , +Y  vers le haut). La ma
trice 4×4 finale finit en tableau imbriqué row-major 
de doubles dans le champ transform_matrix  de 
chaque frame. Les intrinsics sont stockés au top-
level (focale x/y, point principal x/y, largeur/hauteur 
d’image, camera_​model = "OPENCV", plus les coef
ficients de distorsion k1, k2, p1, p2 ) — sauf si 
l’exporteur détecte plusieurs ensembles d’intrinsics 
distincts, auquel cas ils sont écrits par frame. 
Les chemins d’images sont écrits comme images/​
<filename> relatifs au fichier JSON ; l’utilisateur doit 
créer un dossier images/​ voisin avec les photos 
d’entraînement.

E N  B R E F

Ce fichier JSON décrit pour 
chaque photo où la caméra était 
et où elle regardait. Le fichier 
seul est petit et inutile — il 
s’utilise avec les images origi­
nales dans un dossier. Nerfstu­
dio, Brush et quelques autres 
entraîneurs lisent exactement ce 
format, et vous pouvez ainsi 
transmettre vos résultats SfM 
RadianceKit à un autre outil 
sans qu’il doive recalculer la 
reconstruction caméra. Sur de 
grandes scènes, cela économise 
des heures.
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E10 — COLMAP Workspace (sparse/0/)

O Ù

Barre de menu → Export → Photogrammetry → Ex
port SfM (COLMAP Workspace)…. Taille : les trois 
fichiers binaires ensemble typiquement 4–8 Mo — 
points3D.bin  domine (une ligne par point 3D du 

nuage sparse), images.bin  et cameras.bin  cha
cun nettement sous 100 KB. Compatible avec : 
COLMAP lui-même, Nerfstudio, Postshot, Mesh
room, tous les outils qui attendent un dossier COL
MAP sparse/​.

T E C H N I Q U E

Écrit la disposition standard COLMAP sparse/​
0/​ avec trois fichiers binaires : cameras.bin , 
images.bin , points3D.bin . La référence de for

mat est la documentation officielle COLMAP. 
cameras.bin  contient la liste dédupliquée des in

trinsics (les caméras avec mêmes intrinsics et taille 
d’image sont fusionnées en une seule entrée) ; le 
modèle caméra utilisé est OPENCV  (modèle 4), avec 
fx/fy/cx/cy et les quatre coefficients de distorsion 
k1/k2/p1/p2. images.bin  liste par image la pose 
comme quaternion wxyz  plus translation, suivis 
de l’ID caméra et du nom de fichier ; aucune cor
respondance 2D-3D n’est stockée. points3D.bin  
contient le nuage SfM avec position, couleur (RGB 
0-255) et valeurs par défaut pour la reprojection et 
la longueur de track. Tout est écrit en little-endian. 
Le réimport dans RadianceKit passe par le menu 
File → « Import COLMAP/Metashape Workspace… 
» (voir Q3 dans le chapitre des backends SfM).

E N  B R E F

Le format COLMAP officiel. Si 
vous voulez poursuivre votre en­
traînement dans Postshot, Nerf­
studio ou un autre logiciel com­
patible COLMAP, c’est le chemin 
à suivre. Trois petits fichiers plus 
vos images originales, et le pro­
gramme cible les accepte comme 
si COLMAP lui-même avait été le 
programme source. Plus de pro­
grammes comprennent ce for­
mat que le transforms.json (E9), 
mais c’est un peu moins pra­
tique parce que binaire au lieu de 
texte.
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Quel format pour quel objectif ?

Objectif Format

Visionneuse web sur votre site E7 Web Viewer (.html)

Visionneuse web avec gsplat.js E6 Splat (.splat)

Réutilisation pipeline dans Postshot / 
Nerfstudio

E9 transforms.json + E10 COLMAP Workspace

Édition dans SuperSplat E1 PLY ou E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

Compression maximale E4 SOG (cwebp requis)

Vidéo marketing/social E8 Orbit Video

149 / 177



R A D I A N C E K I T Chapitre 8 — Formats d’export

Comparaison rapide

Format Extension Sandbox Taille (1M gauss.) Usage 
idéal

E1 PLY .ply oui ~250 Mo Archive, 
plus haute 
compatibili

té

E2 Com
pressed 

PLY

.ply oui ~40 Mo Web + Su
perSplat

E3 SPZ .spz oui (gzip-
spawn)

~40 Mo Niantic + 
mobile

E4 SOG .sog condi
tionnel 

(cwebp)

~20 Mo Compres
sion maxi

male

E5 glTF .glb oui ~250 Mo Pipeline 
Khronos

E6 Splat .splat oui ~32 Mo Vision
neuse web 
gsplat.js

E7 Web 
Viewer

.html oui ~45 Mo Fichier navi
gateur auto

nome

E8 Orbit 
Video

.mp4 / .mov oui variable Social/mar
keting

E9 SfM 
Trans
forms

.json oui ~5 KB Transfert de 
poses

E10 
COLMAP 
Works
pace

Dossier oui ~4–8 Mo Transfert de 
poses bi

naire

La colonne taille donne des ordres de grandeur pour 1 million de gaussiennes en degré 
SH 3. Les valeurs réelles varient selon la compressibilité de la scène ; le degré SH 0 
réduit PLY/glTF d’un facteur 4.
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C H A P I T R E

Chapitre 9 — Backends SfM

Figure 33. –  Mode expert avec le sélecteur Camera Alignment dans l’inspecteur (Apple 
Photogrammetry / Native (Beta))

Figure 34. –  Inspecteur avec Native (Beta) actif — sélecteur Camera Alignment, deuxième 
option sélectionnée, tous les autres paramètres de configuration d’entraînement inchangés

CE QUE MONTRE L’IMAGE  Le sélecteur Camera Alignment dans l’inspecteur est un seg
mented control avec deux options — Apple Photogrammetry (par défaut pour les 
builds App Store, pleinement conforme au sandbox) et Native (Beta) (le backend 
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propre de RadianceKit, pipeline FAST+BRIEF+GLOMAP, développé en phase 3.8/3.9, 
état 2026-05). Native (Beta) est validé uniquement en orbite et plus rapide qu’Apple 
Photogrammetry à partir de 1 000 images, mais n’atteint pas encore le quality gate §5 
de la phase 3 (finalLoss ≤ 0.0115) — d’où le tag Beta. Des résultats SfM externes pro
venant de Metashape, COLMAP ou d’un autre logiciel de photogrammétrie peuvent en 
outre être importés via le menu File (Q3 format texte COLMAP, Q6 Workspace Import) 
— le sélecteur ne change pas, mais les poses importées remplacent le résultat SfM.

SfM signifie Structure from Motion. À partir d’un ensemble de photos qui se che
vauchent, le logiciel reconstruit pour chaque image la position et la direction de vue 
de la caméra dans un système de coordonnées 3D commun. Au passage, un nuage de 
points 3D grossier est généré, qui initialise l’entraînement par Gaussian Splatting. Le 
résultat SfM est l’entrée du véritable entraînement et détermine de façon décisive la 
qualité d’image finale.

RadianceKit propose cinq chemins SfM : deux backends intégrés à l’application (Q1 
Apple Photogrammetry, Q4/Q5 Native), deux chemins d’import depuis des outils ex
ternes (Q3 format texte COLMAP, Q6 Workspace Import binaire), ainsi que Q2 COLMAP 
binaire, disponible uniquement dans les builds développeur hors App Store. Lequel est 
le bon dépend du type de scène (orbite autour d’un objet, intérieur, vol de drone) et du 
fait qu’un logiciel externe fournisse déjà une reconstruction.
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Q1 — Apple Photogrammetry

O Ù

Expert View → Inspecteur → Configuration 
d’entraînement → sélecteur Camera Alignment, en
trée « Apple Photogrammetry ».

T E C H N I Q U E

Encapsule le framework Photogrammetry intégré 
d’Apple, développé à l’origine pour Object Capture. 
Apple extrait en interne les features avec un pipeline 
propriétaire (les étapes ne sont pas documentées 
publiquement), les vérifie via du matching multi-
vues et résout le bundle adjustment sur le Neural 
Engine + GPU Apple Silicon. Le backend est en
tièrement conforme à l’App Store (pas de binaire 
externe, Sandbox=true, on-device), mais ne four
nit que les poses caméra et un nuage de points 
grossier — aucune métrique de diagnostic comme 
la longueur des tracks ou l’erreur de reprojection. 
Mise à l’échelle, selon la recommandation d’Apple, 
jusqu’à quelques centaines d’images. Au-delà de 
~500 images dans des vols de drone linéaires ou 
de grandes scènes outdoor, des crashes reproduc
tibles ou des abandons silencieux de caméras indi
viduelles ont été observés.

E N  B R E F

C’est la voie la plus simple. 
Vous mettez les images, l’app 
calcule. Fonctionne très bien sur 
les scans d’objets classiques 
— quand vous tournez autour 
d’un meuble ou d’une sculpture 
et prenez 50–200 photos. Pour 
des vols de drone au-dessus 
de paysages ou avec beaucoup 
d’images (plus de 500), la mé­
thode Apple a tendance à devenir 
instable. Pour de telles scènes, 
testez le backend Native (Q4/
Q5) ou calculez les caméras dans 
Metashape et chargez-les via le 
Workspace Import (Q6).

U T I L I S AT E U R  AVA N C É

Q2 COLMAP binaire — lance le programme COLMAP externe comme sous-proces
sus et n’est donc pas disponible dans la version App Store (sandbox). Fonctionne 
uniquement dans les builds développeur hors App Store. Pour la qualité que fournit 
COLMAP, la version App Store propose le Workspace Import (Q3 ou Q6) : calculez 
le SfM dans COLMAP ou Metashape en externe et chargez le résultat.
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Q3 — Format texte COLMAP (Metashape / ETH3D)

O Ù

Menu « File → Import COLMAP / Metashape Works
pace… » (Cmd+⇧+I) OU glisser-déposer d’un dos
sier contenant sparse/​0/​cameras.txt.

T E C H N I Q U E

Lit l’export texte standard de COLMAP — 
trois fichiers texte cameras.txt , images.txt , 
points3D.txt  dans le sous-dossier sparse/​0/​ — 

et convertit vers le modèle de résultat SfM interne. 
Même définition de format que l’export binaire COL
MAP, seulement en ASCII au lieu de binaire. Exporté 
par Agisoft Metashape, RealityCapture, PolyCam et 
le benchmark ETH3D exactement dans cette dispo
sition. Le parseur partage la détection de modèle 
caméra avec le parseur binaire (tous les modèles 
courants : SIMPLE_PINHOLE, PINHOLE, OPENCV, 
OPENCV_FISHEYE, FULL_OPENCV). Robuste face 
aux lignes de commentaire et aux lignes vides. Mise 
à l’échelle dans les tests jusqu’à ~1 400 caméras 
(ETH3D Tunnel) sans problème.

E N  B R E F

Si vous avez déjà travaillé avec 
Metashape, RealityCapture ou un 
autre logiciel commercial pho­
to-3D et exporté le résultat — 
vous pouvez charger cet export 
directement dans RadianceKit, 
sans que l’application ait à tout 
recalculer. Cela vous fait gagner 
des heures d’attente. Chargez 
simplement tout le dossier via le 
menu File ou glissez-le dans la 
fenêtre.
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Q4 — SfM natif (incrémental)

O Ù

Expert View → Inspecteur → Configuration 
d’entraînement → sélecteur Camera Alignment, en
trée « Native (Beta) ». L’incrémental est le mode 
par défaut de ce backend — il n’y a pas de 
sélecteur de mapper séparé dans l’inspecteur. En 
CLI, le mode peut être défini explicitement avec 
--native-sfm  ou --sfm-mapper incremental.

T E C H N I Q U E

Implémentation propre, accélérée par GPU, 
de tout le pipeline SfM : features 
FAST+BRIEF OU SuperPoint+LightGlue via CoreML 
(avec --coreml-features ), suivi d’un matching 
KNN Hamming, matrice fondamentale RANSAC, 
construction de tracks, sélection de la paire ini
tiale, two-view bootstrap (F→E plus DLT), mapper 
incrémental glouton avec enregistrement PnP et tri
angulation multi-vues, et bundle adjustment final via 
Levenberg-Marquardt réduit par Schur avec perte 
de Huber et jacobiennes analytiques par résolution 
Cholesky. Entièrement conforme à l’App Store : pas 
de binaire externe, Sandbox=true. Avec le détecteur 
de collapse R2 livré en phase 3.10 : si l’application 
enregistre moins de 60 % des images d’entrée ou 
si le taux de points-par-caméra tombe sous 13, 
on bascule automatiquement vers le mapper global 
(Q5). Empiriquement propre sur les scènes orbit/
turntable ; sur des mouvements plus généraux (vol 
de drone, intérieurs à géométrie complexe), le taux 
de succès est plus faible — le détecteur intercepte 
cependant ces cas. Mise à l’échelle fiable jusqu’à 
~200 caméras, au-delà avec un temps d’exécution 
nettement plus long.

E N  B R E F

Les forces d’Apple (compatible 
App Store, rapide pour les or­
bites) avec des valeurs de diag­
nostic supplémentaires. Fonc­
tionne particulièrement bien 
quand vous tournez autour d’un 
sujet comme pour un Object Cap­
ture. Sur des prises plus compli­
quées (vol de drone ou salon), 
RadianceKit détecte automati­
quement que cela ne fonction­
nera pas et bascule sur la mé­
thode globale. Marqué « Beta » 
parce qu’encore en test — la re­
commandation par défaut reste 
Apple Photogrammetry pour les 
scans d’objet simples et le 
Workspace Import (Q3 ou Q6) 
pour les sets outdoor exigeants.
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Q5 — SfM natif (global)

O Ù

Appelé automatiquement quand le mapper incré
mental (Q4) déclenche le détecteur de collapse 
(moins de 60 % des images d’entrée enregis
trées ou taux de points-par-caméra sous 13). For
çable manuellement uniquement via la CLI --sfm-
mapper global. Dans l’inspecteur, la méthode glo
bale n’est pas accessible via un sélecteur séparé — 
l’application décide elle-même quand basculer.

T E C H N I Q U E

Variante globale du pipeline natif. D’abord extraction 
de features + matching comme en Q4, puis estima
tion de pose relative pour toutes les paires vérifiées, 
suivie d’un rotation averaging (synchronise toutes 
les rotations caméra dans le système de coordon
nées monde) et d’un translation averaging (basé sur 
LSQR avec une formulation sparse matrix-free pour 
éviter un overflow entier sur de grands ensembles 
de caméras). Mise à l’échelle jusqu’à ~5 000 camé
ras en principe, en pratique dégradée en qualité au-
delà de quelques centaines de caméras — la mesure 
du gate d’acceptation phase 3.8 §5 sur K-1351 a 
donné un finalLoss de 0.07 au lieu des 0.0115 visés. 
Traité comme un « tier de fallback » : entre en jeu 
quand le mapper incrémental dégénère, mais n’est 
pas lui-même vérifié à nouveau en qualité.

E N  B R E F

Le chemin plan B du moteur 
natif. Appelé automatiquement 
quand le chemin incrémental 
plus rapide échoue. Fournit un 
résultat utilisable, mais sur de 
très grandes scènes ou des 
scènes difficiles n’est générale­
ment pas aussi précis que ce que 
vous obtenez avec Metashape ou 
une installation COLMAP externe. 
Si Native devient votre workflow 
standard, le détour par le Works­
pace Import (Q3 ou Q6) en vaut la 
peine dans ces cas-là.
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Q6 — Import Workspace Metashape / COLMAP texte (Phase Q7)

O Ù

Menu File → « Import COLMAP / Metashape Works
pace… » (Cmd+⇧+I). Glisser-déposer d’un dossier 
contenant sparse/​0/​cameras.{bin,txt} et images/​.

T E C H N I Q U E

Détecte automatiquement si un dossier choisi via 
glisser-déposer ou panneau d’ouverture correspond 
à l’une des trois dispositions de workspace COL
MAP (sparse/​0/​, sparse/​ ou racine) et si la re
construction est binaire ( cameras.bin ) ou texte 
( cameras.txt ). Le chemin binaire utilise le parseur 
binaire COLMAP, le chemin texte le loader ETH3D 
— les deux produisent le même modèle de résultat 
SfM et le reste du pipeline (import des images, dé
marrage de l’entraînement MCMC) est agnostique à 
la source. Les images sont ouvertes via le système 
de bookmarks security-scoped du sandbox de l’app, 
de sorte que l’import fonctionne aussi dans la ver
sion App Store. Spécifiquement conçu pour le cas « 
export Metashape sans recalculer la reconstruction 
». La détection mentionnée dans l’entrée de menu 
File avertit dans le journal de l’app si le dossier 
choisi n’est pas un workspace reconnaissable.

E N  B R E F

Spécifiquement la fonction utili­
sateur Metashape. Si vous avez 
une licence pour Metashape ou 
RealityCapture et que vous y 
avez fait la reconstruction ca­
méra, vous pouvez simplement 
glisser le dossier d’export ici et 
démarrer l’entraînement immé­
diatement. Économise plusieurs 
heures de calcul sur de grandes 
scènes, parce que RadianceKit 
ne fait alors pas le SfM lui-même.
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Quel backend dans quelle situation ?

Scénario Backend recommandé

Scan d’objet, 50–200 pho
tos

Q1 Apple Photogrammetry

Grand outdoor / drone / 
>500 images

Q6 Workspace Import (calculer dans Metashape ou COL
MAP, puis importer)

Export Metashape/Reality
Capture disponible

Q6 Import (pas de SfM nécessaire)

Set texte COLMAP 
ETH3D / académique

Q3 import texte COLMAP

Strictement conforme App 
Store + scène en orbite

Q4 Native incrémental

Q4 échoue Q5 Native global (automatique)

Données du benchmark 
ETH3D

Q3 (autotest précalculé)
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Comparaison rapide

Ba­
ckend

App Store Sand­
box

Binaire externe Usage 
idéal

Max 
~cams

Q1 Apple 
PG

✅ ✅ — Objet en 
orbite

~300

Q2 COL
MAP bi

naire

❌ (build 
dév unique

ment)

— colmap/glomap Outdoor 
large

~5 000

Q3 im
port 
texte 

COLMAP

✅ ✅ — Bancs de 
test

~1 500

Q4 Na
tive in

crémen
tal

✅ ✅ — Objet en 
orbite

~200

Q5 Na
tive glo

bal

✅ ✅ — Fallback 
Q4

~1 351

Q6 
Works

pace Im
port

✅ ✅ — Réutilisa
tion Meta

shape

selon 
source
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C H A P I T R E

Chapitre 10 — Mode débutant

Le mode débutant (Simple Mode, Cmd+1) est le workflow guidé pour quiconque recons
truit pour la première fois une scène Gaussian Splatting 3D. Au lieu d’afficher une 
sidebar pleine de champs d’inspecteur, l’app vous guide en quatre étapes : d’abord 
importer des images ou une vidéo et choisir un préréglage de qualité, puis le traitement 
s’exécute (SfM + entraînement), ensuite vous pouvez examiner la scène finie dans un 
aperçu 3D, et enfin exporter au format souhaité. Une fine barre de progression en haut 
de la fenêtre indique en permanence à quelle étape vous êtes.

Comparé au mode expert (Cmd+2) qui montre tous les contrôles d’un coup, le mode 
débutant masque les options inutilisées, affiche des avertissements de validation en 
cas d’images trop rares ou de mauvaise qualité, et propose à chaque étape uniquement 
les boutons pertinents. Vous pouvez basculer à tout moment entre mode débutant et 
mode expert (Cmd+1 / Cmd+2) ; tout l’état — images importées, préréglage choisi, 
entraînement en cours, nuage de points fini — est conservé.

Z1 — Import (images et préréglage)

Figure 35. –  Mode débutant étape 1 — drop zone vide avant import, crumb-trail en haut, 
format pills JPG/PNG/TIFF/HEIC/MP4/MOV/PLY/SPZ/SPLAT/ SCENE/COLMAP

CE QUE MONTRE L’IMAGE  Crumb-trail (Import actif) avec workflow en quatre étapes. Drop 
zone à gauche avec trois CTA : « Browse Files », « Try Sample Scene », « Download 
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Sample Photos (~427 MB) ». Format pills en dessous. À droite « Imported Files » avec 
compteur « 0 images ». En bas le sélecteur Quality (défaut : Preview) et « Start Proces
sing » (désactivé tant qu’aucune image).

La première étape consiste à fournir des images à l’app : par glisser-déposer dans le 
grand cadre pointillé au centre, via le bouton « Browse Files » ou en cliquant sur la 
sample scene livrée. À droite apparaît la liste des images importées avec résolution et 
taille ; en bas, dans la barre flottante, vous choisissez le préréglage et démarrez avec 
« Start Processing ». Les avertissements de validation (rouge si < 3 ou < 10 images, 
orange pour 10–19) indiquent si l’app attend une reconstruction sensée.

C-01 ProgressIndicator (indicateur d’étape)

O Ù

Au-dessus du workflow, toujours visible.

T E C H N I Q U E

Barre de progression horizontale sur tout le pipeline 
(Frame Quality → SfM → Training) avec allocation : 
Frame Quality 0–5 %, SfM 0–30 %, Training 30–100 
%. À côté, texte de statut et pourcentage par phase 
(« SfM 41 % », « Training 12 500/20 000 »). Calcul 
ETA après mesure d’un tempo d’entraînement (typi
quement après 100 itérations).

E N  B R E F

La fine barre en haut est votre 
carte du workflow. Elle indique 
non seulement ce que l’app fait 
mais aussi où elle en est globa­
lement. Calcul caméra = premier 
tiers, entraînement = deux der­
niers tiers, pour ne pas donner 
l’impression d’un retour à zéro 
après SfM. Le texte précise la 
sous-étape.

C-03 DropZoneView (zone glisser-déposer)

O Ù

Gauche de l’étape import, rectangle pointillé.

T E C H N I Q U E

Drop zone qui anime le symbole et colore le fond 
quand des éléments sont au-dessus. Accepte JPG, 
PNG, TIFF, HEIC, MP4, MOV, PLY, SPZ, .splat, 
bundles .radiancescene  et dossiers. Routage par 
type : images collectées, vidéos déclenchent le 
frame sampling, splat ouvre directement l’aperçu, 
bundles chargés. Sandbox bookmarks correctement 
gérés. Extensions non supportées affichées en ban
deau 5 s.

E N  B R E F

Glissez photos, vidéo ou dossier 
— l’app prend ce qu’elle connaît. 
Le cadre devient bleu quand le 
drag est reconnu. Relâchez et 
l’import démarre : images dans 
la liste, vidéos déclenchent le 
frame sampling, fichiers déjà en­
traînés ouvrent l’aperçu. Format 
non reconnu → court avertisse­
ment.
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C-05 Browse Files Button

O Ù

Dans la drop zone, bouton prominent.

T E C H N I Q U E

Ouvre le dialogue de fichiers macOS avec multi-
sélection (JPG, PNG, TIFF, MP4, MOV, dossiers, for
mat scène propre). URLs security-scoped, mêmes 
chemins d’import que le drag-and-drop. Dossier = 
énuméré récursivement.

E N  B R E F

Si le glisser-déposer est gênant, 
cliquez ce bouton et naviguez 
dans le dialogue. Multi-sélection 
(Cmd-clic) ou dossier entier (par­
couru récursivement). Particuliè­
rement pratique pour des images 
dans des sous-dossiers imbri­
qués.

C-06 Try Sample Scene Button

O Ù

Dans la drop zone, visible si bundle contient la 
sample scene ET aucun import.

T E C H N I Q U E

Apparaît si (a) un sample-scene.splat /.spz/.ply 
existe dans le bundle ET (b) aucun import en cours. 
Au clic, charge le nuage fini et fixe après 400 ms 
des valeurs caméra hardcoded pour une perspec
tive d’entrée esthétique.

E N  B R E F

Au premier démarrage, pour voir 
le résultat final — cliquez ici. 
Ouvre une scène bouquet déjà 
entraînée à tourner et exporter 
sans calcul. Parfait pour tester 
sans risque la commande 3D et 
l’export. Disparaît dès l’import.

C-07 Download Sample Photos Button

O Ù

Dans la drop zone, à côté de « Try Sample Scene ».

T E C H N I Q U E

Déclenche un téléchargement (github.com/​
bkindler/​radiancekit-sample-photos) d’environ 
427 Mo contenant 960 images. Bouton désactivé 
pendant le téléchargement. Progression affichée en 
haut comme « Downloading X % » sur sa propre 
échelle.

E N  B R E F

Comme la sample scene mais 
avec les photos source au lieu 
du résultat fini. Permet de tester 
le pipeline complet. Télécharge­
ment gros (427 Mo) mais unique. 
Préférez Wi-Fi rapide.

162 / 177



R A D I A N C E K I T Chapitre 10 — Mode débutant

C-09 Quality Presets Picker

O Ù

Barre flottante du bas, à gauche du bouton Start.

T E C H N I Q U E

Contrôle « Quality » groupant les préréglages par 
catégorie (Classic / MCMC / Custom). Locked state : 

préréglages hors free-list reçoivent un suffixe « 🔒 » 
si pas acheté ; au clic, le picker revient sur Preview 
et ouvre le sheet d’achat.

E N  B R E F

Choisissez précision et temps. 
Quick et Preview gratuits, résul­
tat en minutes. Balanced et Qua­
lity version complète, modèles 
plus propres en heures. MCMC = 
autre stratégie, moins de splats, 
bon pour web compact. Premium 
= cadenas ; clic sans licence ren­
voie sur Preview et ouvre l’achat. 
Règle : commencer par Preview.

C-10 Start Processing Button

O Ù

Barre flottante du bas, à droite du sélecteur préré
glage.

T E C H N I Q U E

Bouton grisé tant qu’aucune image/vidéo importée. 
Au clic, lance le pipeline (Frame Quality → SfM → 
Training). Pas de statut interne ; traitement actif = 
écran séparé.

E N  B R E F

Le bouton « Go ». Tant qu’il 
est gris, il manque des entrées. 
Actif → cliquez pour lancer SfM 
puis entraînement. L’app prend 
en charge la suite, atterrit sur 
l’écran de traitement (Z2). Annu­
lable par Cancel.

C-11 Video Sampling Slider

O Ù

Liste images à droite, visible si vidéo importée.

T E C H N I Q U E

Slider 0,5 fps – 30 fps par pas de 0,5. Calcul du 
nombre cible (min 10). Slider hors de la liste car 
les éléments bloqueraient les events souris. Sous le 
slider : nombre de frames et durée vidéo. Tooltip 
avertit du coût SfM.

E N  B R E F

Si vous avez importé une vi­
déo, ce slider décide com­
bien d’images extraire. Plus = 
meilleure qualité mais temps li­
néairement plus long. Pour orbit 
30 s, 5 fps (150 images) bon dé­
but. Pour 1 min, 3 fps suffit. Vise 
100–300 images.
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C-12 Clear All Button

O Ù

Liste images, en bas, visible si imports.

T E C H N I Q U E

Bouton rouge. Clic ouvre confirmation « Clear all 
imported files? ». Vide toutes les images/vidéos, 
dossiers staging, nuage, statut training, résultat SfM 
et caches ; stage → Import.

E N  B R E F

Pour repartir de zéro. Confirma­
tion car la suppression jette tous 
les imports y compris caméras et 
résultats training — irréversible. 
Vos fichiers disque ne sont pas 
supprimés.

C-13 File List ForEach (suppression individuelle)

O Ù

Liste des images, chaque entrée.

T E C H N I Q U E

Liste avec swipe-to-delete. Par image : icône, nom, 
résolution, taille. Cache de métadonnées asyn
chrone. Suppression par swipe trackpad ou Delete. 
Bouton moins + Backspace + Cmd-Z disponibles 
uniquement en mode expert (Project Navigator).

E N  B R E F

Pour retirer une image, swipez à 
deux doigts vers la gauche, ou 
sélectionnez et Delete. L’app ne 
supprime pas le fichier disque. 
Pour bouton moins ou Cmd-Z, 
passez en mode expert.

C-15 Validation Warnings (3 niveaux)

O Ù

Sous la liste images, au-dessus de Clear All.

T E C H N I Q U E

Trois seuils : - < 3 : bandeau rouge, « At least 
3 images are required. » - 3–9 : bandeau rouge, 
« With fewer than 10 images, SfM often fails… » 
- 10–19 : orange, « Workable, but quality usually 
improves with 20+ images. » À partir de 20, plus de 
bandeau.

E N  B R E F

L’app évalue le nombre d’images 
et donne une indication colorée. 
Rouge = ne marchera probable­
ment pas. Orange = peut marcher 
mais qualité limitée. Pas de ban­
deau = bonnes conditions. Visez 
30–50 prises uniformes autour 
du sujet.
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C-16 COLMAP Workspace Detection

O Ù

Au drop d’un dossier — pas de bouton visible.

T E C H N I Q U E

Au drop d’un dossier, vérifie disposition works
pace : sparse/​0/​cameras.bin, sparse/​cameras.bin 
ou cameras.bin  racine. Si oui, alerte modale de
mandant si reprendre la reconstruction ou recalcu
ler via Apple Photogrammetry. Idem pour text for
mat et exports ETH3D. Voir chapitre 9 backend Q6.

E N  B R E F

Si vous avez un export Me­
tashape/RealityCapture/COLMAP, 
glissez le dossier ici. RadianceKit 
détecte le workspace COLMAP et 
demande s’il doit reprendre ou 
recalculer. Reprendre économise 
des heures car SfM est sauté.

Quand passer à l’étape suivante ?

Vous pouvez cliquer Start Processing dès que (a) au moins une image ou une vidéo 
est importée et (b) le bandeau de validation est orange ou disparu. Sur bandeau 
rouge, l’app laisse démarrer mais le traitement échouera. Recommandation : au moins 
20 images, nettes, avec recouvrement notable entre prises consécutives. Choisissez un 
préréglage adapté au temps disponible.

Z2 — Traitement (SfM + entraînement)

Figure 36. –  Z2 phase SfM — icône « Structure from Motion » 41 % dans le grand cercle, 
barre haute à « SfM 25 % », bouton Cancel en bas

Phase SfM (alignement des caméras) : grand cercle de progression affiche la sous-
étape. Texte « Aligning cameras… » en haut à gauche. Crumb-trail marque « Cameras 
». Barre haute : progression globale. Animation wireframe en arrière-plan.
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Figure 37. –  Z2 phase entraînement — icône « Training Gaussians » 6 %, métriques live en 
haut, ETA, Pause/Cancel en bas

Phase entraînement : icône sous-étape « Training Gaussians », pourcentage compte 
les itérations du préréglage. Ligne métriques live : loss, vitesse, ETA. Bouton Pause 
permet Resume ; Cancel rejette le résultat.

Dès que le pipeline tourne, l’app affiche un écran plein traitement. Au centre, un grand 
cercle de progression (220 × 220 px) avec icône d’étape et pourcentage ; en fond, 
animation discrète. En haut à gauche, un panneau d’info. En bas, Pause/Resume, Cancel 
et en cas d’erreur Retry.

C-18 SplatTrainingView (animation de fond)

O Ù

Fond plein écran derrière le cercle.

T E C H N I Q U E

Animation décorative qui rend des particules splat 
selon la progression. SfM mappé sur 0–0.2, training 
sur 0.2–1.0. Purement décoratif — pas de vrais ré
sultats. Masquée en cas de cancel/échec.

E N  B R E F

En arrière-plan, une petite ani­
mation de points danse pour que 
l’écran ne soit pas vide. Pas votre 
vrai modèle 3D — ça vient en Z3. 
Même tonalité que la progres­
sion. En mode expert, elle dispa­
raît.
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C-19 Grand cercle de progression

O Ù

Centre de l’écran traitement, 220 × 220 px.

T E C H N I Q U E

Deux anneaux : track-ring atténué et progress-
ring intérieur (accent ou rouge en erreur). Icône 
d’étape (cerveau/training, caméra/SfM, film/extrac
tion vidéo, sparkles/quality), titre et pourcentage 
animé. Interpolation 30 Hz vers la valeur réelle.

E N  B R E F

L’affichage principal. Se rem­
plit en douceur même si les 
vraies mises à jour n’arrivent que 
toutes les quelques secondes. 
L’icône change selon la phase. 
Le pourcentage = la sous-étape ; 
total en barre haute. Erreur → an­
neau rouge.

C-22 Bouton Info (afficher métriques)

O Ù

En haut à gauche de l’écran traitement.

T E C H N I Q U E

Bouton avec fond Material. Bascule le panneau Info. 
Icône change Outline ↔ Filled. Tooltip : « Show de
tailed processing metrics ».

E N  B R E F

Par défaut, écran épuré. Pour dé­
tails (itération, loss, gaussiens), 
cliquez le i en haut à gauche. 
Petit panneau avec toutes les va­
leurs live. Réinitialisé à chaque 
entraînement pour ne pas ef­
frayer les débutants.

C-23 Panneau Info (métriques live)

O Ù

En bas à gauche de l’écran traitement.

T E C H N I Q U E

Panneau deux colonnes avec fond Ultra-Thin Mate
rial. Gauche : info spécifiques à l’étape — SfM statut 
+ %, training itération, loss, L1, D-SSIM, Gaussian-
Count, vitesse, elapsed, ETA, SH degree, learning 
rate. Droite : texte statut, mini chart loss (C-28), 
nudge (C-32).

E N  B R E F

Panneau Info montre toutes les 
valeurs live : loss (plus petit = 
mieux), gaussiens, vitesse, ETA, 
SH degree, LR. À droite une mini 
courbe de loss — direction du 
training en un coup d’œil. Loss 
qui stagne ou ETA qui ne descend 
plus → problème.
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C-25 Bouton Pause/Resume

O Ù

Barre nav, visible seulement pendant training (PAS 
SfM).

T E C H N I Q U E

Bouton bordered. Appelle Pause ou Resume. Label 
bascule. Non affiché pendant SfM (Apple Photo
grammetry sans pause). Pause préserve itération, 
état gaussien et moments d’optimiseur ; Resume 
continue.

E N  B R E F

Pendant l’entraînement, pause et 
reprise. Utile pour libérer le GPU. 
Pas de coût qualité. Indisponible 
pendant SfM (Apple Photogram­
metry sans pause).

C-26 Bouton Cancel

O Ù

Barre nav, visible pendant traitement.

T E C H N I Q U E

Bouton rouge. Dialogue « Stop and discard pro
gress? ». Pose le flag cancel, termine le task, tue 
SfM si besoin, écrit summary annulation dans le log. 
Contrairement à Pause, les buffers d’entraînement 
sont rejetés.

E N  B R E F

L’annulation. Définitif — re­
commencer reprend de zéro. 
Utile si préréglage faux, training 
trop lent ou résultats mauvais. 
Confirmation avant exécution. 
Interruption courte = Pause.

C-27 Bouton Retry

O Ù

Barre nav, visible si pipeline a échoué.

T E C H N I Q U E

Bouton accent. Relance tout le pipeline. Vérifie qu’il 
reste des images/vidéos importées. Anciens logs 
conservés ; nouveau run nouveau fichier avec ti
mestamp.

E N  B R E F

Si SfM ou training a échoué, vous 
pouvez réessayer. Parfois ça aide 
car beaucoup d’étapes ont une 
part aléatoire. Échec encore → 
problème d’images d’entrée. As­
tuce : consultez les training logs.
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C-28 Mini chart de loss

O Ù

Panneau Info droite, visible si historique non vide.

T E C H N I Q U E

Zone compacte 40 px haut. Ligne 1 px en accent. 
Données filtrées sur valeurs finies (protection NaN). 
Min/Max recalculés (auto-zoom). Dernière valeur en 
haut à droite. Construit à chaque tick training ( 100 
itérations).

E N  B R E F

Courbe miniature : converge 
(descend) ou stagne/ explose 
(plate/monte). Sain = chute ra­
pide au début puis lente. Auto-
zoom. Saut vers le haut ou gel = 
problème.

C-32 Discoverability Nudge (hint mode expert)

O Ù

Panneau Info droite en bas, visible pendant training 
ET en mode débutant.

T E C H N I Q U E

Petite ligne avec icône œil et caption « Switch to 
Expert Mode (⌘2) for live splat preview », 10 pt. 
Non interactif — l’utilisateur doit appuyer Cmd+2 ou 
utiliser le menu.

E N  B R E F

Indication discrète qu’en mode 
expert, l’aperçu live est visible 
pendant l’entraînement. Cmd+2 
→ training continue en arrière-
plan, vous voyez l’assemblage. 
Bon outil pour décider tôt. Cmd+1 
ramène en mode débutant.

Quand passer à l’étape suivante ?

L’app passe automatiquement à Z3 dès que l’entraînement réussit. La barre nav passe 
de Pause/Cancel à Back et Export. En cas d’erreur, Retry apparaît.
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Z3 — Aperçu (faire tourner le modèle 3D)

Figure 38. –  Mode débutant étape Preview avec viewer 3D

Figure 39. –  Z3 Preview après entraînement — bouquet reconstitué, en-tête « Training 
complete — 3 022 Gaussians in 13 s », Back et Export en bas

CE QUE MONTRE L’IMAGE  Crumb-trail marque « Preview ». Viewport 3D plein écran rend 
la scène bouquet entraînée. Barre : « Training complete — 3 022 Gaussians in 13 s ». 
Glisser = tourne, molette zoom. Back = Z2, Export = Z4.

Après l’entraînement, l’app atterrit dans l’aperçu. Vue fullscreen Metal, tourner/zoomer/
panner avec souris et trackpad. Au-dessus, overlay : contrôle caméra, statistiques trai
ning, reset.

170 / 177



R A D I A N C E K I T Chapitre 10 — Mode débutant

C-36 SplatViewportView (vue 3D principale)

O Ù

Fond plein écran de l’étape Preview.

T E C H N I Q U E

Viewport 3D Metal qui rend le nuage fini. Le ren
derer est le rasteriseur ForwardPass PROPRE à 
RadianceKit — le même qui rend déjà les splats 
pendant l’entraînement — donc c’est du véritable 
WYSIWYG (ce qui est entraîné est affiché et exporté 
exactement à l’identique). Pipeline tile-based avec 
OIT. Si Metal indisponible, fond noir « Metal not 
available ».

E N  B R E F

Viewport principal. Modèle 3D 
reconstitué, rendu par GPU en 
temps réel. Clic-glisser = tourner, 
molette/pinch = zoom, clic droit/
Cmd-glisser = panner. Composé 
d’ellipsoïdes 3D semi-transpa­
rents. Sans Metal, fond noir avec 
message.

C-37 CameraControlsOverlay (overlay contrôle)

O Ù

Au-dessus du viewport, flottant.

T E C H N I Q U E

Overlay compact avec boutons : auto-rotation turn
table, reset caméra, sélection fond Gray/Black/
White, Save Screenshot, toggle panneau info. Lie 
aux paramètres caméra.

E N  B R E F

Petite barre flottante : démar­
rer auto-rotation, reset caméra, 
changer fond (gris/noir/blanc), 
captures sauvegardées sous  /
Pictures. Auto-rotation est aussi 
un bon test pour voir une face 
moins propre due à un manque 
d’images.

C-38 Bouton Export (barre nav)

O Ù

Barre nav inférieure en Z3.

T E C H N I Q U E

Bouton accent avec « Export » et icône share. Au 
clic, Z4. Vérifie d’abord la version complète — sinon 
écran de verrouillage (U-06).

E N  B R E F

Résultat OK → Export → étape fi­
nale pour choisir le format et en­
registrer. Sans version complète, 
écran de verrouillage avec achat. 
Achat → suite directe vers Ex­
port.

Quand passer à l’étape suivante ?

Avant l’export, faites le tour complet : zones couvertes présentes ? Floaters ? Ciel/fond 
propre ? Problèmes graves = nouvel entraînement (plus d’images, autre préréglage, ou 
mode expert avec floater reduction).
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Z4 — Export (choisir le format)

Figure 40. –  Mode débutant étape Export avec cartes de format

Figure 41. –  Z4 cartes Export — 6 formats (PLY 742 KB sélectionné, SPZ 74 KB, glTF 708 
KB, .splat 96 KB, Orbit Video, Web Viewer 133 KB)

CE QUE MONTRE L’IMAGE  Crumb-trail marque « Export ». Grid de cartes à gauche avec six 
options. Tailles calculées live. Sidebar « Export History » à droite. CTA en bas.

Dans l’étape finale, vous choisissez parmi 6 formats via une grille deux colonnes, 
cliquez Export et choisissez l’emplacement dans le dialogue macOS.
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C-39 Grid 2 colonnes des formats

O Ù

Côté gauche de l’étape Export.

T E C H N I Q U E

Grille deux colonnes flexibles, 12 pt d’espacement. 
Itère sur les 6 formats du mode débutant : PLY, SPZ, 
glTF, .splat, Orbit Video, Web Viewer. Compressed 
PLY et SOG réservés au mode expert.

E N  B R E F

Grille avec les 6 formats perti­
nents. Couvre 90 % des usages. 
Pour formats rares (Compressed 
PLY, SOG), mode expert.

C-40 Format Card Button

O Ù

Chaque carte du grid.

T E C H N I Q U E

Bouton avec layout carte : icône, nom (headline), 
description 2 lignes, taille estimée (live). Sélection 
→ fond accent + coche. Tooltip = description.

E N  B R E F

Une carte par format. Cliquez-en 
une, elle est mise en évidence 
et le bouton Export adapte son 
texte. Taille aide à choisir : email 
→ petit (SPZ, .splat) ; autre logi­
ciel 3D → PLY.

C-41 Video Duration Slider

O Ù

Sous le grid, visible si format vidéo.

T E C H N I Q U E

Slider 3–30 s, pas 1. Largeur max 300 px. Affiché 
seulement si format vidéo — sinon retiré.

E N  B R E F

Si orbit video, durée. 3 s = rapide, 
30 s = lent. Reels Instagram/Tik­
Tok : 6–10 s. Portfolio : 15–20 s.

C-42 Bouton Export

O Ù

Sous le grid (et sous duration slider si vidéo).

T E C H N I Q U E

Grand bouton accent. Label : « Export {format} », 
icône share. Au clic, dialogue d’enregistrement ma
cOS avec extension correcte et nom « scene.{ext} 
». Désactivé si pas de résultat ou export en cours.

E N  B R E F

Cliquez, choisissez 
l’emplacement, fini. Nom par dé­
faut « scene.{ext} » modifiable. 
Grisé si pas de résultat ou autre 
export en cours.
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C-43 Export Progress Bar

O Ù

Sous Export, visible pendant export en cours.

T E C H N I Q U E

Progression largeur max 300 px avec caption « 
Exporting… N % ». PLY en chunks de 10 000 gaus
siens, SPZ une fois après quantisation, orbit video 
par intervalles de frames.

E N  B R E F

Barre et pourcentage pendant 
l’export. PLY en secondes. SPZ 
un peu plus long. Orbit video le 
plus long — chaque frame ren­
due.

C-44 Export Error Display

O Ù

Sous progress bar, visible si erreur.

T E C H N I Q U E

Ligne rouge avec icône warning et texte. Fond rouge 
8 % opacity. Causes : SOG attend cwebp  (pas App 
Store compliant) ; disque plein ; sandbox error.

E N  B R E F

Si l’export échoue, ligne rouge 
avec description. SOG → cwebp  
manquant, basculez sur SPZ. Dé­
tails dans les logs (Help → Open 
Training Logs). Réessayez avec 
autre dossier.

C-46 Export History List

O Ù

Côté droit de l’étape Export.

T E C H N I Q U E

Liste de l’historique persistée en JSON dans User
Defaults. Par ligne : badge format, timestamp 
HH:mm, nom fichier, taille. Clic = Finder avec fichier 
sélectionné. Empty state : « No exports yet ».

E N  B R E F

Liste de vos exports passés. Clic 
= Finder ouvert sur le fichier. 
Survit aux redémarrages.

C-48 History Context Menu (clic droit)

O Ù

Clic droit sur une ligne d’historique.

T E C H N I Q U E

Menu contextuel avec deux actions : « Reveal in 
Finder » et « Copy Path ». Pratique pour drag-and-
drop ou ligne de commande.

E N  B R E F

Clic droit → petit menu. Reveal in 
Finder = clic simple. Copy Path 
= chemin en presse-papiers pour 
terminal/ autres apps.
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Quand le workflow est-il terminé ?

Après un export réussi, vous avez votre modèle 3D sur disque et l’historique a une 
nouvelle entrée. Pas de bouton « Done » — vous pouvez exporter dans n’importe quel 
nombre de formats sans réentraîner. Back ramène à l’aperçu. Nouvelle scène : Back 
vers Z1 puis Clear All, ou File → New Project (Cmd+⇧+N).

Passage au mode expert

Appuyez à tout moment sur Cmd+2 ou Mode → Expert Mode ( M8 ). Tout l’état est 
conservé : images, préréglage, entraînement, nuage, historique, étape. En mode expert, 
sidebar inspecteur complète avec  150 contrôles. Project Navigator (chapitre 2) pro
pose les opérations image avancées (bouton moins, Backspace, Cmd-Z, Quick Look), 
le live preview du viewport, et tous les paramètres Loss/MCMC/densification/Mip-Splat
ting. Cmd+1 ramène sans perte d’état.

FAQ

Pourquoi mon bouton Start Processing reste-t-il gris ?

Vous n’avez pas encore importé d’images ou de vidéo. Glissez au moins un fichier dans 
la drop zone ou utilisez « Browse Files ». Dès qu’au moins une entrée est présente, le 
bouton devient actif.

Pourquoi mon bouton Export est-il verrouillé ?

Deux niveaux : (a) si le pipeline n’est pas fini, désactivé. (b) si version complète non 
achetée (PurchaseManager.hasAccess == false), écran de verrouillage avec « Unlock 
Full Version » qui ouvre le sheet d’achat. Quick et Preview permettent l’entraînement 
gratuit, mais l’export est premium.

Pourquoi ne puis-je pas choisir un préréglage ?

Vous pouvez — mais sans version complète, taper un préréglage premium renvoie sur 
Preview et ouvre l’achat. Quick et Preview sont les seuls préréglages gratuits.

Pourquoi ma drop zone reste-t-elle vide même en glissant des images ?

Probablement un mismatch UTI. L’app accepte JPG, PNG, TIFF, HEIC, MP4, MOV et les 
formats splat propres. Autres formats (BMP, GIF, WebP, RAW) NON reconnus. L’app va 
d’abord par extension de fichier.

Pourquoi SfM prend-il si longtemps avec 30 images ?

Apple Photogrammetry ne scale pas linéairement — certaines configurations (intérieurs 
complexes, flou, mauvaise lumière) prennent bien plus longtemps. SfM bloqué après 10 
min → annulez, retentez avec meilleur matériel, ou mode expert pour COLMAP/Native 
SfM.

Où trouver mes training logs ?
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Help → Open Training Logs (Cmd+⇧+L). Ouvre ~/​Documents/​RadianceKit/​Logs/​. 
Chaque session = un fichier JSONL : config, progress toutes les 100 itérations, summa
ry finale.
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